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Overview

In Overview:

● Working with Dashboard Sections
● Working with the Interactive Reporting Object Model
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Working with Dashboard

Sections

In This Chapter

Dashboard Sections...................................................................................................................................................11

Inserting, Renaming, Deleting, and Changing Mode of Dashboard Sections................................................................12

Working with Dashboard Objects................................................................................................................................13
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Embedded Section Objects........................................................................................................................................24
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Using Design Tools.....................................................................................................................................................27

Dashboard Sections
Dashboards are customizable documents that enable developers to build and deploy analytic
applications and end users to access information.

The dashboard sections of Oracle's Hyperion® Interactive Reporting – System 9 provide a
streamlined, push-button approach to querying databases, combining reports, and enhancing
controls to develop and deliver prepackaged business content that includes these items:

● Simple forms to collect multiple input parameters for a report

● Executive dashboard applications, with visual drill-down from high-level metrics to
underlying data

● Browser-style navigation pages to assist users in maneuvering within and between
documents

Within Oracle's Hyperion® Interactive Reporting Studio and Oracle's Hyperion® Interactive
Reporting Web Client, developers can customize dashboard sections to create interfaces that
focus on the data views relevant to end users. When an end user opens an Interactive Reporting
document file, the customized dashboard section is displayed.

Users navigate dashboard sections by clicking buttons and entering parameters. Button clicks,
item selections, or navigation sequences invoke scripts that are processed in the background.
No in-depth knowledge of the data structure or the Interactive Reporting Studio and Interactive
Reporting Web Client applications is required.
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Inserting, Renaming, Deleting, and Changing Mode of
Dashboard Sections

Like other report sections, dashboard sections can be added to an Interactive Reporting
document. Within Interactive Reporting documents, the dashboard section is displayed at the
top of the Sections pane.

Inserting Dashboard Sections
Newly added dashboard sections are listed after existing dashboard sections.

➤ To insert dashboard sections, select Insert > New Dashboard.

Renaming Dashboard Sections
The first dashboard section inserted in an Interactive Reporting document file is, by default,
named Dashboard. Subsequent dashboard sections are numbered sequentially; for example,
Dashboard2, Dashboard3, and so on.

➤ To rename dashboard sections:

1 From Sections, select a dashboard section.

2 Select Edit > Rename Section.

Section Label is displayed.

3 In Label, enter a name, and click OK.

Deleting Dashboard Sections

➤ To delete dashboard sections:

1 From Sections, select a dashboard section.

2 Select Edit > Delete Section.

Delete Section is displayed.

3 Click Delete.

Switching Between Design and Run Modes
Dashboard section modes:

● Design—Used to design dashboard sections. Available objects are displayed in the Catalog
pane.

● Run—Used to deploy dashboard sections to end users. The Catalog pane is empty.
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All dashboard sections within an Interactive Reporting document file use the same mode.
Dashboard sections of Interactive Reporting document files open by default in Run mode.
Changing one section to Design mode changes all sections to Design mode.

➤ To switch to Design mode, select Dashboard > Design Mode, or click , or press Ctrl+D.

Working with Dashboard Objects
Embeddable objects used to construct custom dashboard sections:

● Sections—Results, chart, pivot, table, and OLAP sections from the active Interactive
Reporting document file. When you embed a section in a dashboard section, the section is
resized, and its data is updated.

Note:

In Run mode, you can sort active embedded tables and results (from the shortcut menu)
and resize table and results columns.

● Graphics—Objects, such as lines, rectangles, and pictures, for which you can set colors and
border properties. These are available from the Catalog pane.

❍ Line

❍ Hz line

❍ Vt line

❍ Rectangle

❍ Round rectangle

❍ Oval

❍ Text label, can be used as a caption

❍ Picture, insert BMPs, GIFs, JPGs, and PNGs

● Controls—Widgets for which you can set fonts and default values. Controls, which provide
users a way to interact with the application, can be populated with values at design time or
dynamically populated using JavaScript.

Table 1 Dashboard Control Objects

Control Object Suggested Use

Command button Initiate or activate a process

Radio button Select one from a group of choices

Check box Toggle an option, on and off or true and false

List box List multiple values from which users can select one or more

Drop down List multiple values from which users can select one
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Control Object Suggested Use

Text box Gather and display user input

Embedded browser Display external content through a browser

HyperLink Link to external content through a hyperlink

● Resources—Pictures or images loaded in the Resource Manager.

Inserting Dashboard Objects

➤ To embed objects in dashboard sections:

1 Select Dashboard > Design Mode, or press Ctrl+D.

2 From the Catalog pane, expand the folder that contains the object to be inserted.

3 Drag the object onto the content area.

➤ To insert control and graphic objects:

1 Select Dashboard > Design Mode, or press Ctrl+D.

2 Select Dashboard > Insert Graphic or Dashboard > Insert Control, and, from the menu, select a graphic
or control object.

3 Click within the content area to insert the control or graphic.

Deleting Dashboard Objects

➤ To delete embedded sections, controls, and graphics:

1 Select Dashboard > Design Mode, or press Ctrl+D.

2 From the content area, select one or more objects.

To select multiple objects, press and hold Ctrl while selecting objects.

3 Select Dashboard > Remove Selected Items.

External Content in Dashboards
You can incorporate external Web-based content into your dashboards, embedding the content
in your reports sections and thus enhancing your reports. You can embed stock tickers,
calendars, and document objects and launch the content of a URL-based hyperlink in a separate
window.

Embeddable external Web-based dashboard objects:

● Interactive Reporting document files
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● Interactive Reporting jobs

● Oracle's Hyperion® SQR® Production Reporting – System 9 jobs

● Oracle's Hyperion® Web Analysis – System 9

● Oracle's Hyperion® Financial Reporting – System 9

Interactive Reporting Studio and Interactive Reporting Web Client provide two controls for
working with Web-based content:

● Embedded browser control—Essentially, an instance of a Web browser window, positioned
on the dashboard page. Similar to an embedded section object, except that the content is
anything that can be referenced through a URL and rendered in a Web browser window,
rather than in a section. There are no recognizable events in the control; that is, you can not
create scripts on an embedded browser control.

● Hyperlink control—A URL-based hyperlink control. The content may be displayed in a
pop-up window or the current window.

Working with Embedded Browser Controls
An embedded browser control renders and executes in all Interactive Reporting environments
(Interactive Reporting Studio, Interactive Reporting Web Client, and Oracle's Hyperion®
Workspace).

Attributes and behavior of embedded browser controls, typical of all dashboard controls:

● Is added to the dashboard section (in Design mode) by dragging an instance from the Catalog
pane, sizing the instance, and setting properties

● Uses common dashboard-control properties: name, visible, locked, tab order, accessibility,
cut, copy, paste, auto-alignment and sizing

Properties of embedded browser controls, similar to properties of embedded sections:

● Show Scrollbars

● Reference to the content—For embedded sections, the reference is the name of a chart, pivot,
or table that is contained in the Interactive Reporting document file. For the embedded
browser control, the reference is a URL. If the content is a generic URL (such as a stock
ticker), the designer can reference it by entering the URL. If the content is an Interactive
Reporting document, file in the repository, the designer can use GUI controls to select the
Interactive Reporting document file and the preferred parameters, thus creating the
appropriate Smartcut URL.

Note:

A report section that is contained in one Interactive Reporting document file and displayed
in an embedded browser object of another Interactive Reporting document file cannot be
printed.
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➤ To create instances of embedded browser controls:

1 Select Insert > New Dashboard.

Inserting a dashboard section changes the document to Design mode. The content area is blank,
and the Catalog pane displays the sections, graphics, controls and resources available for
embedding in a dashboard section.

2 From the Catalog pane, expand Controls, and drag the embedded browser control onto the content area.

3 Double-click the control object.

Objects is displayed.

4 In Name enter a unique name for the control.

The default name is EmbeddedBrowser followed by a number.

5 In Title enter a title for the dashboard section.

The Title is only used when the dashboard section is printed.

6 Select Visible to display the embedded browser control when the dashboard section is executed.

By default, Visible is selected.

7 Select Locked to prevent the embedded browser control from being moved or deleted.

By default, Locked is not selected.

8 From Show Scrollbar, to indicate when scroll bars are displayed on the embedded browser control, select
a scrolling option:

● Always

● Never

● Automatic (the default)

9 Optional: To define explicitly the URL of the content to be displayed in the embedded browser, in URL, enter
the URL address.

When the embedded browser is rendered, the URL is used “as is” (server information is not
appended).

You can reference Oracle's Hyperion® Reporting and Analysis – System 9 repository content by
entering an explicit URL. In this case, the URL is treated like any other external reference (no
special authentication support).

It is important to plan how the content of the URL is displayed in the embedded browser. An
action from within the embedded content can result in the browser, rather than only the contents
of the embedded browser control, being replaced.

10 Optional: To select a repository document (and associated properties) or an object to be displayed in the
embedded browser control or HyperLink object, select Repository, and perform one or more actions:

● Document—Enter manually the path and name of the preferred repository document

● Browse—Browse the Reporting and Analysis repository for the preferred document

● Options—Launch the Document Options dialog box so that you can select display
properties for a Workspace document (See “Document Options” on page 18)
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11 Click OK.

Referencing A Name With A Single-Byte Character

If you are using the Embedded Browser control of the Dashboard section to embed content from
the repository, and it references a name (for example, file name, directory, section, parameter)
that contains a single-byte character with a value greater than 127 (for example, accent
characters), and the SmartCut encoding for URLs is set to “default”, then the characters display
as scrambled and the embedded content may not display properly.

➤ To change the encoding property for SmartCuts:

1 Log in to Workspace with a user ID that has an Administrator role.

2 Select Administration on the Module menu.

3 Click the System tab and navigate to SmartCut.

4 Change the Encoding for URLs property to UTF8.

Browsing the Repository
With proper authentication, you can select a document to embed from the Reporting and
Analysis Repository dialog box. Authentication is provided through an authentication service,
which reviews user credentials at login time and enables users to connect. The service also
determines a user’s group membership, which, with user roles, affects what content and other
system objects (resources) the user can view and modify.

For users authenticated to a global service manager (GSM), the Foundation Browse dialog box
is displayed automatically. Authentication is assumed for Interactive Reporting Web Client and
Workspace documents, because they receive a URL stamp when they are created. The stamp
provides GSM access.

Interactive Reporting Studio users who are not authenticated are prompted to enter a valid server
address on the Connect to Server dialog box (Tools > Connect to Foundation). When the user
selects Connect (and the connection succeeds), the server address is persisted in the Windows
registry. Thus, the address can be used as the default server address, if no valid address can be
obtained from the session or the Interactive Reporting document.

After a valid server address is determined, the Interactive Reporting Studio application contacts
the data access servlet, and an authentication dialog box is displayed. After user credentials are
validated, the user is authenticated, and the Reporting and Analysis Repository dialog box is
displayed.

➤ To log into the Reporting and Analysis repository and embed an object:

1 In the Objects dialog box, select Repository.

2 Click Browse.
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Connect to Server is displayed.

3 In the Connect to Server dialog box, enter a server address, and click Connect.

The Reporting and Analysis Login dialog box is displayed.

4 Enter your user name and password, and click Login.

After you are successfully authenticated, Browse Listing is displayed.

5 Navigate to the folder that contains the repository object to be embedded.

6 Double-click the object.

Verify that the full path name and object name are displayed to the right of the Selection field.

7 Click Apply.

The document name is displayed in the Document field of the Object dialog box.

Document Options
You use the Document Options dialog box to select display properties for a document to be
viewed in Workspace. The properties that you select prepare a Smartcut (a URL reference to a
Reporting and Analysis repository object, for example, an Interactive Reporting document or
job).

Document types available for display in Workspace:

● Interactive Reporting document (BQY)

● Interactive Reporting Job

● SQR Production Reporting Job

● Web Analysis

● Financial Reporting

● Others

Note:

If a hyperlink control display type is New Window or Current Window, the Document Options
dialog box looks and behaves as described in “Working with Embedded Browser Controls” on
page 15.

If Interactive Reporting Studio and Interactive Reporting Web Client determines the document
type prior to the display of the Document Options dialog box, then the Document Type drop-
down list presets the document type, and no document-type choices are available.

If Interactive Reporting Studio and Interactive Reporting Web Client cannot determine the
document type prior to display of the Document Options dialog box, the default is Others, and
you can select one of the five specific document types.

Depending on the document, specific options are available.
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Table 2 Interactive Reporting Document Type Display Options

Option Description

Document Type For Interactive Reporting Studio and Interactive Reporting Web Client, select Interactive Reporting document

Section Specify which Interactive Reporting document section is displayed.

If the list of Workspace-enabled sections is determined prior to display of the Document Options dialog box, the
list is displayed. The default section name is the name of the default section of the Interactive Reporting document.

If the section list cannot be determined, a blank text box is displayed, and you can enter the section name manually.
If the text box is blank, the default section is displayed when Browse is clicked in the Properties dialog box.

Toolbar Specify which Workspace toolbar is displayed:

● Standard—Contains the controls for commonly used operations, such as Open and Save

● Paging—Contains the section paging controls (Page Left, Page Up, Page Down, and Page Right) and indicates
the current page (Page x of y)

● Section Navigation—Contains the navigational controls (Back, Forward, and Dashboard Home)

● Paging and Section Navigation—Contains the controls for paging and section navigation

● None

Smartcut Parameters Specify key value pairs for the document and add parameters to the URL.

To add a parameter, enter the parameter into the Smartcut Parameters text box, and click Add. When the URL is
formed, the parameter is appended to the end of the URL. For example, the Smartcut Parameter “ShowMenubar”
specifies state of the toolbar when the Interactive Reporting document is opened. Parameter values include:

● Standard

● Navigation (for Paging)

● Section Navigation and Navigation

● None

● Numbers (1, 2, 3, 4 respectively)

To remove parameters from the list, select the parameters, and click Remove.

Table 3 Interactive Reporting Job Document Type Display Options

Option Description

Document Type For Interactive Reporting Studio and Interactive Reporting Web Client, select Interactive Reporting Job

Section Specify which Interactive Reporting document section is displayed.

If the list of Workspace-enabled sections is determined prior to display of the Document Options dialog box, the
list is displayed. The default section name is the name of the default section of the Interactive Reporting document.

If the section list cannot be determined, a blank text box is displayed, and you can enter the section name manually.
If the text box is blank, the default section is displayed when Browse is clicked in the Properties dialog box.

Toolbar Specify which Workspace toolbar is displayed:

● Standard—Contains the controls for commonly used operations, such as Open and Save

● Paging—Contains the section paging controls (Page Left, Page Up, Page Down, and Page Right) and indicates
the current page (Page x of y)

● Section Navigation—Contains the navigational controls (Back, Forward, and Dashboard Home)

● Paging and Section Navigation—Contains the controls for paging and section navigation

External Content in Dashboards 19



Option Description

● None

Smartcut Parameters To add a parameter, enter the parameter into the Smartcut Parameters text box, and click Add. When the URL is
formed, the parameter is appended to the end of the URL.

To remove parameters from the list, select the parameters, and click Remove.

Table 4 SQR Production Reporting Job Document Type Display Options

Option Description

Document Type For SQR Production Reporting, select SQR Production Reporting Job

Run Job Specify whether the job should be executed. Not selected (not to be run) is the default.

Smartcut Parameters Specify key value pairs for the document and add parameters to the URL.

To add a parameter, enter the parameter into the Smartcut Parameters text box, and click Add. When the URL is
formed, the parameter is appended to the end of the URL.

To remove parameters from the list, select the parameters, and click Remove.

Table 5 Web Analysis Document Type Display Options

Option Description

Document Type For Web Analysis, select Web Analysis

Smartcut Parameters Specify key value pairs for the document and add parameters to the URL.

When the URL is formed, the parameter is appended to the end of the URL.

To remove parameters from the list, select the parameters, and click Remove.

Table 6 Financial Reporting Document Type Display Options

Option Description

Document Type For Financial Reporting, select Oracle's Hyperion® Financial Reporting – System 9

Display Format Specify the type of format in which to display the report (HTML or PDF). The default is HTML

Smartcut Parameters Specify key value pairs for the document and add parameters to the URL.

When the URL is formed, the parameter is appended to the end of the URL.

To remove parameters from the list, select the parameters, and click Remove.

Table 7 Others Document Type Display Options

Option Description

Document Type Select Others to add parameters to the URL

Smartcut Parameters Add parameters; for example, add SQR Production Reporting Job parameters or Interactive Reporting document
limits (filters).
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Option Description

To add a parameter, enter the parameter into the Smartcut Parameters text box, and click Add. When the URL is
formed, the parameter is appended to the end of the URL.

To remove parameters from the list, select the parameters, and click Remove.

Setting Dashboard Home Sections
You use the Dashboard Home dialog box to select a section to set as the home dashboard section
(the first section that is displayed when the document is opened). In addition for Interactive
Reporting users only, use the Dashboard Home dialog box to enable the preloading of the active
home section in order to increase loading performance in Workspace. This option is enabled
only when the selected dashboard section in an Interactive Reporting document contains a
minimum of one dashboard with at least one embedded browser.

Section rules define the first displayed section when a document is opened:

● Defined through the object model, for example, Activate()

● Selected on the Dashboard Home dialog box

● If not defined through the object model or the user interface, the section that was last saved
is opened first (This behavior is a change in Release 9.3, that may cause the document to
open to the home section. In releases earlier than Release 9.3, the same document might
have opened to the last saved section or another section)

● If a home dashboard is not set, then the last saved section is opened (If the user cannot access
the last saved section; for example, due to an adaptive state which prevents a user from
viewing some sections, then the document is opened in a section available to the user)

In releases earlier than Release 9.3, the default home section was the first section added to the
document. In Release 9.3, there is no default home section; that is, if no home section is defined,
none is assumed in Interactive Reporting.

To enable the Dashboard Home toolbar button when an Interactive Reporting document file is
deployed in the Workspace, Dashboard home must be explicitly set in Interactive Reporting
Studio or Interactive Reporting Web Client.

Note:

➤ To specify a home dashboard section:

1 From the Dashboard menu, select Home Dialog.

2 Select the dashboard to use for the home section.

3 Optional: To use a hidden dashboard section, select View > Unhide Section, and select the section before
displaying the Dashboard Home dialog box.

When you save the Interactive Reporting document, the section is no longer hidden.

4 To preload embedded browser objects, click Preload.
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5 Click OK.

Note:

Setting a home dashboard section in Design mode activates  (Dashboard Home) on the
toolbar.

Working with HyperLink Controls
Hyperlink controls behave like embedded browser controls, except that their URL-based content
is displayed as follows:

● Current window

● Top window

● New window

● Named window

● No window

Hyperlink-control behavior depends upon the display window selection and the type of
application (Interactive Reporting Studio, Interactive Reporting Web Client, or Workspace).

Target Interactive Reporting Studio Interactive Reporting Web
Client

Workspace

New window Launches new window Launches new window Launches new window

Current window Launches new window Replaces current window Replaces content of the
Workspace tab, if the content is
derived from the Oracle's
Hyperion® Reporting and
Analysis – System 9 repository.
Otherwise, opens the hyperlink
object in a new window.

Top window Launches new window Replaces current window Opens in a new Workspace tab,
if the content is derived from
the repository. Otherwise,
opens the hyperlink object in
the top window.

Named window Launches new named window Launches new named window Launches new named window

Other properties of hyperlink controls are similar to the properties of text label graphics and the
OpenURL method. Hyperlink controls are added like embedded browser controls are added,
except that the control name in the Catalog pane is Hyperlink.

➤ To create instances of hyperlink controls:

1 Select Insert > New Dashboard.
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Inserting a dashboard section changes the document to Design mode. The content area is blank,
and the Catalog pane displays the available sections, graphics, and control objects.

2 From the Catalog pane, expand Controls.

3 Drag the hyperlink control onto the content area, and double-click the control.

Properties is displayed.

4 On the Object tab, enter a unique name for the hyperlink control.

The default name is Hyperlink.

5 Enter a title for the dashboard section.

The Title is only used when the dashboard section is printed.

6 Select Visible to display the hyperlink control when the dashboard section is executed.

By default, Visible is selected.

7 Select Locked to prevent the hyperlink control from being moved or deleted in dashboard Design mode.

By default, Locked is not selected.

8 From Display in, select where to display the contents of the hyperlink control:

● New Window—A pop-up window is created every time the hyperlink is clicked. This option,
which is the default, maps to the OpenURL OM method "_blank" target.

● Current Window—If the execution application is Interactive Reporting Web Client or
Workspace, the content replaces the Workspace content area (for example, excluding the
surrounding browse application panes). In Interactive Reporting Studio, a pop-up window
is displayed.

● Top Window—If the execution application is Interactive Reporting Web Client or
Workspace, the content replaces the top HTML window. This option maps to the OpenURL
OM methods "_top" target.

● Named Window—A named pop-up window is created. If a named window is currently
displayed, the URL replaces the content of the current window. When this option is selected,
the user can enter the new window name in the Target window text box that is displayed
below the drop-down list. This option maps to the user-specified, target-name option of the
OpenURL method.

9 Optional: To define explicitly the URL of the content to be displayed in the hyperlink control, in URL, enter
the URL address.

When the hyperlink control is rendered, the URL is used “as is” (server information is not
appended).

You can reference repository content by entering an explicit URL. In this case, the URL is treated
like any other external reference (no special authentication support).

It is important to plan how the content of the URL is displayed in the hyperlink control. An
action from within the hyperlink content can result in the browser, rather than only the contents
of the hyperlink control, being replaced.

10 Optional: To select a repository document (and associated properties) to be displayed in the hyperlink
control, select Repository, and perform one or more actions:
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● Document—Enter the path and name of the preferred repository document.

● Browse—Browse the repository for the preferred document.

● Options—Launch the Document Options dialog box, from which a user can select display
properties for a selected Workspace document. If the display type is New Window or Current
Window, the dialog box looks and behaves as described in “Working with Embedded
Browser Controls” on page 15. Also see “Document Options” on page 18.

11 Click OK.

Embedded Section Objects
Results, pivot, chart, table, OLAP and Report sections can be embedded in any Interactive
Reporting documents and viewed in Workspace. Data is updated in Workspace as it is updated
in the original sections.

The limitations to Interactive Reporting document files embedded in a dashboard through an
embedded browser or hyperlink control include:

● Online help is available through a toolbar or a dialog box.

● Number formatting options are not available.

● The Reference sub dialog box of the Computed Item dialog box is not available.

Properties that define what users can do with embedded sections:

● View-only—Can view static reports (The reports are displayed as thumbnails in the
dashboard section—as currently defined in the native-report section. Users cannot interact
with the reports.)

● Hyperlink—Can navigate to original sections by clicking thumbnails in the dashboard
section. An embedded Report object can only be displayed in View or Hyperlink.

Note:

In Workspace, for embedded objects, the Active property, available in Interactive Reporting
Studio and Interactive Reporting Web Client, is not enabled.

Embedded Section Object Scrollbar and Auto-Sizing
Properties
Scrollbar options are only available when an embedded object is view only. Scrollbar properties
on the Object tab determine how and when they are displayed: The horizontal and vertical
scrollbars can be used to scroll only the current page of the original section

● If the Show Scrollbar option is set to always, vertical and horizontal scrollbars are displayed
adjacent to but outside the container boundaries of the sections and do not obstruct them.

● If the Show Scrollbar option is set to never, vertical and horizontal scrollbars are not
displayed.
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● If the Show Scrollbar is set to automatic, The horizontal and vertical scrollbars appear when
necessary and not as a default.

If Auto-Size is enabled, the object data is scaled to fit within the container boundary of the
section, and the object cannot be scrolled. This means only the first page of the report is displayed.
Disabling the autosize option makes the scrollbars active.

Embedded Section Object Behaviors—View-Only
Behavior of view-only embedded section objects:

● Results and table—Selection of columns, rows, or column titles is not permitted.

● OLAPQuery and Pivot—Selection of report cells and handles is not permitted. (For a Pivot
embedded section object in active mode, a fact cell can be double-clicked to launch a script
if there is an OnCellDoubleClick event and JavaScript associated with the event . The event
is associated with the dashboard object, not with the pivot section. See Embedded Pivot
Section Interactivity)

● Chart—Selection of labels, bars, lines, and pie slices is not permitted.

● Results, table, OLAPQuery, pivot, and chart—Workspace speed-menu options, which
typically are displayed for selected sections, are not available.

● Reports—An embedded Report section is shown as a contiguous band that includes all the
pages of the section. design time helpers such as the Ruler and specific graphical markups
to outline boundaries of report elements are not displayed.

Embedded Section Object Paging
Paging standards used by embedded objects:

● If the original section includes multiple pages and the embedded section is selected, the
paging buttons of the Workspace toolbar are enabled. When a toolbar button is clicked, the
updated page view is displayed within the borders of the embedded section.

● Embedded-section paging is independent of original-section paging, and the paging of each
embedded section is independent of the paging of other sections, even if the other sections
are embedded in the same dashboard section and derived from the same original section.

● For hyperlinks, page view cannot be updated.

● In Workspace, hyperlinks are displayed in new tabs, if the hyperlink content is derived from
the repository and the hyperlink is set to display in the top window. If you select the current
window and the content is from the repository, the repository content replaces the current-
tab content. Otherwise, the content is displayed in a new window.

● If an action performed on the original section invalidates the current-page view of the
embedded section, the embedded-section view moves to the next valid page.

● Non-paging-related actions performed on original sections (such as column modification
and formatting) are propagated to all embedded sections (regardless of active-page or
embedded-section mode). In these cases, embedded sections retain their current page views.
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Embedded Section Object Design Considerations
Reminders for designers working with embedded objects:

● Because embedded section scrollbars are sometimes displayed outside defined boundaries,
objects and controls within embedded sections must be placed carefully, to avoid obstructing
the scrollbars.

● When you connect to a computer to start the BI Service on Windows, ensure that the color-
setting for the display is at least 16-bits. If the color setting is less than 16-bits, users may
encounter extremely long response times when opening chart sections of Interactive
Reporting documents. Color setting is a significant pre-startup step, especially when services
are started remotely (for example using VNC, Terminal Services, Remote Administrator, or
Timbuktu), because many remote administration clients connect with only 8-bit colors by
default.

Embedded Pivot Section Interactivity
Pivot tables embedded in dashboards as active sections can be scripted to enable users to double-
click cells and build interactivity around them. This feature is available on all fact cells of pivot
tables. When a fact cell is double-clicked, the OnCellDoubleClick event is fired, and JavaScript
associated with the event can be executed. The event is associated with the dashboard object,
not with the pivot section.

Embedded pivot section interactivity is available for Interactive Reporting Studio and Interactive
Reporting Web Client. It is not available for documents deployed in Workspace.

Prior to executing the script associated with the OnCellDoubleClick event, certain object-tree
properties are set. The properties are then valid from wherever within the object model that the
object is accessible, such as from document startup and shutdown scripts. If the pivot section is
recalculated, the properties are reset to the initial, default state, as if no double-click event had
occurred.

Properties set prior to executing OnCellDoubleClick events:

● OnCellDoubleClick (Method)

● FactName (Property)

● CellValue (Property)

● TopLabelValues (Array)

● SideLabelValues (Array)

See “Object-Level Events” on page 33.

Setting Dashboard Properties
You use the Properties dialog box to set properties for a dashboard section or for specific objects
within a dashboard section. Many dashboard objects have unique properties. For example, radio
buttons (option buttons) have Radio Group properties, and list boxes have Multiple Selection
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properties. Tab-order properties apply to all sections and are accessible in the Properties dialog
boxes for the dashboard section and for individual objects.

➤ To set properties for objects and dashboard sections:

1 Select an object on the content area or a dashboard section.

2 Right-click and select Properties, or select Dashboard > Properties.

Properties is displayed. The active tab depends on the selection made prior to invoking
Properties.

3 Set the properties for the object or dashboard section, by using the tabs.

Available properties:

● Alignment—Horizontal and vertical alignment, text wrapping, and rotation

● Border and Background—Border color, width, style, and shadow and background color
and pattern

● Font—Family, style, size, effects (underline, overline, double overline), and color

● Object—Name, title, visible, enable (control objects only), locked, scroll bars always shown,
and auto-size; for embedded sections, view-only, active, or hyperlink

● Picture—File name, size, and effects—for dashboard background and graphic object
pictures

● Tab Order—Object path that end users follow when Tab is pressed in Run mode

● Accessibility—User-defined and auto generated descriptive 508 text for each embedded
section or graphic

● Values—User-defined values that populate list box, drop-down lists, or text box controls

4 Click OK to apply the settings and close Properties.

Detailed information on the properties is presented in the online help.

Using Design Tools
Interactive Reporting Studio gives you complete control of your dashboard section setup and
provides layout and navigation tools that assist you in designing effective, high quality custom
applications.

Layout Tools
Layout tools are available from the dashboard menu or the dashboard section toolbar.

Using Design Guides
Design guides are horizontal and vertical lines that you place in your report to help you align
objects. Design guides are similar to grids in that objects automatically snap to align to the guides.
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If rulers are visible, you can click a ruler and drag one or more design guides from the horizontal
or vertical ruler.

➤ To display or not display design guides, select Dashboard > Design Guides.

If guides were visible, they are now invisible. If guides were not visible, they are now visible. If
guides are visible, a check mark is displayed before Design Guides.

Using Grids
Interactive Reporting Studio and Interactive Reporting Web Client provide a layout grid that
automatically snaps all objects to the closest grid point.

➤ To display or not display the grid, select Dashboard > Grid.

If the grid was visible, it is now invisible. If the grid was not visible, it is now visible. If the grid
is visible, a check mark is displayed before Grid.

Using Rulers
Horizontal and vertical rulers help you align items based on units of measure—inches,

centimeters, and pixels. You select a unit by clicking  (measure indicator) at the intersection
of the top and left rulers.

➤ To display and not display the ruler, select Dashboard > Ruler.

If the ruler was visible, it is now invisible. If the ruler was not visible, it is not visible. If the ruler
is visible, a check is displayed before Ruler.

Using the Dashboard Section Toolbar
The dashboard section toolbar provides icons that enable you to maneuver multiple dashboard
objects.
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Table 8 Dashboard Section Toolbar

Numbered Item Button Name Description

1 Design/Run Toggle between Design and Run modes

2 Align Aligns multiple selected objects to the first selected object (Select the first
object, press and hold Ctrl, and select the remaining objects. Click , and
select an alignment option: left, center, right, top, middle, or bottom)

3 Make Same Size Sizes multiple selected objects to the size of the first selected object. (Select
the first object, press and hold Ctrl, and select the remaining objects. Click

, and select a sizing option: width, height, or both)

4 Layer Stacks one object relative to other objects: bring to front, send to back, bring
forward, and send backward (Use this feature to layer multiple objects so that
only the sections of the objects that you want visible are displayed)

Using the Navigation Toolbar
You use the navigation toolbar to return to a dashboard section from another section when
Sections, section title bar, toolbars, and menus are turned off.

The navigation toolbar is hidden by default, but you can use scripts to enable it. When activated,

the toolbar is available in all sections and includes the  (Back),  (Forward), and 
(Dashboard Home—See “Setting Dashboard Home Sections” on page 21).

Use these scripts to work with the navigation toolbar.

This script activates the navigation toolbar.

//Syntax for turning on Navigation toolbar
Toolbars["Navigation"].Visible=true;

This script activates all toolbars except the navigation toolbar.

//Syntax for turning on all toolbars except the Navigation toolbar

j=Toolbars.Count

for (i=1; i<=j; i++) {
     if (Toolbars[i].Name != "Navigation") {Toolbars[i].Visible=true}
}

This script turns off all toolbars.

//Syntax for turning off all toolbars
j=Toolbars.Count

for (i=1; i<=j; i++) {
     Toolbars[i].Visible=false
}
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The Object Model 
The object model is the cornerstone for scripting customized interfaces (dashboards). The object
model and Script Editor provide access to all levels of Interactive Reporting.

The object model is a hierarchical representation of Interactive Reporting and the Interactive
Reporting Web Client objects and the actions (methods) and attributes (properties) that are
used to manipulate the objects.

Objects include applications, documents, sections, limits, connections, graphics, controls,
catalog items, topics, request lines, results columns, chart labels, pivot-side labels, facts, menu
bars, status bars, toolbars, and so on.

Methods include create, activate, open, close, save, add, copy, remove, process, export,
recalculate, and so on. For example, data-results objects (database-query results or tables that
contain results data) have a recalculate method, which refreshes (recalculates) data based on
updated parameters.

Properties include object names, values, alignments, colors, and so on. You can view properties
or set (modify) the values of properties. For example, all graphics objects have a visible property
—if set to true, an object is visible, and, if set to false, an object is invisible.

Table 9 Object Model Terminology

Term Definition Example Interactive Reporting Example

Object Items perceived as entities Tree, leaf, fruit Application, Section, Document

Method Actions that are executed when an
object receives messages

Grow, bear fruit, drop leaves Activate, Copy, Add

The Object Model 31



Term Definition Example Interactive Reporting Example

Property Qualities or distinctive features
(attributes)

Name, color, growing pattern Active, Visible, Type

Collection Groups of objects Grove Documents

Constant Values that do not change or vary Number Constants

Typically, the object model is manipulated by JavaScript from inside dashboard sections and
used to build self-contained analytic applications. On Windows systems, the object model is also
accessible through the automation interfaces (OLE Automation) that enable Interactive
Reporting to be controlled by external applications that can make OLE Automation calls (such
as Excel or, VB).

Interactive Reporting Events
Custom applications (that is, dashboard sections) that are developed using Interactive Reporting
and Interactive Reporting Web Client are event-driven. Events are actions; such as, clicking a
button or opening a document, that are recognized by Interactive Reporting documents, or
sections, or by dashboard objects. When an event occurs, Interactive Reporting and Interactive
Reporting Web Client invoke the script attached to the event. The order in which events are
executed depends upon the order of user actions.

You determine how events respond to actions by attaching scripts to events. For example, assume
that you want a particular action to occur when a particular button is clicked. You attach a script
that defines the response to the OnClick event associated with the button. When the button is
clicked, Interactive Reporting and Interactive Reporting Web Client invoke the script.

Note:

Since Interactive Reporting and Interactive Reporting Web Client Release 6.0, JavaScript has
been used as the scripting language. Documents scripts created using the Brio scripting language
are converted to JavaScript when documents are first opened.

Predefined event levels and the items with which they are associated:

● Object-level events—Dashboard objects

● Section-level events—Dashboard sections

● Document-level events—Interactive Reporting and Interactive Reporting Web Client
documents
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Object-Level Events

Note:

All events starting with OnClient are executed in the client browser, not on the server. See
“Client-Side JavaScript” on page 100.

Table 10 Predefined Object-Level Events Associated with Dashboard Objects

Event Associated Object Action that Invokes the Event

OnCellDoubleClick Dashboard sections within Interactive Reporting or
Interactive Reporting Web Client that contain pivot
Embedded Section Objects (ESOs) in Active mode

Note: Double-clicking label values does not initiate
OnCellDoubleClick.

Double-clicking fact cells or using
theOnCellDoubleClick () method

Note: Executing OnCellDoubleClick does not
corrupt documents, but actions invoked by
OnCellDoubleClick may corrupt documents.
Whether the corrupt state persists, within the
document or application, depends upon which
action is invoked.

OnClick Sections: Hyperlinked embedded sections (if not
View-only or Active)

Graphics: Line, horizontal line, vertical line, rectangle,
round rectangle, oval, text label, and picture

Controls: Command button, radio button, check box,
list box, drop-down list, and text box

Clicking sections, graphics, or controls.

The OnClick handler also supports the optional
bqoEvent parameter, which provides access to the
mouse cursor position relative to the Dashboard
control. The bqoEvent parameter contains two
properties: ClickX and ClickY. When the event occurs,
the event handler has access to the event related
information needed to process it. For example, the
event might require the position of the mouse cursor
for a picture OnClick event, or information about
which table column was clicked for a table
embedded section object OnClick event.

OnDoubleClick List box Double-clicking list-box values

OnSelection List box and drop-down list Selecting list-box or drop-down-list values

OnChange Text box (not available for Workspace) Changing data in text boxes

OnEnter Text box Entering text boxes

OnExit Text box Leaving text boxes

OnRowDoubleClick Active embedded results or table sections (if not
View-only or Hyperlinked)

Double-clicking rows

OnClientClick Command button, radio button, check box, list box,
text box, and drop-down list

Clicking sections or controls

OnClientDoubleClick List box Double-clicking list-box values

OnClientEnter Text box Entering text boxes
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Event Associated Object Action that Invokes the Event

OnClientExit Text box Leaving text boxes

Active Section-Level Events
Active section-level events are associated with dashboard sections.

Actions that invoke predefined section-level events:

● OnActivate—Entering a dashboard section

● OnDeactivate—Existing a dashboard section

Document-Level Events
Document-level events are associated with Interactive Reporting and Interactive Reporting Web
Client documents.

Actions that invoke predefined document-level events:

● OnStartUp—Opening an Interactive Reporting document

● OnShutDown—Closing an Interactive Reporting document

● OnPreProcess—Before a query is processed

● OnPostProcess—After a query is processed

The execution of document events can be enabled or disabled by using options in Script Editor
programmatically through the object model.

Note:

The Save and Save As commands in Interactive Reporting Studio, Interactive Reporting Web
Client, and Workspace do not execute the document shutdown scripts. The scripts execute only
when documents are closed.

Caution!

OnShutDown events execute before the prompts of the Save dialog box.

Associating Document-Level Events
By default, the desktop and Interactive Reporting Web Client applications invoke the scripts
attached to document-level events when the events are triggered. For example, the
OnStartup document event is triggered when Interactive Reporting documents are opened.

On the other hand, Hyperion Scheduler does not invoke a script attached to a document-level
event until the user sets the document-level event for the Interactive Reporting document

34 Working with the Interactive Reporting Object Model



manually. Settings for document-level events can be set based on how a document is to be
deployed (on the desktop, or on Workspace, or in Interactive Reporting Web Client).

➤ To associate document-level events:

1 Select File > Document Scripts.

Script Editor is displayed. Document is selected by default in the Object drop-down list, and
OnStartup is selected by default in the Event Trigger drop-down list.

2 From Event Trigger, select a document-level event to be associated with the Interactive Reporting document.

3 In Enable For, select the type of document to associate with the event.

Available types include All Clients (Interactive Reporting Studio, Thin Client (Workspace),
Plug-in Client (Scheduler), and SmartView (Workspace).

Note:

To remove a document-level event association, in Enable For, deselect the type of document.

Using Script Editor
You can use Script Editor (a built-in feature) to add scripts to events. Open the Script Editor for
an object, an active dashboard section, or a document. Script Editor contains the object browser,
description pane, events menu, and scripting pane.

➤ To open Script Editor, perform an action:

● From a section other than a dashboard section, select File > Document Scripts

● From within a dashboard section, in Design mode, select Dashboard > Scripts

● For an object, select Dashboard > Scripts

Using the Object Browser
Script Editor provides an object browser in the left pane. The browser displays the object model,
listing all available objects, properties, and methods. At the top of the hierarchy is Application,
which represents the Interactive Reporting application and contains application-wide settings
and options and methods, and properties. See Chapter 4, “Object Model Map.”

Clicking objects or collections displays methods, properties, and internal objects. Double-
clicking methods or properties generates scripts in the scripting pane of Script Editor.

The Application object contains a Documents collection and an ActiveDocument collection.
Methods and properties of the active document Sample1.bqy, are available in two places in the
object model hierarchy:

● Application > Documents > Sample1.bqy

● Application > ActiveDocument
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Scripts that access multiple open documents should use the Documents path to the methods
and properties of a document. Scripts that affect only the currently active document can use the
ActiveDocument path.

Using the Scripting Pane
You use the scripting pane to enter scripts that are attached to specific object events (such as
mouse clicks, button clicks, and so on). Use the object model to access objects, properties, and
methods. When you double-click an item in the object browser, a reference to the object,
property, or method is displayed in Script Editor at the cursor location.

Using the Events Menu
Above the scripting pane is the Object drop-down list that includes all available objects associated
with the selected document, section, or object. Adjacent to Object is the Event Trigger drop-
down list. This list displays the events for the control object, the action that invokes the script
attached to the event.

After selecting an event, you can enter JavaScript and reference the object model. To see or edit
scripts that extend beyond the scripting pane boundaries, use the horizontal and vertical scroll
bars.

Script Editor provides functions to:  (cut),  (copy),  (paste), and  (find and
replace, see “Finding and Replacing Within Scripts” on page 38).

Other functions provided by Script Editor:

● Check Syntax—Verify the script is written and edited correctly

● Go To Line number—Navigate to a specific code line in the script

Cutting, Copying and Pasting Dashboard Objects
You can cut, copy, and paste embedded sections, controls, or graphic objects in a dashboard
section.

➤ To cut, copy, and paste dashboard objects, embedded sections, or controls:

1 Select Ctrl+D to enter Design Mode.

2 Select an object, embedded section, or control on the content area.

Press Ctrl+Click to select multiple items. Selection handles display.

3 Select Edit > Cut, or select Ctrl+X.

The item is placed on the clipboard.

4 Optional: Select Edit > Copy, or selectCtrl+C.

5 Locate a position on the dashboard content area, position your cursor, and click.
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6 Select Edit > Paste.

The object, embedded section, or control is pasted to the new location.

Using the Description Pane and Online Help
When you select an item in the object model hierarchy, a brief description of the item is displayed
in the description pane. For example, selecting the ActiveDocument properties item displays the
description “Object/Document ActiveDocument.”

➤ To display Help text for object model items:

1 Select the item.

2 Click Help.

A help dialog box is displayed. It provides information on the selected method or property, such
as the type of argument expected.

Using a Sample JavaScript Script
Each level of the object model has a Methods folder that contains the methods (actions)
applicable to objects at that level. You can use the methods to write scripts.

Testing Scripts Using the Interactive Reporting Execution
Window

You can test scripts you are working on by copying and pasting them into the Interactive
Reporting Execution window. For example, instead of closing and reopening a document to test
the OnStartup script, copy and paste the script into the Execution window and press Enter. In
Interactive Reporting, select View > Execution Window.

Reviewing Error Messages in the Interactive Reporting Console
Window

The Console window records all error messages that occur from the time Interactive Reporting
starts until the application is closed or the window is cleared (with Edit > Clear). In Interactive
Reporting, select View > Console Window.
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Finding and Replacing Within Scripts
The Script Editor Find and Replace function enables you to search scripts for strings, punctuation
marks, and numbers. You can conduct partial-word and whole-word searches, apply case-
sensitive constraints, and replace individual or multiple occurrences of your search item.

Table 11 Find/Replace Definitions

Field Definition

Find What Enter the search criteria—a string, punctuation mark, or number. If you do not stipulate whole
word, the search criteria acts as a prefix. That is, “report” matches “reporting,” “reporter” and
“reported.” Wildcard characters cannot be used.

Replace With Enter the replacement text.

Match Whole Word Instructs the Find/Replace feature to match only the entire text that matches exactly your search
criteria. For example, “report” matches only “report”. It does not match “reports” “reporting”,
“reporter” and “re-ported.”

Match Case Instructs the Find/Replace feature to match only the text that matches the case of your search
criteria. For example, if you specify “Chart,” the found words must match “Chart” with a capital
C.

Direction Specify the direction from which to conduct the search, upward or downward. By default, the
direction is downward.

Replace Specify whether to replace, as indicated.

ReplaceAll Specify whether to replace of all occurrences.

Close Close the Find/Replace window.

Note:

In JavaScript version 1.4, if a regular expression starts with ‘|’ , this character is treated as a vertical
bar and not an alternate regexp metacharacter. For example, the regular expression “|aaa”
matches the string “bbb|aaa” starting at the fourth position, and it does not match the string
“aaabbb”. In JavaScript verion 1.5, the ‘|’ character is treated (when not quoted) as an alternate
metacharacter . In this case, the regular expression “|aaa” means “empty string OR ‘aaa’”. For
example “|aaa” matches the string “bbb|aaa” starting before the first character (and the matched
string is empty). The same occurs with “aaabbb”. It matches the empty alternative before the
first character. To make an older “|aaa” regular expression work in JavaScript 1.5, place quotes
around the | character with a backslash.. For example, enter “|aaa” as “\|aaa”, or “|Target~”. In
JS1.5 as “\|Target~”. Also note the JavaScript version 1.4 behavior not only occurs when ‘|’ is
located at beginning of whole regular expression, but also at the beginning of regexp group. For
example, you would need to change the regular expression “aaa(|bbb)” to “aaa(\|bbb)”. See
http://developer.mozilla.org/en/docs/Core_JavaScript_1.5_Reference.
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Note:

When the Find/Replace feature finishes its search, the message "Reached the end of the script.
All instances of search item replaced" or “Reached the end of the script. Cannot find Search
item” is displayed.
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About Scripts
When you use Interactive Reporting to create a dashboard, you can include one or more
Interactive Reporting documents and one or more of script components:

● Startup and Shutdown Scripts—Scripts that run when documents are opened and closed
(Save and Save As in Interactive Reporting Studio, Interactive Reporting Web Client, and
Workspace do not execute document shutdown scripts when saving documents. These
scripts only execute when documents are closed. To prevent a startup script from running,
press and hold Ctrl while opening the document)

● Dashboard Shapes and Controls—User-interface components that enable interaction with
the application

● Computed Columns—Scripts that run within the context of a results or table section column

● Custom Menu Items—Items that enable scripts to run from any section

On Windows, you can launch script commands from the command line. The commands must
include the -jscriptcmd flag. For example, to launch Interactive Reporting, you type

brioqry.exe –jscriptcmd "Application.Documents.Open ("c:\\temp\\hyperiondoc.bqy")"

Understanding Functions
Functions are a fundamental building block of JavaScript. A function is a JavaScript procedure:
a set of statements that performs a specific task. To use a function, you must define it before
your script can call it.
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Defining Functions
A function definition consists of the function keyword, followed by:

● The function name

● A list of arguments, enclosed in parentheses and separated by commas

● JavaScript statements that define the function, enclosed in braces { }

For example, to define a simple function named square, you type

function square(number) {
  return number * number;
}

The function name is square; the argument is number. The statement is return number *
number. The function returns the value of the argument multiplied by itself.

Changing Function Parameters and Object Properties
Parameters are passed to functions by a value. If a function changes the value of a parameter,
the change is not reflected globally or in the calling function. If you pass an object as a parameter
to a function and the function changes the properties of the object, the change is visible outside
the function.

Example:

function myFunc(theObject) {
  theObject.make="Toyota"
}
mycar = {make:"Honda", model:"Accord", year:2004}
x=mycar.make // returns Honda
muffin (mycar) // pass object mycar to the function
y=mycar.make // returns Toyota (property was changed by the function)

Calling Functions
In Interactive Reporting, all functions defined in the current script or defined globally or at a
higher level than the current script can be called.

Note:

Use caution when working with global variables. Global variables are visible throughout
Interactive Reporting, including to computed column calculations and report section
expressions.

Defining a function names the function and specifies what happens when the function is called.
Calling the function performs the specified actions with the indicated parameters. For example,
to call the function square (see “Defining Functions” on page 44) with an argument of 5, you
call square(5). The function executes its statements and returns the value 25.
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Function arguments can be strings, numbers, and objects. Functions can be recursive; that is,
they can call themselves.

Example—Recursive function that computes factorials:

function factoring) {
  if ((n == 0) || (n == 1))
    return 1
  else {
    result = (n * factorial(n-1) )
  return result
  }
}

You can compute the factorials of 1 through 5 as follows:

a=factorial(1) // returns 1
b=factorial(2) // returns 2
c=factorial(3) // returns 6
d=factorial(4) // returns 24
e=factorial(5) // returns 120

Function Scope
Functions are accessible within the scope in which they are created, unless they are explicitly
defined in a different scope. Thus, a function which is defined in the OnClick() event handler
of a command button can only be called by other statements in that event handler.

Example—Two command buttons in a dashboard section:

// MyButton
function square(value)
{
return value*value;
}
Alert (‘’The square of 3 equals ‘’+ square(3))

// YourButton
var retVal = square(3) 
// generates a runtime error
Alert (‘’The square of 3 equals ‘’+ retVal)

The square function is only visible in the context of MyButton. As a result, a call to the
square function from YourButton generates a runtime error.

Defining Functions in Different Scopes
To make functions visible to scripts throughout an application, you must explicitly define the
scope in which the function is visible. This objective can be accomplished in various ways:

● Using with statements

● Dynamically adding methods to objects

● Assigning functions to global variables
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Examples: Defining Functions in Different Scopes
When using a with statement to set the script scope, functions defined within the with statement
become visible for that object.

Example—Using a with statement:

// MyButton
With (YourButton)
{
  function square(value)
  {
    return value*value;
  }
  Alert (“The square of 3 equals “+ square(3))
}

// YourButton
var retVal = square(3)
Alert (“The square of 3 equals “+ retVal)

Explicitly defining the square function within the context of the YourButton object makes the
function visible to scripts that are running behind the button. Any object from the object model
can be used with the with statement.

Example—Dynamically adding a method to an object:

// MyButton
Function square(value)
  {
    return value*value;
  }
Alert (“The square of 3 equals “+ square(3))YourButton.square = square;

// YourButton
var retVal = square(3)
Alert (“The square of 3 equals “+ retVal)

A new method is added dynamically to the YourButton object. Scripts running in the context
of this object can access the dynamically created square function.

Example—Assigning a value to a global variable:

// MyButton
Function square(value)
  {
    return value*value;
  }
Alert (“The square of 3 equals “+ square(3)) MyGlobalFunction = square;

// YourButton
var retVal = MyGlobalFunction(3)
Alert (“The square of 3 equals “+ retVal)

Creating a variable named MyGlobalFunction without using the var statement places the variable
in the top scope. Thus, the variable is global.
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Using Variables
Variables used to create function components:

● Using Global Variables

● Using Document Variables

● Using Section Variables

Using Global Variables
Functions declared at the top level of scripts are global; that is, they are always in memory, and
all other functions can read and modify them.

You must carefully consider how and where to use global variables because a change to one
component of a variable affects all variables that reference the changed variable.

➤ To call a function using a global variable, type

glMyFunction(myParam)

Using Document Variables
Document variables belong to and depend upon the document script in which they are included.
That is, document variables are erased when their documents are closed or another variable is
defined for them. From one document, you can call functions in two ways: myFunction
(myParam) or ActiveDocument.myFunction(myParam).

Using Section Variables
Section variables exist in the section and document in which they are included. You use section
variables to specify elements defined from multiple dashboard sections (provided that each
section declares a function of the same name).

You can call the same-named function by typing

ActiveDocument.Sections["Dashboard"].myFunction(myParam)

(myParam) can be defined in two ways:

● In this.Parent.myFunction=myFunction, this.Parent is the parent object of
this, which can be a Fields or Shapes object and is the object to which the script belongs.

● In this.myFunction=myFunction, the object belongs to the OnActivate or
OnDeactivate method of the section and this is the section object.

Understanding Functions 47



Using JavaScript Statements
JavaScript uses conditional and loop statements to change the order in which scripts execute
(based on object states or user selections) and break statements to change the execution of control
structures.

● Conditional Statements

● Loop Statements

● break Statements

● for...in Statements

● with Statements

Conditional Statements
Conditional statements are sets of commands that execute if specified conditions are true.
JavaScript supports three conditional statements:

● if...else Statements

● Inline if Statements

● switch Statements

if...else Statements
If a logical condition is true, the if statement performs one or more actions. If a logical condition
is false, the else clause, which is optional, performs one or more actions.

A typical if statement:

if (condition) {
  statements1 
}
else {
  statements2 
}

Conditions are JavaScript expressions that evaluate to true or false. Statements to be executed
are JavaScript statements, including nested if statements. If you want to use multiple statements
after an if or else statement, enclose the statements in braces {}.

Do not confuse primitive-Boolean true and false values with Boolean-object true and false values.
Objects whose values are not undefined or null, including Boolean objects whose values are false,
evaluate to true when passed to conditional statements, for example:

var b = new Boolean(false);
if (b) // this condition evaluates to true

Note:

If you use an initial capital letter for if or else or type the word then, you receive an error message.
A then statement is implied for values enclosed in braces { }.
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You can use an if...else statement to stop a script when the script encounters a selected
condition, for example:

if(cellvalue==0){ Alert("Cell has no value") }
else{ (execute remainder of code here) }

Inline if Statements
Inline if statements are alternatives to if...else statements. They use the conditional
operator (?) to represent if statements and a colon (:) to representelse clauses. Such statements
require three operands:

condition ? expr1 : expr2

● condition—An expression that evaluates to true or false

● expr1, expr2—Expressions with values of any type

If condition is true, the value of expr1 is returned; if condition is false, the value of
expr2 is returned.

You should place the condition in parentheses and each expression in single or double quotes:

((condition == value)?'expr1':'expr2')

Note:

You can safely eliminate the condition parentheses, but omitting the quotes can cause problems.

Numbers do not require quotes.

(condition?2:10)

For example, to display one message if a variable is true and another message if the variable is
false, you can use this statement:

( isMember ? 'Member' : 'Not a member')

In this case, if isMember is true, Member is returned. If isMember is false, Not a Member is
returned.

You can also use the comparison operator:

((isMember == 'Yes' ) ? 'Member' : 'Not a member')

In this case, if isMember equals the string Yes,Member is returned. If isMember does not equal
the string Yes, Not a Member is returned.

If you want to nest inline if statements, (that is, use one inline if statement as an expression
for another inline if statement), enclose the nested inline if statements in parentheses:

(1 != 1 ? 'Not Equal' : (1 < 1 ? 'Less Than': 'Equal') )

In this case, if 1 does not equal 1, the second inline if statement is evaluated as part of the
else clause of the first inline if statement. If 1 evaluates as less than 1, the string Less Than
is returned. Because 1 equals 1, the string Equal is returned from the else clause of the second
inline if statement.
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Note:

If you open a Release 5.5 document in Interactive Reporting Release 6.x and the document
contains computed columns with nested if...else statements, the Interactive Reporting
JavaScript engine converts the if...else syntax to the inline if statement syntax. The
conversion process does not change the meaning or value of the original if...else statement.

switch Statements
switch statements evaluate expressions and match the values of the expressions to case labels.
If a match is found, the associated statement executes.

Example—switch statement:

switch (expression){
  case label : 
    statement;
    break;
  case label : 
    statement;
    break;
  ...
  default : statement;
}

The program searches for a label that matches the value of the expression and then executes the
associated statement. If no match is found, the program searches for the optional default
statement. If a match is found, the program executes the associated statement. If no default
statement is found, the program executes at the statement following the end of switch.

Break statements, which are optional, are associated with case labels. Break statements ensure
that, after matched statements execute, programs leave switch and continue execution at the
statement following switch. If break is omitted, the program continues execution at the next
statement of the switch statement.

In the following example, if expr evaluates to Bananas, the program matches the value with
case Bananas and executes the associated statement. When break is encountered, the
program terminates switch and executes the statement following is.

switch (expr) {
  case "Oranges" : 
    Console.Writeln("Oranges are $0.59 a pound."); 
    break; 
  case "Apples" :
    Console.Writeln("Apples are $0.32 a pound.");
    break;
  case "Bananas" : 
    Console.Writeln("Bananas are $0.48 a pound."); 
    break; 
  case "Cherries" :
    Console.Writeln("Cherries are $3.00 a pound.");
    break; 
  default :
    Console.Writeln("Sorry, we are out of " + i + "."); 
}
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Console.Writeln("Is there anything else you'd like?");

Loop Statements
Loop statements are sets of commands that execute repeatedly, until a specified condition is met.
JavaScript supports five loop statements:

● for Statements

● do...while Statements

● while Statements

● label Statements

● continue Statements

Note:

label, although not a loop statement, is frequently used with loop statements. break and
continue statements are also used within loop statements.

Note:

for...in statements, which also execute statements repeatedly, are used for object
manipulation. See “Manipulating Objects with JavaScript” on page 55.

for Statements
for loops repeat until a specified condition evaluates to false. The JavaScript for loop is similar
to the Java and C for loop.

for loop syntax:

for ([initialExpression]; [condition]; 
[incrementExpression]) {
   statements
}

When a for loop executes, the following occurs:

1. The initializing expression initialExpression, if any, is executed. This expression
usually initializes one or more loop counters, but the syntax accepts expressions of any degree
of complexity.

2. The condition expression is evaluated. If the value of condition is true, the loop statements
execute. If the value of condition is false, the for loop terminates.

3. The statements execute.

4. The update expression incrementExpression executes and control returns to step 2.
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do...while Statements
do...while statements repeat until a specified condition evaluates to false.

do {
  statement
} while (condition)

The statement executes once before the condition is evaluated. If the condition returns true, the
statement executes again. At the end of every execution, the condition is evaluated. When the
condition returns false, execution of the statement stops, and the statement following
do...while executes.

Example—do...while statement that iterates at least once and reiterates until it is greater than
five:

do {
  i+=1;
  Console.Writeln(i);
} while (i<5);

while Statements
while statements execute as long as a specified condition evaluates to true:

while statement syntax:

while (condition) {
  statements
}

If the condition becomes false, the statements within the loop stop executing and control passes
to the statement following the loop.

The condition test occurs before the loop statements are executed. If the condition returns true,
the loop statements are executed, and the condition is re-tested. If the condition returns false,
loop execution stops, and the statement following while executes.

Example—while loop that repeats as long as n < 3:

n = 0
x = 0
while( n < 3 ) {
  n ++
  x += n
}

With each iteration, the loop increments n and adds that value to x. Therefore, x and n obtain
the following values:

● After the first pass: n = 1, and x = 1

● After the second pass: n = 2, and x = 3

● After the third pass: n = 3, and x = 6

After the third pass, the condition n < 3 is no longer true, so the loop terminates.
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Example—while loop that never terminates; that is, the loop executes forever because the
condition never becomes false:

while (true) {
  Alert("Hello, world") }

label Statements
label statements refer to statements in other locations. For example, you can use label to
identify a loop and then use break to interrupt execution of the loop.

label statement syntax:

label : 
  statement

label can be any JavaScript identifier that is not a reserved word, and the statement identified
by label can be any type.

Example—markLoop (the label identifier) identifies a while loop:

markLoop:
while (theMark == true){
  doSomething();
}

continue Statements
continue statements can be used to restart while, do...while, for, and label statements.

● Forwhile and for, continue terminates the current loop and continues execution of the
loop with the next iteration

● For while, continue returns to the condition

● For for, continue moves to the increment expression

● For label, continue restarts the statement or continues execution of a labeled loop with
the next iteration. The continue statement must be in a looping statement that is identified
by the label that continue uses.

Note:

In contrast to the break statement, continue does not entirely terminate the execution of the
loop.

continue statement syntax: continue or continue [label]

Example—A while loop with a continue statement that executes when the value of i is 3.
Thus, n obtains the values 1, 3, 7, and 12.

i = 0
n = 0
while (i < 5) {
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  i++
  if (i == 3)
    continue
  n += I
}

Example—A statement labeled checkiandj that contains a statement labeled checkj:

checkiandj : 
  while (i<4) {
    Console.Writeln(i + ""); 
    i+=1; 
    checkj : 
      while (j>4) {
        Console.Writeln(j + ""); 
        j-=1; 
        if ((j%2)==0);
          continue checkj;
        Console.Writeln(j + " is odd.");
      } 
    Console.Writeln("i = " + i + "");
    Console.Writeln("j = " + j + ""); 
   }

If continue is encountered, the current iteration of checkj terminates, and the next iteration of
checkj begins. Iterations continue until the checkj condition returns false. When false is returned,
the remainder of checkiandj is complete and checkiandj reiterates until its condition returns false.
When false is returned, the statement following checkiandj executes. If continue had a label of
checkiandj, checkiandj would re-execute.

break Statements
break statements terminate loop, switch, or label statements.

When using break with a while, do...while, for, or switch statement, break terminates
the innermost enclosing loop or switch immediately and transfers control to the following
statement.

When using break within an enclosing label statement, it terminates the statement and
transfers control to the following statement. If a label is specified when the break is issued,
the break statement terminates the specified statement.

break statement syntax:break or break [label]

Example—Iteration through array elements until the index of an element with the value of
theValue is found:

for (i = 0; i < a.length; i++) {
  if (a[i] = theValue);
    break;
}
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Manipulating Objects with JavaScript
JavaScript uses for...in and with statements to manipulate objects.

● for...in Statements

● with Statements

for...in Statements
for...in statements iterate specific variables over all properties of an object. For each property,
JavaScript executes the specified statements.

for...in statements syntax:

for (variable in object) {
  statements }

Example—An object and its name used as the argument, iteration over all properties of the
object, and return of a string that lists property names and values:

function dump_props(obj, obj_name) {
   var result = ""
   for (var i in obj) {
      result += obj_name + "." + i + " = " + obj[i] + ""
   }
   result += "<HR>"
   return result
}

Example—Car (as the object) with properties make and model:

car.make = Ford
car.model = Mustang

with Statements
with statements establish default objects for sets of statements. JavaScript reviews unqualified
names to determine whether the names are properties of the default object. If an unqualified
name matches a property, the property is used in the statement; otherwise, a local or global
variable is used.

with statement syntax:

with (object){
  statements
}

Example—Math is specified as the default object; the PI property and the cos and sin methods
are referenced, but no object is specified for the references; therefore, Math is assumed to be the
object of the references:

var a, x, y
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var r=10   
with (Math) {
  a = PI * r * r
  x = r * cos(PI)
  y = r * sin(PI/2)
}

Microsoft Automation Interfaces and the Object Model
Typically, you use JavaScript to manipulate the object model from within a dashboard section
to build self-contained analytical applications. Because Interactive Reporting Studio is an OLE
Automation server, on Windows systems, you can use Microsoft Automation Interfaces to work
with the object model and with Interactive Reporting Studio in external applications such as
Excel, Visual Basic, C++, or any application that can make OLE Automation calls. The object
model is exposed through the brioqry.tlb file located in the system32 directory.

OLE Automation Controller within JavaScript (JOOLE)
Interactive Reporting Studio is an OLE Automation controller. On Windows systems,
Interactive Reporting Studio can control external applications (that is, programmable ActiveX
objects) that are OLE Automation servers. By making OLE Automation calls, Interactive
Reporting Studio can access functionality exposed by other OLE Automation Servers. Examples
of OLE Automation Servers, such as Excel and Visual Basic.

➤ To define a JOOLE object reference, use var <variableName> = new JOOLEObject
(<ProgId>).

<ProgID> is a string that indicates the object to be referenced. Interactive Reporting Studio or
Interactive Reporting Web Client passes the string as a reference to the object; for example,
Excel.Application. <ProgID> is stored in the registry and contains a string defined as
Project.ClassName.

JOOLE works on Windows systems only.

Note:

It is recommended that JOOLE calls stored in plug-in scripts be implemented on Internet
Explorer.

Tip:

You cannot embed OLE objects inside Interactive Reporting documents. Likewise, Interactive
Reporting Studio and Interactive Reporting Web Client are not OLE servers that produce OLE
objects that you can embed in OLE containers.
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Example—Invoking an Excel worksheet from a command button created in a dashboard section
and writing “Hello World” to rows of a column.

Excel = new JOOLEObject("Excel.Application"); 
Excel.Visible = true;
Excel.Workbooks.Add;
Excel.Sheets.Item(1).Cells.Item(2).Item(2).Value = "Hello";
Excel.Sheets.Item(1).Cells.Item(2).Item(3).Value = "World";
Print(Excel.Sheets.Item(1).Cells.Item(2).Item(2).Value);

Example—Invoking Outlook from a command button created in a dashboard section and
writing a message in the body of the e-mail message:

var olApp = new JOOLEObject("Outlook.Application") 
var olNote = olApp.CreateItem(0) 
olNote.To = "yourname@Hyperion.com"
olNote.Subject = "JOOLEObject mail Example"
olNote.Body = "This is an automatically generated note."
//olNote.Attachments.Add (filepath)
olNote.Send

Example—Using JOOLE to start Outlook on Windows XP:

var obj = Application.Shell("c:\\program Files\\outlook express\
\msimn.exe") 

Example—Invoking, displaying, and printing a Word document (Hello.doc) from a command
button created in a dashboard section:

/Create Word Object 
word = new JOOLEObject("Word.Application");
// Make is Visible 
word.Visible = true;
//Open the desired file 
word.Documents.Open("c:\\Hyperion\\Hello.doc");
// Set Options 
word.Options.PrintBackground = false;
//Start Printing 
word.ActiveDocument.PrintOut();

Example—Creating and writing text to a text file from an Interactive Reporting document file,
appending the characters “_trace” to the document name and replacing the document extension
with .TXT:

var oleApp = new JOOLEObject("Scripting.FileSystemObject")
var myPath=ActiveDocument.Path.slice(0,-4)+"_trace.txt"
var traceDoc=oleApp.CreateTextFile(myPath)
traceDoc.WriteLine("hello from Hyperion")
traceDoc.Close()

For example if the Interactive Reporting document is named DashboardText.bqy, Interactive
Reporting Studio or Interactive Reporting Web Client creates the text file named
DashboardText_trace.txt.
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Exporting Scripts to Text Files
You use the Export Scripts To Text File feature to export JavaScript scripts from Interactive
Reporting documents to text files. Interactive Reporting Studio categorizes text files by object
name and events and includes document and custom menu-item scripts.

➤ To export scripts to text files:

1 Select File > Export > Scripts To Text File.

Export Script is displayed.

2 Specify the file name and location, and click Save.
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Object Model Hierarchy
The object model map provides an expanded view of the object model hierarchy, as seen in Script
Editor. It begins at the highest level, Application, and drills down through the hierarchy. The
object model hierarchy:

● Application Level Hierarchy

● ActiveDocument Level Hierarchy

● Sections
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Table 12  Object Model Hierarchy

1 Application

2 ActiveDocument

3 Sections

4 Section specific

Application Level Hierarchy
Objects subordinate to the Application level:
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ActiveDocument Level Hierarchy
Objects subordinate to the ActiveDocument level:
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Sections
Objects subordinate to Sections:

● Query Section

● Dashboard Section

● Chart Section

● Results, Report, and Pivot Sections

● Table and OLAPQuery Sections
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Query Section
Objects subordinate to Query Section:

Dashboard Section
Objects subordinate to Dashboard Section:
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Chart Section
Objects subordinate to Chart Section:

64 Object Model Map



Results, Report, and Pivot Sections
Objects subordinate to Results, Reports, and Pivot Sections:
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Table and OLAPQuery Sections
Objects subordinate to Table and OLAPQuery Sections:
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Displaying and Entering Values in Text Boxes
You use Interactive Reporting Studio text boxes to display output to and gather input from the
application.

Ways in which, in Run mode, you can use text boxes:

● Entering values

● Displaying values
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● Displaying read-only information

● Validating data

● Calculating data

Text boxes are associated with three events: OnEnter, OnChange, and OnExit.

Example—For OnEnter, attach a JavaScript script

/* OnEnter Event—enables CommandButton */
var sect_name=’Dashboard’;
var ctrl_name=’CommandButton1’;
ActiveDocument.Sections[sect_name].Shapes[ctrl_name].Enabled = true;

Example—For OnChange, attach a JavaScript script

/* OnChange Event- validates changes*/
var sect_name=’Dashboard’;
var ctrl_name=’TextBox1’;
if (ActiveDocument.Sections[sect_name].Shapes[ctrl_name].Text==’Hello’)
{
Alert(‘Hello is an Invalid Entry’);
}

Example—For OnExit, attach a Javascript script

/* OnExit Event- increments variable counter */
var sect_name=’Dashboard’;
var ctrl_name=’TextBox1’;
if (ActiveDocument.Sections[sect_name].Shapes[ctrl_name].Text==’2’)
{
x=x+1;
}

Retrieving and Setting Object Properties
Interactive Reporting objects have associated properties, which represent attributes such as
name, visible, enabled, and text. Most properties can be set using the Properties dialog box in
the dashboard section.

Example—Get a ListBox property

/* Get the value of the ListBox MultiSelect property*/
var sect_name=’Dashboard’;
var ctrl_name=’ListBox1’;
TextBox1.Text =
ActiveDocument.Sections[sect_name].Shapes[ctrl_name].MultiSelect;

Example—Set a CheckBox property

/* Set the value of the CheckBox Checked property */
var sect_name=’Dashboard’;
var ctrl_name=’CheckBox1’;
ActiveDocument.Sections[sect_name].Shapes[ctrl_name].Checked = true;
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Example—Get a RadioButton group property

/* Get the value of the RadioButton Group property */
var sect_name=’Dashboard’;
var ctrl_name=’CheckBox1’;
TextBox1.Text =
ActiveDocument.Sections[sect_name].Shapes[ctrl_name].Group;

Object Model Placement and Sizing
All shapes and controls on a dashboard have a node called Placement, which contains properties
and a method to enable the shape or control to be moved or resized.

The Shapes collection contains two methods, CreateShape and RemoveShape, to enable shapes
to be created and deleted using COM or JavaScript.

Placement Node
The Placement node has four properties and one method that enable the parent shape or control
to be moved or resized.

All values given to and supplied from the Placement properties and methods are pixel values.

Placement Properties
These are the Placement properties.

XOffset—Sets or returns the position of the left-hand edge of a shape

YOffset—Sets or returns the position of the top of a shape

Width—Sets or returns the width of a shape

Height—Sets or returns the height of a shape

Placement Method
The Placement method, Modify(XOffset, YOffset, Width, Height), changes the origin and size
of the shape.

All parameters must be supplied. If YOffset, Width, or Height are not supplied, YOffset has a
value of zero, and Width and Height have a value one.

Using this method is a quick way to set all Placement properties at once.

Note:

To keep the current position or size of a shape when using the Placement.Modify method, supply
the current values using the Placement properties.
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Creating and Deleting Shapes
The Shapes collection includes two methods (CreateShape and RemoveShape) that enable
shapes and controls to be created and deleted using COM or JavaScript.

CreateShape Function
To programmatically create a shape on a dashboard, use CreateShape(bqShapeType,
[sectionName]). The first parameter specifies the sort of shape or control to be created and must
be one of the values of the bqShapeType enumeration.

If the shape being created is an embedded section, the section parameter must be the name of
the section to be embedded. This must be a chart, pivot, result set, or table. If the name of any
other section type is supplied the function fails and an exception is thrown.

When creating shapes using COM, you must supply a value for the second parameter. You can
supply the empty string “” for this value for shapes and controls other than embedded sections.

Shapes are created at the top-left of the dashboard section, with a default size based on type of
shape or control. The default size is the size used when the shape is dragged onto the dashboard
in Design mode.

A reference to the newly created shape is returned from this function. You can use the reference
to set the Placement of the shape using the Placement properties or functions, see “Placement
Node” on page 71, and you can set the name of the shape using the Name property.

Note:

Using more than 1,021 shapes is not supported in a Dashboard section.

RemoveShape Function
RemoveShape(shapeName) can be used to delete a shape from a dashboard using COM or
JavaScript. Pass the name of the shape to be deleted as the shapeName parameter.

Caution!

The RemoveShape operation cannot be undone.

Using the Placement Properties and Method
In the procedural example, an object; for example, a graphic of a ball, is moved across a screen
by using the Placement properties and method.

Note:

Modify the example to suit your requirements.

72 JavaScript Examples



Placing Objects
Example—Using the properties and method of the Placement node.

➤ To move an object (graphic) across a dashboard frame:

1 In Interactive Reporting Studio, select File > New.

New File is displayed.

2 Select Other > A Blank Document, and click OK.

The document opens in Design mode.

3 From the catalog pane, expand Graphics, drag the rectangle onto the dashboard and resize it to be bigger.

4 Right-click the rectangle, and select Properties.

Properties is displayed.

5 In Properties, enter a Name for the rectangle, and click OK.

For example, type Field. The rectangular shape is the area that the ball graphic moves across.

6 Optional: Select Border and Background, and change the Background color.

7 From Graphics, drag a picture onto the dashboard, and then navigate to and select an image of a ball.

8 Right-click the ball graphic, and select Properties.

9 In Properties, enter a Name for the graphic, and click OK.

For example, type Ball.

10 From the catalog pane, expand Controls, and drag an option button onto the dashboard.

With the option button selected, drag a copy to the right to create a duplicate.

11 Right-click the first option button, and select Properties.

12 In Properties, enter a Name, Title, and Group Name, and click OK.

For example, type Left as the Name, Move Left 100 as the Title, and LeftRight as the Group
Name.

13 Repeat step 12 for the second option button with alternate data.

For example, type Right as the Name, Move Right 100 as the Title, and LeftRight as the Group
Name.

14 From Controls, drag a command button onto the dashboard, right-click, and select Properties.

15 In Properties, enter a Title, and click OK.

For example, type Move Ball.

16 Right-click Move Ball again, and select Scripts.

Script Editor is displayed.

17 Copy and paste this script into the editor. You can modify the script to suit your requirements.

var moveHoriz
if (Right.Checked){

Using the Placement Properties and Method 73



   moveHoriz = 100
}else{
  moveHoriz = (-100)
}
var left = Ball.Placement.XOffset
var top = Ball.Placement.YOffset
var width = Ball.Placement.Width
var height = Ball.Placement.Height

if (moveHoriz > 0){
   if ( left+width+moveHoriz > Field.Placement.XOffset + 
Field.Placement.Width){
      Alert ("Reached the right end of the field","Goal !!! Yay!!!")
      Ball.Placement.XOffset = Field.Placement.XOffset + 
Field.Placement.Width - Ball.Placement.Width
      Left.Checked = true
      return
   }
}else{
   if ( left+moveHoriz < Field.Placement.XOffset){
      Alert ("Reached the left end of the field","Goal !!! Yay!!!")
      Ball.Placement.XOffset = Field.Placement.XOffset
      Right.Checked = true
      return
   }
}
Ball.Placement.Modify(left + moveHoriz, top, width, height)

18 Click OK to close Script Editor.

19 Press Ctrl+D to exit Design mode, and save the dashboard.

Verifying Functionality
When the objects and the script are added to the dashboard, verify that the code is functioning
correctly.

Test the functionality by clicking Move Ball. The ball moves 100 pixels at a time. When it reaches
the edge of the rectangle, an alert is displayed.

Using CreateShape and RemoveShape
You use the CreateShape method to add a shape to a dashboard; for example, a goal for football,
and you use the RemoveShape method to remove the shape of the goal. To perform the physical
adding and removing of the shape, configure two command buttons.

Note:

Modify the example to suit your requirements.
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➤ To configure two command buttons:

1 In Interactive Reporting Studio, use the dashboard from the Placing Objects procedure.

2 Press Ctrl+D to enter Design mode.

3 From the catalog pane, expand Controls, and drag two command buttons onto the dashboard.

4 Right-click CommandButton2, and select Properties.

5 In Properties, enter a Name and Title.

For example, type AddGoal as the Name, and Add a Goal as the Title.

6 Repeat steps 4-5 for CommandButton3 with alternate data.

For example, type DelGoal as the Name, and Delete the Goal as the Title.

7 From Graphics, drag a rectangle onto the dashboard, right-click, and select Properties.

The rectangle will be added or removed by the command buttons.

8 In Properties, enter a Name.

For example, type LeftGoal.

9 Select Add a Goal, right-click, and select Scripts.

10 In Script Editor, copy and paste this code, or modify to suit your requirements.

var objRect = ActiveSection.Shapes.CreateShape(bqRectangle)
objRect.Name = "LeftGoal"
objRect.Placement.XOffset = Field.Placement.XOffset - 10
objRect.Placement.YOffset = Field.Placement.YOffset - 10
objRect.Placement.Width = Ball.Placement.Width - 60
objRect.Placement.Height = Field.Placement.Height + 20
objRect.Fill.Color = bqBlack

11 Click OK to close Script Editor.

12 Right-click Delete the Goal, and select Scripts.

13 In Script Editor, copy and paste this code, or modify to suit your requirements.

try{
   Shapes.RemoveShape("LeftGoal")
   
}catch(e){} // no worries it does not exist

14 Click OK to close Script Editor.

15 Press Ctrl+D to exit Design mode, and save the dashboard.

Verify CreateShape and RemoveShape Functionality
Test the functionality by clicking Add a Goal. The goal shape is displayed. Click Delete the Goal,
and the goal shape is removed.
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Enabling and Disabling Controls
Dashboard graphics and controls have an Enable property that determines whether, in Run
mode, they are enabled or disabled. Users can use enabled objects to trigger events. Users cannot
use disabled objects (which are displayed as dimmed) to trigger events. The Enable property is
available, for graphics and controls, from the Object tab in the Properties dialog box.

Example—Enable a control

/* Enables controls */
var sect_name=’Dashboard’;
var ctrl_name=’TextBox1’;
ActiveDocument.Sections[sect_name].Shapes[ctrl_name].Enabled = true;

Example—Disable a control

/* Disables controls */
var sect_name=’DashboardDashboard’;
var ctrl_name=’TextBox1’;
ActiveDocument.Sections[sect_name].Shapes[ctrl_name].Enabled = false;

Controlling the Visibility of Graphics and Controls
Dashboard graphics and controls have a Visible property that determines whether, in Run mode,
they are displayed. Users can use only visible objects to trigger events. The Visible property is
available, for graphics and controls, from the Object tab in the Properties dialog box.

Example—Make a control visible

/* Makes control Visible */
var sect_name=’Dashboard’;
var ctrl_name=’TextBox1’;
ActiveDocument.Sections[sect_name].Shapes[ctrl_name].Visible = true;

Example—Make a control invisible

/* Makes control Invisible */
var sect_name=’Dashboard’;
var ctrl_name=’TextBox1’;
ActiveDocument.Sections[sect_name].Shapes[ctrl_name].Visible = false;

Creating Interactive Reporting Database Connection Files
(OCEs)

Example—Create an Interactive Reporting database connection file (OCE)

// try to create sample.oce from scratch.
// create SQLNet-Oracle8 oce - save as sample.oce
MyConnection = ActiveDocument.Sections["Query"].DataModel.Connection
MyConnection.Open("c:\\OCEs\\Sample.oce")
MyConnection.Username = "hyperion"
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MyConnection.SetPassword("hyperion")
MyConnection.Connect()
MyConnection.SaveAs("c:\\temp\\sample.oce")

ActiveDocument.Sections["DataModel"].DataModel.Connection.Open("c:\\temp\
\astro8.oce")
// need to connect ?
ActiveDocument.Sections["DataModel"].DataModel.Connection.UserName = 
"hyperion"
ActiveDocument.Sections["DataModel"].DataModel.Connection.SetPassword
("hyperion")
ActiveDocument.Sections["DataModel"].DataModel.Connection.Connect()

Displaying a Connection Login Box
Example—Display a connection login box

ExecuteBScript(“set logon root, 'OCENAME', 'd:\\programfiles\\hyperion\
\oces\\Astro SQLNet Oracle8.oce': connect logon root”)

Downloading Data Models
Example—Download from the repository a data model, standard query, or standard query with
report

//download a data model, standard query or standard query with reports //
from a local repository
//(document name to gain the download), (type of document), (repository //
owner) (group with access), (name of document)
ExecuteBScript("download doc root, 'SQR', 'ts', 'PUBLIC', 'Sales")

Displaying Table Catalogs
Example—Display a list of tables available on the database

// display table catalog
ActiveDocument.Sections["DataModel"].DataModel.Catalog.Refresh()

Adding Topics To Data Model Sections
Example—Add topics to a data model section

// add topics to DataModel section
CatItem = ActiveDocument.Sections
["DataModel"].DataModel.Catalog.CatalogItems["PCW_ITEMS"]
ActiveDocument.Sections["DataModel"].DataModel.Topics.Add(CatItem)
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Setting Up Topic Object Variables
Example—Set up topic object variables

// setting up topic objects variables...
PCWItems = ActiveDocument.Sections["DataModel"].DataModel.Topics
["PCW_ITEMS"]
PCWSales = ActiveDocument.Sections["DataModel"].DataModel.Topics
["PCW_SALES"]
PCWCustomers = ActiveDocument.Sections["DataModel"].DataModel.Topics
["PCW_CUSTOMERS"]
PCWPeriods = ActiveDocument.Sections["DataModel"].DataModel.Topics
["PCW_PERIODS"]

Adding Joins
Example—Add a join

// add join between PCW_PERIODS (Day) and PCW_SALES (Order_Date)
PCWPeriods_Day = PCWPeriods.TopicItems["Day"]
PCWSales_OrderDate = PCWSales.TopicItems["Order_Date"]
Day_OrderDate_Join = ActiveDocument.Sections
["DataModel"].DataModel.Joins.Add(PCWPeriods_Day,PCWSales_OrderDate,
bqJoinSimpleEqual)

Adding Items to the Request Line
Example—Add items to the request line

// add items to the request line
ActiveDocument.Sections["Query"].Requests.Add("PCW_CUSTOMERS", "Store")
ActiveDocument.Sections["Query"].Requests.Add("PCW_SALES", "Store_Id")
ActiveDocument.Sections["Query"].Requests.Add("PCW_SALES", "Order_Date")
ActiveDocument.Sections["Query"].Requests.Add("PCW_SALES", "Delivery_Date")
ActiveDocument.Sections["Query"].Requests.Add("PCW_SALES", "Units")
ActiveDocument.Sections["Query"].Requests.Add("PCW_SALES", "Amount")
ActiveDocument.Sections["Query"].Requests.Add("PCW_CUSTOMERS", "City")
ActiveDocument.Sections["Query"].Requests.Add("PCW_CUSTOMERS", "State")
ActiveDocument.Sections["Query"].Requests.Add("PCW_PERIODS", "Year")

Adding Computed Columns to Query Request Lines
Example—Add a computed column to a query request line

// add computed column to Query request line - Amount/Units
ActiveDocument.Sections["Query"].Requests.AddComputedItem
("CompItem","Amount/Units",3)
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Creating and Setting Variable Filters (Limits)
Example—Create and set variable filters

// create and set variable limit - Store_Id
mylimit = ActiveDocument.Sections["Query"].Limits.CreateLimit
("PCW_SALES.Store_Id")
mylimit.Operator = bqLimitOperatorLessThanOrEqual
mylimit.CustomValues.Add(10)
mylimit.SelectedValues.Add(10)
ActiveDocument.Sections["Query"].Limits.Add(mylimit)
mylimit.VariableLimit = true

Using a BrioQuery 5.5 Limit Dialog Box to Store Values
Example—Use a BrioQuery 5.5 Limit dialog box to store values in a text box

ExecuteBScript("modify limit root.'Pcw Customers'.'Store Type'.'Store 
Type'")
var limit = ActiveDocument.Sections["Query"].Limits["Store Type"]
var TextBox = ActiveSection.Shapes["TextBox1"]
if (!limit.Ignore)
{
TextBox.Text = limit.SelectedValues[1]
}
else
{
TextBox.Text =""
}

Turning Off Page Headers on Report First Page
Example—For the first page of a report, turn off page headers

if ( PageNm==1)
{' '}
else
{"Query Processed:  "+ Format(new Date(), "d-mmm-yyyy")}

Turning Off the Prompt to Save Dialog Box
Example—On an OnShutdown event, shut down the Interactive Reporting application

Application.Quit(false)
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Identifying Errors
When syntax or runtime errors occur and scripts fail to execute, you must debug the code.
Preventing errors is preferable to finding and fixing errors. Therefore, observe carefully the
protocols required by Javascript.

Space-Saving Variables
Exception to the code-entry rule: If you plan to use an object model path repeatedly, define it
as a variable, to save space and create a compact script.

Example—What not to type:

ActiveDocument.Sections["Query"].DataModel.Connection.Username = "hyperion"
ActiveDocument.Sections["Query"].DataModel.Connection.SetPassword("hyperion")
ActiveDocument.Sections["Query"].DataModel.Connection.Connect

Example—What to type:

DMPath = ActiveDocument.Sections["Query"].DataModel.Connection
DMPath.Username = "hyperion"
DMPath.SetPassword("hyperion")
DMPath.Connect
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Treat space-saving variables as object model paths. That is, insert periods between object model
segments, and do not add unnecessary spaces.

Also, include only objects in the path; that is, do not include methods or property segments for
the objects:

Example—Incorrect script, because ActiveDocument.Sections["Query"].Limits does
not have an Activate() method:

LPath = ActiveDocument.Sections["Query"].Limits
LPath.Activate()

Example—Correct script:

LPath = ActiveDocument.Sections["Query"]
LPath.Activate()

Case-Sensitive Code
JavaScript is case-sensitive.

Case-related rules:

● JavaScript statements (for example, var, if…else, while, switch, and so on) begin with
lowercase letters. The script Var StringName = "John Smith" fails because Var is
capitalized.

● JavaScript core operators start with uppercase letters, for example, new Date(). The script
new date() fails because date is not capitalized.

● Object model path segments begin with uppercase letters; for example,
ActiveDocument.Sections["Dashboard"].Activate(). Both
activeDocument.Sections["Dashboard"].Activate() and
Activedocument.Sections["Dashboard"].Activate() fail because the
ActiveDocument is not properly capitalized.

● You must refer to variables as you define them. For example, if you define a variable as
var StringName, you must refer to it as StringName, not Stringname or
stringName or stringname.

Assignment Operators Versus Comparison Operators
JavaScript distinguishes between assignment and comparison operators.

Example—Assignment operator:

myvar = 5

Example—Comparison operator:

if (myvar == 5)

Be careful with operators, particularly when assigning argument values to methods.
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Example—Syntax that assigns hyperion to DMPath.SetPassword.

DMPath = ActiveDocument.Sections[”Query”].DataModel.Connection
//This works…
DMPath.SetPassword(“hyperion”)

//This does not!!!!
DMPath.SetPassword = "hyperion"

Conditional Tests
When using if statements, avoid impossible conditional tests.

Example— A incorrect script, which returns myvar is not 5!, even though myvar is 5,
because 5 is not the same as five:

var myvar = 5
if ( myvar == "five")
  {
  Alert("myvar = 5!")
  }
else
  {
  Alert("myvar is not 5!")
  }

You need to know how variables report in various situations. The Console.Writeln() and
Alert() methods are especially useful in diagnosing problems related to inaccurate reporting
of variables.

Example—A correct script, in which the JavaScript core operator String is used to format
myvar for the Console window:

var myvar = 5
Console.Writeln(String(myvar))
if ( myvar == "five")
  {
  Alert("myvar = 5!")
  }
else
  {
  Alert("myvar is not 5!")
  }

If you are comparing a value that you selected in a list or drop-down list to another value, verify
the retrieved value before you compare it. You want to avoid confusing the placement of the
selected item with the value of the selected item.

For example, if a drop–down list contains 4, 9, 15, 25, and 36 and you select 36, the following
script returns myvar is 5!:

var myvar = DropDown1.SelectedIndex
Console.Writeln(String(myvar))
if ( myvar == 5)
  {
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  Alert("myvar = 5!")
  }
else
  {
  Alert("myvar is not 5!")
  }

The result occurs because DropDown1.SelectedIndex returns the placement, not the value,
of 36.

Consider another example: A drop-down list contains one, two, three, four and five. When you
select five, the following script returns myvar = five!

DropDown1 = ActiveDocument.Sections["Dashboard"].Shapes.DropDown1
var myvar = DropDown1.SelectedIndex
Console.Writeln(String(myvar))
if ( myvar == 5)
  {
  Alert("myvar = five!")
  }
else
  {
  Alert("myvar is not five!")
  }

Five is returned because five is the fifth item. You receive the correct result, but for the wrong
reason.

Consider another example: The drop-down list contains the values one, two, three, four, and
five. When you select five, the following script returns the value that is displayed in the drop-
down list (the correct value, five):

DropDown1 = ActiveDocument.Sections["Dashboard"].Shapes.DropDown1
var myvar = DropDown1[DropDown1.SelectedIndex]
Console.Writeln(String(myvar))
if ( myvar == "five")
  {
  Alert("myvar = 5!")
  }
else
  {
  Alert("myvar is not 5!")
  }

Syntax Displayed in the Description Pane
On the bottom left of the Script Editor, directly above the Help button, is the Description pane.
The Description pane shows you the necessary syntax for any item you select in the Object
browser.

For example, if, in the Object browser, you navigate to Application > ActiveDocument >
Sections > Query > Methods and select Activate(), the description pane reads void
Activate().

This display indicates that the Activate() method does not accept arguments.
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If you select Export(), the description pane reads

void Export(String Filename, BqExportFileFormat FileFormat, [optional] Boolean 
IncludeHeaders)

This display indicates that Export() accepts three arguments, two required and one optional.

Recalculating Results
Scripts that include limits (filters) may execute slowly because the scripts must recalculate the
data set each time a limit is modified. You can use the SuspendRecalculate property to
prevent a results limit from forcing recalculations.

Example—Limit values are dynamically selected from a list, but recalculation occurs only after
the last value is selected:

Sections[sect_name].Limits[limit_col].SuspendRecalculation = true;
Sections[sect_name].Limits[limit_col].SelectedValues.RemoveAll();
for(I = 1; I <= ListBox2.SelectedList.Count;I++)
{
  NewLimitValue = ListBox2.SelectedList[I];
  newname  +=  ListBox2.SelectedList[I]
  Sections[sect_name].Limits[limit_col].SelectedValues.Add(NewLimitValue);
}
Sections["Results"].Limits["1"].SuspendRecalculation = false;
Sections[sect_name].Limits[limit_col].Ignore=false; // Trigger recalculation now

Designing Scripts
JavaScript is an interpreted, not a compiled, language that evaluates and runs code line in
sequence. If JavaScript finds a problem with a code line, it stops. Although the syntax checker
of Interactive Reporting Studio Script Editor identifies some obvious syntax errors, many errors
are not noticed until runtime.

Identifying whether each line of code executes or fails, as you develop scripts, is a time-effective
way to identify and avoid problems.

The Console window displays error messages and alert values that are generated by the JavaScript
interpreter. During script debugging cycles, you can write messages to the Console window to
track the state of variables and the progress of the script. If a syntax error is detected, the error
and the line number in which it occurs are displayed. You can use the line number to move
directly to the error in the Script Editor.

You use one of three methods to write to the Console window: Console.Write(),
Console.Writeln(), or Alert().Console.Write() and Console.Writeln()are
essentially identical. Console.Write() does not add carriage returns at the ends of lines, and
Console.Writeln() does add carriage returns.

Console.Writeln() is usually, but not always, the preferred technique. It enables the script
to run without user interaction, and the Console window records each line as it is written to the
Console.
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Note:

Console.Writeln()is spelled with a lowercase l and n.

The Console window also displays the buffer that contains messages about the errors that occur
from when Interactive Reporting Studio starts. Thus, the Console window may display
information that is no longer of value.

➤ To clear the error buffer, select Edit > Clear.

You can access the Console window from any section within a document; it remains open until
you close it. When the Console window is closed, the buffer size is 1,000 bytes. When the Console
window is open, the buffer size is 641 bytes.

To work through a challenging section of code, you should use Alert().

Whatever method you use, you must identify the beginning and end of each script and each
code line before the script or each code line executes.

Example—A script that moves to the query section and removes limits:

Console.Writeln("Start Query Script")
Console.Writeln("Step1")
ActiveDocument.Sections["Query"].Activate()
Console.Writeln("Step2")
ActiveDocument.Sections["Query"].Limits.RemoveAll()
Console.Writeln("Step3")
Console.Writeln("End Query Script")

For the example script, the Console window displays the following message:

Start Query Script
Step1
Step2
Step3
End Query Script

Code Entry
To avoid errors, add code to the Script Editor scripting pane by double-clicking an object in the
Object browser or by cutting and pasting rather than by typing.

Bypass Errors
The try-catch block, which is borrowed from Java, is used to bypass errors.

General syntax for a try-catch block:

try
{do something}
catch(errorname)
{do something with the error}
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finally
{do something else}

Example of a try-catch block:

QPath = ActiveDocument.Sections["Query"].Limits
try
{QPath.Activate()}
catch(e)
{Alert(e.toString())}
finally
{Alert("We're Done!")}

The try-catch block does not usually identify definition errors but does identify errors such
as use of a lowercase d in date():

try
{Alert(new date())}
catch(e)
{Alert(e.toString())}
finally
{Alert("We're Done!")}

Getting Assistance with Problem Scripts
If you follow all recommended practices and your script does not function properly, consider
opening a call with Hyperion Solutions Customer Support at 1-877-901-4975 or visit the
Hyperion Web site (http://www.hyperion.com).

When you contact Hyperion Solutions Customer Support, be prepared to show the Interactive
Reporting document that contains the problem script and to specify the section and control
within which the script resides.

If your data is confidential, consider using the sample script that ships with Interactive Reporting
Studio to duplicate your Interactive Reporting document, saving your document file without
results, or limiting the results sets.

➤ To set results options, select Query > Query Option.

Problems in one script may result from problems in another script. Therefore, Hyperion
Solutions Customer Support may also need to evaluate your startup scripts and your dashboard
section scripts. For this reason, it is recommended that you use the Console.Writeln()
method to identify each code line to the Console window.
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Architecture of Workspace
Workspace generates dynamic HTML, enabling users to interact with Interactive Reporting
documents from browser interfaces. Users perform actions such as drilling into and processing
data, changing chart types, and swinging pivots, and Workspace generates HTML pages on
demand.
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Workspace Components
● Interactive Reporting HTML Servlet—An information broker between the browser and

Interactive Reporting

● Interactive Reporting Service—The back-end component that opens, manages, and renders
HTML versions of Interactive Reporting documents (The HTML documents are returned
to Interactive Reporting HTML Servlet.)

● Data Access Service (DAS)—The component that is responsible for and manages all
database requests

Workspace Performance-Enhancing Features
Workspace offers several performance-enhancing features:

● Partial Document Loading

● Multithreading

● Distributed Components

● Disk Caching Of Interactive Reporting Documents

Partial Document Loading
Only required sections of Interactive Reporting documents, rather than whole documents, are
loaded.

Multithreading
Rather than one process executing serially on one thread or several processes executing on
multiple individual threads (requiring greater memory overhead), one process executes
concurrently on multiple threads (in a multitasking or multiprocessing environment).

Distributed Components
Rather than software components being centralized within a system, they are modularized and
deployed anywhere within a network, with communication coordinated by messages passed
among components.

Disk Caching Of Interactive Reporting Documents
Rather than disk access being required for everyInteractive Reporting document request, data
read from disk is stored in memory and thus is readily available to the next request.
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Interactive Reporting Features Supported in Workspace
Interactive Reporting sections:

● Drill down and drill into (chart and pivot)

● Drill anywhere (chart and pivot)

● Swing pivots

● Add and remove totals (pivot)

● Add and remove items (results, chart, and pivot)

● Data functions (chart, pivot)

● Add, remove, and modify cume (cumulative) (chart and pivot)

● Surface values (pivot)

● Show and hide items

● Sort

● Grouping labels (chart and pivot)

● Add and remove grand and break totals (results)

● Specify chart type (chart)

● Set legend on XYZ Axis (chart)

● Show values (bar, pie, and line charts)

● Process relational and OLAP queries

● Recognition of document and dashboard section events

● Blank content areas for empty sections

Interactive Reporting graphics and control objects:

● Recognition of most dashboard object events

● Interaction with dashboard controls

● Most embedded dashboard section objects

● Most dashboard and report graphics objects

Interactive Reporting object model:

● Most functions of the object model

● Definition and manipulation of filters (limits) through the object model

Interactive Reporting Web Client features:

Four of the six Interactive Reporting Web Client adaptive states. See Behaviors specific to
Interactive Reporting features supported in Workspace.

Behaviors specific to Interactive Reporting features supported in Workspace:

● For Interactive Reporting Web Client—Adaptive States Query and Analyze and Data Model
and Analyze are not completely available, because only their view, process, and analyze
portions are honored. Adaptive States override defined roles.
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● When Process All occurs (dashboard and report) or when the ProcessAll() method is called,
users are prompted for connection information prior to processing, not following each query
process.

● All errors are handled by log files. There is no feature equivalent to the Console window,
but most errors are displayed.

● If no data items are supplied for a section, the browser pop-up menu is overwritten with
one “add item” pop-up menu.

Workspace Limitations—Designing and Using Interactive
Reporting Document Sections

Because of limitations of the HTML standard or a user set specification, some Interactive
Reporting functions are not supported in Workspace, and some functions behave differently in
Workspace.

● General Functions—Workspace Limitations

● Query and Data Model Sections—Workspace Limitations

● Results and Table Sections—Workspace Limitations

● Pivot Sections—Workspace Limitations

● Chart Sections—Workspace Limitations

● Dashboard Sections—Workspace Limitations

● Report Sections—Workspace Limitations

General Functions—Workspace Limitations
General Interactive Reporting functions that cannot be performed in Workspace:

● Define layout

● Format (Format defined in the published document is displayed, format is applied only
through the object model.)

● Hide and show, insert and delete, and duplicate and rename sections (The functions can be
performed through the object model.)

● Set or read tools options (for example, default formats)

● Export to text, Excel, Lotus, or JPEG formats

● Export scripts to text

● Use native print (can print using the browser, Acrobat (PDF format), or through Scheduler)

● Password-protect documents

● Create or use custom menus

● Insert, delete, or show page headers and footers
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From the user interface, for OLAP sections, Workspace supports only sort, drill-up, drill-down,
and auto-size width. However, additional OLAP functionality is available through the object
model.

Query and Data Model Sections—Workspace Limitations
Interactive Reporting functions related to query and data model sections that Workspace does
not support:

● Access to data model sections from the user interface (Sections can be accessed through the
object model.)

● Programmatic application of variable filters (Filters can be applied non-programmatically.)

● Query canceling

● Query log and custom SQL options

● Addition of subqueries

● Creation of local result tables or derived queries (Local results and derived queries can be
displayed.)

● Creation of union queries

Ways in which Interactive Reporting functions related to query and data model sections behave
differently in Workspace.

● For Interactive Reporting documents that contain union queries, the first query is displayed.
For union queries, the request and filter panes in data layout are read-only, and there is no
union controller line.

● Subqueries are indented in the Sections pane but displayed as regular queries in the content
area.

● For queries that contain multiple join paths, Workspace defaults to the first join path.

OLAPQuery Sections—Workspace Limitations
Interactive Reporting functions related to OLAPQuery sections that Workspace does not
support:

● Drill through

● Ad hoc OLAPQuery capabilities from the user interface (OLAPQuery building is available
through the object model.)

● Access to OLAPQuery sections from the user interface (Sections can be accessed through
the object model.)

● Filters from the user interface (Filters are supported through the object model.)

● Programmatic application of variable filters (Filters can be applied non-programmatically.)

● Query canceling
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Results and Table Sections—Workspace Limitations
Interactive Reporting functions related to results and table sections that cannot be performed
in Workspace:

● Import results sets

● Sort computed columns based on order functions

● Show or hide row numbers

● Insert, delete, or modify computed columns (Columns can be inserted, deleted, and
modified through the object model.)

● Group columns

● Suppress duplicates

● Set spotlighter conditions

● Enable grid lines, borders, or background

For format-related items (spotlighter, grid lines, border, and background), format can be
displayed in Workspace and set through the object model.

Pivot Sections—Workspace Limitations
Interactive Reporting functions related to pivot sections that cannot be performed in Workspace:

● Drill to detail

● Insert, delete, or modify computed columns (Sections can be accessed through the object
model.)

● Change or restore pivot-label names

● Manually refresh data (Sections can be accessed through the object model.)

● Pivot data labels or corner labels

● Use the Chart-This-Pivot function

● Set or remove pivot page breaks

Chart Sections—Workspace Limitations
Interactive Reporting functions related to chart sections that cannot be performed in Workspace:

● Drill to detail

● Resize individual chart components

● Insert, delete, or modify computed columns (Sections can be accessed through the object
model.)

● Manually refresh data (Sections can be accessed through the object model.)

● Use the Pivot-This-Chart function

● Select or specify the location of chart legends
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● Reorder chart items

● Change or restore chart-label names

● Rotate pie charts

Dashboard Sections—Workspace Limitations
Interactive Reporting functions related to dashboard sections that cannot be performed in
Workspace:

● Access dashboard design mode

● Define dashboard tab order

● Perform OnRowDoubleClick (Active ESOs), DoubleClick (ListBox), OnChange (TextBox),
or OnEnter (TextBox)

● Use diagonal lines, round rectangles, or ovals

● Align or rotate text label objects

Interactive Reporting functions related to dashboard sections that behave differently in
Workspace:

● Active objects embedded in dashboard sections behave like hyperlinks

● View-only objects with AutoSize=Off that are embedded in dashboard sections behave like
hyperlinks

● For unsupported graphics objects (diagonal lines, round rectangles, and ovals), other
graphics objects are substituted (lines, rectangles, and rectangles, respectively).

● For the DropDown control, the OnSelection event is not executed if the first selection is the
first list item—an HTML limitation. To resolve the problem, users must select another item
prior to selecting the first item or developers must make the first item a blank entry.

● Command-button text wrap is available only through Internet Explorer, and not when the
508 accessibility feature is enabled.

Report Sections—Workspace Limitations
Interactive Reporting functions related to report sections that cannot be performed in
Workspace:

● Enable users to build or lay out reports

● Use diagonal lines, round rectangles, or ovals

● Align or rotate text label objects

Interactive Reporting functions related to report sections that behave differently in Workspace:

● The Data Path field is set to local path.

● For unsupported graphics objects (diagonal lines, round rectangles, and ovals), other
graphics objects are substituted (lines, rectangles, and rectangles, respectively).
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Computed Items Workspace Limitations
Special characters must not be used in column or control names in Interactive Reporting
documents files to be deployed in the Workspace. These characters include:

● |

● $

●

● \

● half width Yen

● half width Won

Using these characters in controls is not supported, and can contribute to rendering issues.

Creating Predefined Drill-Down Paths
For Workspace, you can create predefined drill-down paths that move through the levels of
detail that are defined in the data model. Drill-down paths are associated with dimensional tables,
which consist of numerous attributes about business processes, such as about product lines or
geographical locations. As the designer, you specify the items and the order of items through
which users drill down when they perform chart or pivot analysis.

Within dimensional tables, topic items are included in drill-down paths, and fact values are
excluded from drill-down paths. Thus, if you want to exclude items from drill-down paths, you
tag them as fact values. In Workspace, unlike in Interactive Reporting Studio, you cannot use
missing items that are not defined in the drill-path as pivot and chart items.

In Workspace, drill-down paths are accessed from a shortcut-menu option: “Drilldown into
(ITEM_NAME).” In Workspace, unlike in Interactive Reporting Studio, drill-down paths are
not context-sensitive. When users select from the shortcut menu, all available drill-down paths
are displayed. Each path shows the topic item that is being drilled and the label item from which
it is drilled. Drilled items add their return values as pivot-label or chart-label items.

Drill-down-path definitions originate in the data model or in query tables. All pivots and charts
sections derived from data models that include drill-down paths inherit the drill-down-path
definitions. This capability can be used to augment the Drill Anywhere option in Interactive
Reporting Studio and Interactive Reporting Web Client, or the administrator can disable Drill
Anywhere and permit users to drill on only one predefined path.

➤ To define drill-down paths in query or data model sections:

1 Click the topic window header.

2 Select View  > Properties.

Topic Properties is displayed. By default, topic items are displayed in the order in which they
are defined in the underlying table. You can hide or show selected items (click Hide All or Show
All), or you can alphabetize items (click Sort).
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3 Define the drill path:

● Click Sort to arrange items alphabetically

● Click Hide All and Show All to toggle the display of items in the topic

4 Click Set as Dimension to establish the item order in which a user can drill-down when charts or pivots are
analyzed.

The drill path is defined under Items to Display.

5 Optional: Move selected items up or down in the topic list by clicking Up or Down.

6 Click OK.

If you intend to use a topic item on the request line but eliminate it from the drill-down path,
add the item to the request line before completing the following procedure.

➤ To remove items from the drill-down path:

1 Select the table to which the item belongs, right-click, and selectProperties.

Topic Item Properties is displayed.

2 From Items to Display, double-click an item

The asterisk (*) displayed to the left of the topic item is removed.

3 Click OK.

Chart Sizing
When you work with Interactive Reporting charts, you see multiple rectangular regions. By
default, there is one global rectangular region, called size object. Typically, the graphic object
(which contains the chart) and other objects (such as the objects holding the chart legend and
the chart labels) fit inside the size object.

When you manipulate the sizes of objects, you may affect the rendering of the chart in HTML
format and cause elements to be clipped. To avoid clipping elements rendered in HTML-
rendered charts, ensure that all chart elements fit inside the global object. (You can see the
rectangular outlines of the objects by clicking various parts of the chart.)

Locating Errors
When syntax or runtime errors occur and scripts fail to execute, you must debug the code.
Preventing errors is preferable to finding and fixing errors. Therefore, observe carefully the
protocols required by JavaScript. See Chapter 6, “Troubleshooting Scripts”.

Console Window
The Console window, which displays the error buffer, is not available from Workspace.
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Error Logs
The Workspace displays errors to an HTML dialog box or generates entries to error logs:

● Interactive Reporting BI1 [server] log

● Interactive Reporting Data Access Service [server] log

● Interactive Reporting DAServlet log

● Interactive Reporting HTMLServlet message log

For information about interpreting the logs, consult Hyperion Solutions Customer Service.

try-catch Block
You can use try_catch blocks to test the usefulness of syntax or, within scripts, to isolate a
sequence of steps. See “Bypass Errors” on page 86.

Controls
Controls, inserted into dashboard sections, enable users to interact with the application
dynamically. Display-related controls supported for Interactive Reporting document files:

● Command button

● Radio button

● Check box

● List box

● Drop down

● Text box

● Embedded browser

● Hyperlink

Note:

Using Interactive Reporting reserved keywords (such as ActiveSection) can result in
unpredictable behavior.

Control Objects Properties
Basic control properties such as name, visible, auto-size, and so on are accessible through the
object model, but not through the Workspace user interface. Some limitations apply to control
properties.
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Table 13 Control Limitations in Workspace

Control Limitation in Workspace

Command button Text wrap is available only in Internet Explorer and not available when the 508 accessibility feature
is enabled.

Drop down The OnSelection event does not fire when the first selection from the down-down list is the first
item on the list. You must enter a blank for the first item or instruct users to select some other
list item before selecting the first list item.

Text box The OnEnter and OnChange events do not fire.

Note: In Netscape, dashboard text boxes with the password property set to TRUE display only
the bottom half of the cursor at the very top of the text box. The issue is visual only; functionality
is intact.

Graphics
From Workspace, users can display graphics in documents but cannot insert graphics into
dashboard sections.

The graphics available for you, as a designer, to use in Workspace documents:

● Text label—Overline effect; double-overline effect; vertical and horizontal rotation; vertical
and horizontal, up and down rotation

● Line

● Horizontal line

● Rectangle

● Round rectangle

● Oval

● Picture—Picture clip effect (upper left corner clip of the image); picture tile effect

If you are working with graphics that Workspace does not support, substitute supported graphics
or omit the graphics.

Note:

All graphics support the OnClick event.

Borders, Background, and Fonts
Workspace enables you to apply border, background, and font properties for graphic objects in
the object model but does not enable users viewing the document in Workspace to modify the
properties.
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Events
Interactive Reporting Studio and Interactive Reporting Web Client have events (document
events, dashboard-section events, and dashboard-object events) that can fire in Interactive
Reporting documents, generally in response to user actions.

Within Workspace, all document events (including OnStartUp, OnShutDown, OnPreProcess,
and OnPostProcess) and all dashboard section events (including OnActivate and OnDeActivate)
are supported. Two dashboard object events (OnClick and OnExit—for text boxes only) are
supported, and four dashboard object events (OnRowDoubleClick; OnDoubleClick;
OnChange; and OnEnter) are not supported.

Note:

Document events can be turned on or off.

When deploying documents for use on the Web, you must evaluate how events behave within
Interactive Reporting documents.

Client-Side JavaScript
You can use client-side JavaScript to designate scripts to run in client-browser sessions. Because
JavaScript enables fast responses to mouse clicks, form inputs, and page-navigation actions, it
is useful for validating form information.

For example, you can script a JavaScript function on the HTML page to confirm that users
entered required information, such as address and telephone number. If required information
was not supplied, the embedded script displays a dialog box. Thus, server response is required
only for non-scriptable browser functions, and, by using JavaScript, you avoid form redrawing,
server processing and download of invalid data.

Note:

Object model methods that are not supported and properties that are associated with
OnClientXXX event scripts are ignored by Internet Explorer and Safari. When, in a script,
Netscape 7 and Mozilla encounter non-supported object model methods and properties,
execution stops. Only some object model methods and properties can be associated with
OnclientXXX scripts: TextBox.Text, TextBox.Enable, TextBox.Visible, TextBox.Font,
TextBox.Scrollable, TextBox.Name, TextBox.Password, and TextBox.Type.

Client Status
Status indicators that client-side JavaScript uses to instruct server code to run or not run:

● ActiveSection.ClientScriptStatus

● Object.ClientScriptStatus

100 Designing for Workspace



For example, if a client-side JavaScript script (which might be activated by a command button)
determines that a user entered alphabetic rather than numeric data, the server-side JavaScript
script does not run until the user enters the data correctly.

You use ActiveSection.ClientScriptStatus indicators, which take Boolean values, to coordinate
actions between objects.

You use Object.ClientScriptStatus indicators, which take Boolean values, to initiate actions for
objects. Object is a placeholder for the object name; for example,
CommandButton1.ClientScriptStatus is a valid status indicator. Independent objects are subject
to the script status settings of ActiveSection.

Table 14 Behavior of Status-Indicator Settings in Workspace

Indicator Value ActiveSection.ClientScriptStatus Object.ClientScriptStatus

True Server-side scripts are initialized when client-side script
execution concludes.

Client-side scripts are initialized when the browser page
is refreshed.

Client-side scripts are initialized when
users perform a required action, such as
clicking a button.

False No server-side script is executed. No server-side script is executed.

For example, consider a dashboard that contains a password field and Submit and Cancel
buttons. The password field contains a client-side script that requires an alphanumeric password
of at least 6 characters. If ActiveSection.ClientScriptStatus is false (the user entered the password
incorrectly) and the user clicks Submit, the password is not sent to the server. However, the
Cancel button can reset ActiveSection.ClientScriptStatus to true and enable cancel logic, that is
implemented at the server level, to run.

Client-Side Events
Client-side events are displayed in the Event Trigger drop-down list of Script Editor. All events
are executed in the Workspace browser, not on the server.

Table 15 Client-Side Events Associated with Controls 

Event Controls That Support the Event Action That Invokes Event

OnClientClick Command button, radio button, check box,
list box, drop-down list, text box

Clicking a control

Note: Using the Euro symbol or other special
characters in control names for the OnClient
script causes a JavaScript error in the
Workspace. Dashboard control names must
not contain these characters: %, #, &, *, !, ,
\, /

OnClientDoubleClick List box Clicking a control

OnClientEnter Text box Entering a text box

OnClientExit Text box Leaving a text box

Client-Side JavaScript 101



Event Controls That Support the Event Action That Invokes Event

OnCliehttp://
wealthtrack.com/
ntSelection

Drop down Selecting an item from a drop-down list

Text Box Events and Properties
When creating client-side JavaScript, designers can use text box events and properties. In
Workspace, for text box events, both client-side and server-side components run, but server-
side components do not execute.

Text box properties that can be used in client-side JavaScript:

● TextBox.Text

● TextBox.Enable

● TextBox.Visible

● TextBox.Font

● TextBox.Scrollable

● TextBox.Name

● TextBox.Password

● TextBox.Type

Alert Dialog Box
Workspace supports use of alert dialog boxes, modal windows that display messages and are
displayed as full Web pages. When a box is displayed, to continue working on the browser, users
must dismiss the box (by clicking OK).

The Alert() method can be called from any supported event, except OnStartUp and
OnShutDown.

Up to three custom-named buttons can be displayed on alert dialog boxes. When users select a
button, the integer associated with the button is returned. For example, if the user selects button
#1, the number 1 is returned.

Syntax used, in the object model, to create the alert dialog box:

Expression.Alert(Prompt As String, [Title As String], 
[Button1Text As String], [Button2Text As String], 
[Button3Text As String]) As Integer

Toolbars
Control of which toolbars are displayed for Workspace versions of Interactive Reporting
documents is determined in the Interactive Reporting object model. Toolbars can be hidden, to
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limit user control of Interactive Reporting documents. For example, the standard and formatting
toolbars can be hidden when documents are opened. Toolbars can be displayed as needed. For
example, the navigation toolbar can be displayed, to extend the users' ability to navigate.

All methods and properties, including all individual toolbar properties, of the toolbar collection
in the Interactive Reporting object model are available to you.

Properties of the standard, paging, and navigation toolbars:

● Name

● Type

● Visible

Note:

Paging toolbar properties are available as constant values in the BqToolbars group. If you try to
access the paging toolbar in Interactive Reporting Studio or Interactive Reporting Web Client,
the script command is ignored, no exception is recorded, and the script continues.

Toolbars Not Required in Workspace
Toolbars that are not required in Workspace:

● Formatting—If, from Workspace, a script attempts to access associated properties for a
toolbar, the script command is ignored, no exceptions are recorded, and the script continues.

● Paging and Navigation—If the standard Interactive Reporting toolbar is enabled, these
toolbars are not enabled because they are subsets of the standard toolbar.

Standard Interactive Reporting Toolbar
The icons of the Interactive Reporting toolbar are specific to features used exclusively for
Interactive Reporting document files:
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Table 16 Standard Interactive Reporting Toolbar options Workspace

Number Name Description

1 Save Saves the file locally and launches the Interactive Reporting document file in the Interactive Reporting Web
Client so you can view the document and save it to your desktop for offline viewing (Interactive Reporting
document files can be viewed only by the full desktop or Interactive Reporting Web Client. If the Interactive
Reporting Web Client is not installed, the browser is launched automatically.)

Tip:  If you want to save the Interactive Reporting document file to the repository, select File > Save or
File > Save As.

2 Export to XLS Exports a section to Excel and launches it inside your browser, if the MIME type is set to recognize the XLS
file extension (Thereafter, the file is saved locally and manipulated through Excel. If the MIME type is not
set to recognize the XLS file extension, a Save As dialog box is displayed, to enable you to save to a local
location.)

3 Export to PDF Exports a section to Portable Document Format (PDF) and launches it inside your browser, if the PDF MIME
type is set in your browser (If the PDF MIME type is not set in your browser, the browser Save As dialog
box is invoked.)

4 Refresh In all but dashboard and report sections, refreshes the current section against the database server, to
retrieve the most current data set

In dashboard and report sections, refreshes all queries, in the order in which they are displayed in the
Sections catalog of the full client (For example, in an Interactive Reporting document file with Query1,
Query2, and Query3, Query1 is executed first, Query2 is executed second, and so on.)

5 Page Right In report and chart sections, moves one page or one view to the right, respectively (To move to the first
page or view to the right, select Shift+Click+right arrow.)

6 Page Down In report and chart sections, moves one page or one view down, respectively (To move to the bottom page
or view, select Shift+Click+down arrow.)

7 Page Up In report and chart sections, moves one page or one view up, respectively (To move to the top page or
view, select Shift+Click+up arrow.)

8 Page Left In report and chart sections, moves one page or one view, respectively, to the left (To move to the first
page or view to the left, press Shift+Click+left arrow.)

9 Current Page On the tooltip, displays the number of the current page

For chart types, except pie, scatter, and bubble, tooltips display data points on the x and y axes (Based
on the Maximum Bars Displayed property in the Label Axis dialog box.)

10 Dashboard Home Displays the dashboard Home section

11 Navigate Forward Moves to the next section

12 Navigate Back Returns to the last viewed section

13 Data Layout Enables the Data Layout feature

Event Controls for Toolbar Display
You use object model commands to determine which toolbars are displayed in Workspace and
which toolbars are defined for embedded sections in personal pages.
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Within Workspace, script commands that display toolbars and that are executed through trigger
events supported by the object model:

● Document Scripts Trigger Events (used with OnStartup, On Shutdown, OnPreProcess, and
OnPostProcess)

● Dashboard Section Display Trigger Events (used with OnActivate and OnDeactivate)

● Dashboard Object Trigger Events (used with OnClick, OnSelection, and OnExit)

Rules for Toolbars in Workspace
Rules for the display, in Workspace, of the standard and paging toolbars:

● Only one toolbar can be displayed at one time.

● If a script sets the Visible property of both toolbars to true, the toolbar latest in the script
execution is displayed, and the Visible property of the toolbar earlier in the execution is set
to false.

● Workspace may display no toolbars.

● The Page x of y field displays the current page number and an unknown y value until you
navigate to the last page. From the time that you first arrive at the last page and for the
remainder of the session, the Page x of y field displays the current page number and the
total-number-of-pages number. Section fields that display Page x of y values match the Page
x of y tooltip. If an Interactive Reporting document file contains a section with page
information and the file is saved without the results from the section, when the Interactive
Reporting document file is processed, only the first page of the section is generated

These Workspace toolbar rules are consistent with the rules enforced by the Personal Page
Display Properties option buttons.

Personal Pages
For personal pages, toolbar display settings that are specified through object model script
commands supersede toolbar display settings that are specified by owners. Therefore, the
designer of the Interactive Reporting document file, not the personal pages owner, determines
which functions and options are available to users, and script commands to show or hide toolbars
for embedded sections are executed even if they alter the owner's toolbar selections.

For personal pages, if an Interactive Reporting document file contains no object model script
commands that govern toolbar display, the owner's toolbar-display selections are enforced.

Section 508 Compliance
Section 508 compliance behavior for toolbars in Interactive Reporting document files:

● The first line of the page (invisible link) is reached by pressing Alt+H, regardless of which
toolbar is displayed on the page

● An invisible link enables a user to skip the paging toolbar
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● ALT text for all paging toolbar buttons is provided

● When in 508 compliant mode, the toolbar property Visible must show or hide the correct
version of the standard or paging toolbar

Accessibility
The Accessibility property enables designers of dashboard sections to display dashboard sections
and objects that are more accessible to disabled users.

The Accessibility property is a read-only Boolean (true or false) value that exists as a document-
collection-object property:

Document[<collection index value or document file name>].Accessibility
ActiveDocument.Accessibility

To set the Accessibility property, users use the 508 Compliance Preferences setting, which is
within the Browse Publish application. The setting persists only for the duration of an Interactive
Reporting document session, not for the duration of an Interactive Reporting document file.
Users with the Accessibility property enabled set the property by selecting from the document
list, an Interactive Reporting document file to display in Workspace. Rules governing which
Boolean value applies to the property:

● If the Accessibility property is enabled in the Browse Publish application, the property is set
to true

● If the Accessibility property is disabled, the default, which is false, applies

The property is not set for document-link selections on Interactive Reporting Web Client,
regardless of the user's Accessibility status, as Interactive Reporting Web Client is not Section
508 compliant.

Guided Analysis and Reporting
Guided analysis and reporting enables you to select a point of view (POV) from one Hyperion
product and seamlessly pass it to another Hyperion product. Guided analysis and reporting
focuses the second product on the POV of the first product and eliminates the need for you to
launch the second product and drill down to the preferred POV.

For example, if you are navigating through a bar chart in Web Analysis and require information
from a relational data source, you select a bar on the chart (as the POV) and select the Related
Content option. Workspace launches the relevant Interactive Reporting document file and
displays a relational chart that is based on the POV sent from Web Analysis.

Note:

Depending upon the type of link established at design time, you may be prompted to navigate
to the preferred Interactive Reporting document file.
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In the background, in Oracle's Hyperion® Web Analysis – System 9, a direct or embedded link
is defined, and the Interactive Reporting document file to which to send the POV is selected.
When an Interactive Reporting document fileis selected, a SmartCut (a link—URL—to an item
in the Hyperion Foundation repository) is created, and the Workspace client is invoked. The
Smartcut includes the parameters that define the POV.

http://Aserver.hyperion.com/Hyperion/browse/get/AFolder/Test.bqy?
store=21&product=A&year=2003

Processing the POV
As a designer of POV-linked Interactive Reporting document files, you provide a script to parse
the SmartCut, identify the relevant POV information, navigate the Interactive Reporting object
model, and apply the POV values where and if appropriate.

➤ To process POVs:

1 Retrieve the SmartCut for the document.

2 Create an OnStartUp script that performs these actions:

● Parses the SmartCut, using JavaScript and the object-model-sessions object

● Identifies the POV parameters and assigns to them to global variables

● Traverses the object model tree and applies applicable values where and if appropriate

Parsing SmartCuts and Storing Data in Global Variables
Use the sessions object of the object model to parse the SmartCut.

Extract all relevant data and store it in global variables.

Example of using the sessions object to extract values from a SmartCut:

var store_id = Session.URL.Item(‘store’);
var product_id= Session.URL.Item(‘product’);
var year_id= Session.URL.Item(‘year’);

Traversing the Object Model Tree
Starting from the root of the object model tree, traverse relevant branches and nodes.

Apply values to relevant properties.

The best place to apply the property-value code is the OnStartUp script.

Example of traversing a query section branch of the object model tree and applying Store as the
query limit:

//gets the store id value from the SmartCut
var A_Limit=Session.URL.Item('store_id');

//identifies query section to work with
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var QuerySect=ActiveDocument.Sections["Query"];

//checks all limits till the appropriate one is found and applies limit
for (i=1; i<=QuerySect.Limits.Count; i++)
{
    if  (QuerySect.Limits[i].Name=="Store")
     QuerySect.Limits[i].SelectedValues.Add(A_Limit)
}
ActiveDocument.Sections["Query"].Process()

Object Model Items Excluded from Workspace
Some objects, methods, and properties of the object model do not affect the Workspace
environment. Therefore, when designing an Interactive Reporting document file for use with
Workspace, you must exclude (not reference) some objects, methods, and properties.

If a script encounters an excluded method or property, a warning is entered in an error log, and
script execution continues, if possible. If you must include excluded methods or properties,
include them in Interactive Reporting document files that are designed for desktop viewing.

Object model items that are excluded from Workspace (applicable to all operations that depend
on Interactive Reporting Service, including Interactive Reporting document jobs):

● ActiveDocument.Close()

● ActiveDocuments.Modified()

● ActiveDocument.PromptToSave()

● ActiveDocument.SetODSPassword()

● ActiveDocument.ODSUsername (Set only)

● ActiveDocument.Save()

● ActveDocument.SaveAs()

● ActiveDocument.Sections[“SectionName”].Copy()

● ActiveDocument.Sections[“Chart”].XLabels.DrillInto()

● ActiveDocument.Sections[“Dashboard”].Shapes[“TextBox1”].OnChange()

● ActiveDocument.Sections[“Dashboard”].Shapes[“TextBox1”].OnEnter()

● ActiveDocument.Sections[“Dashboard”].Shapes[“ListBox1”].OnDoubleClick()

● ActiveDocument.Sections[“Dashboard”].Shapes[“Results1”].OnRowDoubleClick()

● ActiveDocument.Sections[“OLAPQuery”].Slicers.Add()—Only the case where the last
argument VariableSlicer=TRUE. Ignores the last argument, always defaulting to
VariableSlicer=FALSE

● ActiveDocument.Sections["Query"].DataModel.Connection.DBLibAllowChangeDatabase

● ActiveDocument.Sections["Query"].DataModel.Connection.DBLibApiSeverity

● ActiveDocument.Sections["Query"].DataModel.Connection.DBLibDatabaseCancel

● ActiveDocument.Sections["Query"].DataModel.Connection.DBLibPacketSize
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● ActiveDocument.Sections["Query"].DataModel.Connection.DBLibServerSeverity

● ActiveDocument.Sections["Query"].DataModel.Connection.DBLibUseQuotedIdentifiers

● ActiveDocument.Sections["Query"].DataModel.Connection.DBLibUseSQLTable

● ActiveDocument.Sections["Query"].DataModel.Connection.SaveWithoutUsername

● ActiveDocument.Sections["Query"].SaveResults

● ActiveSection.Shapes["Pivot1"].CellValue

● Application.CreateConnection()

● Application.DoEvents()

● Application.LoadSharedLibrary()

● Application.Shell()

● Application.Quit()

● Console.Write() (writes content to log)

● Console.WriteLn() (writes content to log)

● Documents.Add()

● Documents.New()

● Documents.Open()

● JOOLE Objects

● Dashboard Export to HTML (Dashboards only exports JPG in other client applications)

Object Model Properties Irrelevant to Workspace That Must Be
Retained

Some object model methods and properties do not affect the Workspace user interface, but the
values that they set must be retained within Interactive Reporting document files. When scripts
encounter the irrelevant methods and properties, no error log entry is recorded, and script
execution continues.

Note:

In the Workspace, an Interactive Reporting document file is saved locally for use with other
Interactive Reporting applications, Workspace changes are saved.

Object model items that are irrelevant to Workspace but must be retained:

● ActiveDocument.ShowSectionTitleBar

● ActiveDocument.Sections["Query"].DataModel.Connection.SaveWithoutUsername

● ActiveDocument.Sections["Query"].DataModel.Connection.ShowMetadata
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● ActiveDocument.Sections
["Query"].DataModel.MetaDataConnection.SaveWithoutUsername

● ActiveDocument.Sections["Query"].DataModel.MetaDataConnection.ShowMetadata

● ActiveDocument.Sections["Query"].DataModel.ShowIconJoins

● ActiveDocument.Sections["Query"].Limits["Quarter"].VariableLimit

● ActiveDocument.Sections["Query"].SaveResults

● ActiveDocument.Sections["DataModel"].DataModel.AutoJoin

● ActiveDocument.Sections["DataModel"].DataModel.Connection.SaveWithoutUsername

● ActiveDocument.Sections["DataModel"].DataModel.Connection.ShowMetadata

● ActiveDocument.Sections["DataModel"].DataModel.Limits["Year"].VariableLimit

● ActiveDocument.Sections
["DataModel"].DataModel.MetaDataConnection.SaveWithoutUsername

● ActiveDocument.Sections
["DataModel"].DataModel.MetaDataConnection.ShowMetadata

● ActiveDocument.Sections["DataModel"].DataModel.ShowIconJoins

● ActiveDocument.Sections["Dashboard"].Shapes
["EmbeddedSection"].ScrollbarsAlwaysShown

● ActiveDocument.Sections["Dashboard2"].Shapes
["EmbeddedSectionResults"].ShowOutliner

● ActiveDocument.Sections["Dashboard2"].Shapes["Embedded"].ShowRowNumbers

● Application.ShowMenuBar

● Application.ShowStatusBar

● Application.StatusText

● Application.Visible

● Application.WindowState

● BqFontEffectOverDouble

● BqFontEffectOverLine

● BqFontEffectStrikeThru

● BqFontEffectSuperScript

● BqFontEffectSubScript

● Toolbars["Formatting"].Name

● Toolbars["Formatting"].Type

● Toolbars["Formatting"].Visible
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Note:

Some object model methods invoke (or can be set to invoke) a dialog box. Workspace suppresses
most dialog prompts and assumes the default selection. Three dialog boxes are supported Logon,
Variable Filter, and Alert.

Note:

Users must provide absolute network paths for object-model methods that require local-path
information.

Note:

If an explicit prompt for information from the user (that is, Connect()) is not called, user names
and passwords associated with OCEs are used regardless of scripted values. If an explicit prompt
is called, user-supplied, scripted values are used. If scripted values are not available when an
explicit prompt is called, the process behaves as if no user name or password is provided.

User Embedded HTML
You can embed images, such GIF or JPEG, and hypertext links in the cells of tables and pivots.
Embedded data can be viewed in Workspace and in Interactive Reporting document files to be
exported to HTML pages.

User embedded HTML is written “as is” in the Workspace source code wherever the text would
normally use the function wrapper @HTML(<html image/link>).

How function wrappers are added to text is a customer-implementation choice. For example,
if the HTML that you want to use is stored in an Oracle database column titled HTMLDATA,
you might add ‘@HTML(’ || HTMLDATA || ‘)’ to the request line, where || is the Oracle string-
concatenation operator. This method can also be used to generate a computed item in results.

If you want report headers or dashboard pages to contain hard coded links, such as to a corporate
home page, you can enter, into a text label field, a literal string.

Example: @HTML(<a href=’http://www.hyperion.com’>Company Web site</a>)

Interactive Reporting Studio and Interactive Reporting Web Client cannot guarantee the format
or appearance of cell data that is adjacent to cells that contain user-defined HTML. When viewed
in a non-HTML context (such as Interactive Reporting Web Client or Interactive Reporting
Studio), embedded, user-defined HTML information is displayed as text.

➤ To embed images or hyperlinks into table or pivot cells:

1 Select the cell in which to embed the image or hyperlink.

2 n the cell, type @HTML(<HTML image/link>).

When Interactive Reporting Studio and Interactive Reporting Web Client encounter the
@HTML wrapper, it is deleted from the cell and the content up to but not including the wrapper
is exported “as is,” without character substitutions. The parentheses () is also deleted.
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BQY-XML Formatting
Workspace can read and view BQY-XML documents. The BQY-XML format is defined by the
XML Schema, that is provided by Hyperion in the workspace\xml\IHTMLServlet installation
folder. The BQY-XML format supports dashboard sections only, with a limited set of controls:

● Text label

● Hyperlink

● Embedded browser

● Picture

The BQY-XML format is not fully functional with equivalent objects and controls in Interactive
Reporting document files. To create a BQY-XML document, use an external editor (Hyperion
does not provide an editing tool). Design your Interactive Reporting document file after the
following XML Schemas provided in the workspace\xml\IHTMLServlet installation folder:

● common.xsd

● brioquery.xsd

● eis.xsd

Verify the format of BQY-XML documents before importing them into the repository. See the
bq.bqxml bq.template and bqxmlample files in the workspace\xml\IHTMLServlet folder, for
information about working with or modeling an XML Schema.

User Credentials in Scripting
When scripting includes supplied credentials (through the SetPassword (Method) and
Username (Property), the credentials are used in establishing an Interactive Reportingdatabase
connection file. If no credentials are supplied with the script, the behavior follows the settings
used by the Interactive Reporting database connection file and section mapping, together with
the options of the Connect method.

Fixing Scripted Credentials Errors
Script-provided credentials that are not used as expected, cause Interactive Reporting documents
files to be unusable without modification to the scripts.

When using scripted credentials, if database login failures occur, administrators can configure
the system to take remedial action. Errors are reported to the user by default, and no further
action is taken.

When the remedial action option is enabled, if the scripted credentials fail again to log into the
database, retry the login using settings from the Interactive Reporting database connection file
and section mapping, together with the options of the Connect method.
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A login failure due to incorrectly scripted credentials will always be logged. The remedial action
only affects users of Interactive Reporting Web Client, but does not affect Workspace or
Interactive Reporting Studio usage.

When the failure is logged, stop the Web server and enter
WebClient.Applications.DAServlet.RetryUsingDefaultDBCredential = true in
the ws.conf file. Save ws.conf and restart the Web server

PrintOut() Method Support in Workspace
The PrintOut() method is an Interactive Reporting document and section level function, that
is available regardless of the state of the application. As long as the application is running,
PrintOut() method is available through scripting, and in Interactive Reporting Studio or Oracle's
Hyperion® Interactive Reporting Web Client, prints the Interactive Reporting document file
according to the arguments provided, or opens a standard Print dialog box.

If Workspace users encounter PrintOut() method in scripts, the data received in the browser
includes a PDF file.

Note:

Script run in full before the PDF data is returned to the browser. This may cause some unexpected
behavior with Interactive Reporting document files, such as those that display an alert that
printing is complete, when in fact it has not yet started. Script authors should be aware of these
factors when designing applications.

Caution!

In Adobe Acrobat Reader, the default print settings are set to first page only. Reset the print
range options to print the full document.

PrintOut() method is prevented from executing in Interactive Reporting documents displayed
in Workspace if an Alert method is used after PrintOut() method. In Workspace optional
parameters of the method; for example, pages to print and number of copies are ignored, use
the Adobe Acrobat Reader Print dialog box to specify those options.

PrintOut() method is not supported:

● In scripts that run as the result of Document events (such as OnStartup)

● For section-level activation and deactivation events

● When used as a method of query or data model type sections

PrintOut() method has no effect on jobs; therefore, no printout occurs.

PrintOut() method takes five optional arguments:
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● Start page—A number, equivalent to setting the first number to print in a print dialog box,
and must represent the first page to print in the document. This value is ignored in
Workspace.

● End page—A number, equivalent to setting the last number to print in a print dialog box,
and must represent the last page to print in the document. This value is ignored in
Workspace.

● Number of copies—A number, equivalent to setting the print dialog box option for number
of copies, and must represent 1 to n copies. This value is ignored in Workspace.

● PrintOut filename—A string, equivalent to setting the filename for printing to file, and
should have a printer extension; for example, PRN or PS . The file is generated by the default
printer driver, and requires that a default printer be available. The value must represent a
properly formatted local or UNC path. URL syntax is not supported. This value is ignored
in the Oracle's Hyperion® Workspace.

● Prompt for dialog box—A Boolean, equivalent to displaying or hiding the print dialog box.
The value must be false (0) or true (a number other than 0). The method does not persist
with the Interactive Reporting document file or application.

Note:

The placeholder empty string; for example, (“”,””,””,””, “”) must be used to pass no value. If
insufficient arguments are passed to the method, the PrintOut dialog box opens in a set location
that cannot be programmatically changed.

Anti-Aliasing and Charts
Anti-aliasing improves chart images by displaying jagged lines as smooth, and affects
performance. In applications where performance is critical, use the server.xml setting to prevent
charts from being anti-aliased.

➤ To disable anti-aliasing:

1 In a text editor, open server.xml.

2 Search and locate the section <SERVICES app="bq">.

3 Search and locate the section <service type="BrioQuery">.

4 In the section <properties>, copy and paste the string:

<property defid="0ad70321-0001-08aa-000000e738090110" 
name="DISABLE_ANTIALIASING">true</property>

 <SERVICES app="bq">
...
    <service type="BrioQuery">
...
      <properties>
...
        <property defid="0ad70321-0001-08aa-000000e738090110" 
name="DISABLE_ANTIALIASING">true</property>
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...
      </properties>
    </service>
  </SERVICES>
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A
Abbreviations and Acronyms

Abbreviation Meaning

ABC activity-based costing

ABM Activity-Based Management

ADO ActiveX Data Object

AE accountability element

AJP Apache JServ Protocol

AJAX Asynchronous JavaScript and XML

API application programming interface

ASMTP Authenticated SMTP

ASP Active Server Pages

BAT batch file extension

BI Business Intelligence

BPM Business Performance Management

CA certificate authority

CMD command file extension

CN common name

COGS cost of goods sold

CORBA Common Object Request Broker Architecture

CPM corporate performance management

CSC custom calculation scripts file extension

DBCS double-byte character set

DBMS database management system

DC domain component

DCOM Distributed Component Object Model
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Abbreviation Meaning

DHTML Dynamic Hypertext Markup Language

DIT directory information tree

DLL dynamic link library

DN distinguished name

DNS Domain Name System

DOM Document Object Model

DSN data source name

DTD Document Type Definition

EAR enterprise application archive file

EIS executive information system

EJB Enterprise JavaBeans

EPB Enterprise Planning and Budgeting

EPM Enterprise Performance Management

ERP enterprise resource planning

ESM editable source master

ESMTP Extended SMTP

FP fix pack

FTP File Transfer Protocol

GAAP generally accepted accounting principles

GIF Graphics Interchange Format

GSKit7 IBM Global Security Kit 7

GUI graphical user interface

GSM Global Service Manager

HTML HyperText Markup Language

HTTP HyperText Transfer Protocol

HTTPS HyperText Transfer Protocol layered over the SSL protocol; secure HTTP

ID identification

I/O input/output
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Abbreviation Meaning

IP Internet Protocol

JAIN Java APIs for Integrated Networks

JDBC Java Database Connectivity

JDK Java Development Kit

J2EE Java 2 Platform, Enterprise Edition

JFC Java Foundation Classes

JRE Java Runtime Environment

JSP JavaServer Pages

JSSE Java Secure Socket Extension

JVM Java Virtual Machine

KPI key performance indicator

LAN local area network

LCM Life Cycle Management

LDAP Lightweight Directory Access Protocol

LRO linked reporting object

LSC Local Service Configurator

LSM Local Service Manager

MDDB multidimensional database

MDX Multidimensional Expression Language

MIME Multipurpose Internet Mail Extensions

MSAD Microsoft Active Directory

ND Network Deployment

NFS network file system

NTFS New Technology file system

NTLM Windows NT LAN Manager

OCI Oracle Call Interface

ODBC open database connectivity

OLAP online analytical processing
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Abbreviation Meaning

OLE Object Linking and Embedding

ORA Oracle file name extension

ORB Object Request Broker

OTL outline file extension (Analytic Services)

PDF Portable Document Format

P&L profit and loss

POV point of view

PRX Adapter icon file name extension

PV present value

RAM random access memory

RDBMS relational database management system

REP report scripts file extension

RMI Remote Method Invocation

ROM read-only memory

RPC Remote Procedure Call

RSC Remote Service Configurator

RTP runtime prompt

RUL Business Rules file extension

SAP JCo, JCo SAP Java Connector

SDK Software Development Kit

SE strategy element

SEM Strategic Enterprise Management

SID (Oracle) System Identification value (database instance)

SMTP Simple Mail Transfer Protocol

SOAP Simple Object Access Protocol

SP service pack

SPM Strategic Performance Management

SQL structured query language
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Abbreviation Meaning

SSAS SQL Server Analysis Services

SSL Secure Sockets Layer

SSO token single sign-on token

STP Summary Time Period

TAR tape archive (UNIX archive file)

TBH To be hired

TCP/IP Transmission Control Protocol based on Internet Protocol

UDA user-defined attribute; Universal Data Access

UDL Universal Data Link

UI user interface

UID user identification

URI Uniform Resource Identifier

URL Uniform Resource Locator

URN Uniform Resource Name

UTF-8 8-bit Unicode Transformation Format

UUID universally unique identifier

VBIS Vignette Business Integration Studio

VNC Virtual Network Computing

WAN wide area network

WAR WebARchive file

W3C World Wide Web Consortium

WWW World Wide Web

XML Extensible Markup Language

Xvfb X virtual frame buffer

XREF cross reference; Data reference source to a remote cube

ZIP data compression and archival file format
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Glossary

Interactive Reporting database connection file (OCE)

Files encapsulating database connection information,

including: the database API (ODBC, SQL*Net, etc.),

database software, the database server network address, and

database user name. Administrators create and publish

Interactive Reporting database connection files (OCE).

! See bang character (!).

#MISSING See missing data (#MISSING).

access permissions A set of operations that a user can

perform on a resource.

accessor Input and output data specifications for data

mining algorithms.

account A dimension that represents an accounting

container that identifies the location and primary nature of

the data.

account blocking The process by which accounts accept

input data in the consolidated file. Blocked accounts do not

receive their value through the additive consolidation

process.

account eliminations Accounts which have their values set

to zero in the consolidated file during consolidation.

account type How an account's value flows over time, and

its sign behavior. Account type options can include expense,

income, asset, liability, and equity.

accountability map A visual, hierarchical representation of

the responsibility, reporting, and dependency structure of

the accountability teams (also known as critical business

areas) in an organization.

accounts dimension A dimension type that makes

accounting intelligence available. Only one dimension can

be defined as Accounts.

active service A service whose Run Type is set to Start rather

than Hold.

active user A user who is entitled to access the system.

active user/user group The user or user group identified as

the current user by user preferences. Determines default

user preferences, dynamic options, access, and file

permissions. You can set the active user to your user name

or any user group to which you belong.

activity-level authorization Defines user access to

applicationsand the types of activities they can perform on

applications, independent of the data that will be operated

on.

ad hoc report An online analytical query created on-the-fly

by an end user.

adaptive states Interactive ReportingWeb Client level of

permission.

adjustment See journal entry (JE).

Advanced Relational Access The integration of a relational

database with an Essbase multidimensional database so that

all data remains in the relational database and is mapped to

summary-level data residing in the Essbase database.

agent An Essbase server process that starts and stops

applications and databases, manages connections from

users, and handles user-access security. The agent is referred

to as ESSBASE.EXE.

aggregate cell A cell comprising several cells. For example,

a data cell that uses Children(Year) expands to four cells

containing Quarter 1, Quarter 2, Quarter 3, and Quarter 4

data.

aggregate function A type of function, such as sum or

calculation of an average, that summarizes or performs

analysis on data.
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aggregate limit A limit placed on an aggregated request line

item or aggregated metatopic item.

aggregate storage database The database storage model

designed to support large-scale, sparsely distributed data

which is categorized into many, potentially large

dimensions. Upper level members and formulas are

dynamically calculated, and selected data values are

aggregated and stored, typically with improvements in

overall aggregation time.

aggregate view A collection of aggregate cells based on the

levels of the members within each dimension. To reduce

calculation time, values are pre-aggregated and stored as

aggregate views. Retrievals then start from aggregate view

totals and add up from there.

aggregation The process of rolling up and storing values in

an aggregate storage database; the stored result of the

aggregation process.

aggregation script In aggregate storage databases only, a

file that defines a selection of aggregate views to be built into

an aggregation.

alias An alternative name. For example, for a more easily

identifiable column descriptor you can display the alias

instead of the member name.

alias table A table that contains alternate names for

members.

alternate hierarchy A hierarchy of shared members. An

alternate hierarchy is based upon an existing hierarchy in a

database outline, but has alternate levels in the dimension.

An alternate hierarchy allows the same data to be seen from

different points of view.

ancestor A branch member that has members below it. For

example, the members Qtr2 and 2006 are ancestors of the

member April.

appender A Log4j term for destination.

application (1) A software program designed to run a

specific task or group of tasks such as a spreadsheet program

or database management system. (2) A related set of

dimensions and dimension members that are used to meet

a specific set of analytical and/or reporting requirements.

application currency The default reporting currency for

the application.

Application Migration Utility A command-line utility for

migrating applications and artifacts.

area A predefined set of members and values that makes up

a partition.

arithmetic data load A data load that performs operations

on values in the database, such as adding 10 to each value.

artifact An individual application or repository item; for

example, scripts, forms, rules files, Interactive Reporting

document files, and financial reports. Also known as an

object.

asset account An account type that stores values that

represent a company's assets.

attribute Characteristics of a dimension member. For

example, Employee dimension members may have

attributes of Name, Age, or Address. Product dimension

members can have several attributes, such as a size and

flavor.

attribute association A relationship in a database outline

whereby a member in an attribute dimension describes a

characteristic of a member of its base dimension. For

example, if product 100-10 has a grape flavor, the product

100-10 has the Flavor attribute association of grape. Thus,

the 100-10 member of the Product dimension is associated

with the Grape member of the Flavor attribute dimension.

Attribute Calculations dimension A system-defined

dimension that performs these calculation operations on

groups of members: Sum, Count, Avg, Min, and Max. This

dimension is calculated dynamically and is not visible in the

database outline. For example, using the Avg member, you

can calculate the average sales value for Red products in New

York in January.

attribute dimension A type of dimension that enables

analysis based on the attributes or qualities of dimension

members.

attribute reporting A reporting process based on the

attributes of the base dimension members. See also base

dimension.
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attribute type A text, numeric, Boolean, date, or linked-

attribute type that enables different functions for grouping,

selecting, or calculating data. For example, because the

Ounces attribute dimension has the type numeric, the

number of ounces specified as the attribute of each product

can be used to calculate the profit per ounce for that

product.

authentication Verification of identity as a security

measure. Authentication is typically based on a user name

and password. Passwords and digital signatures are forms

of authentication.

authentication service A core service that manages one

authentication system.

auto-reversing journal A journal for entering adjustments

that you want to reverse in the next period.

automated stage A stage that does not require human

intervention, for example, a data load.

axis (1) A straight line that passes through a graphic used

for measurement and categorization. (2) A report aspect

used to arrange and relate multidimensional data, such as

filters, pages, rows, and columns. For example, for a data

query in Simple Basic, an axis can define columns for values

for Qtr1, Qtr2, Qtr3, and Qtr4. Row data would be retrieved

with totals in the following hierarchy: Market, Product.

backup A duplicate copy of an application instance.

balance account An account type that stores unsigned

values that relate to a particular point in time.

balanced journal A journal in which the total debits equal

the total credits.

bang character (!) A character that terminates a series of

report commands and requests information from the

database. A report script must be terminated with a bang

character; several bang characters can be used within a

report script.

bar chart A chart that can consist of one to 50 data sets,

with any number of values assigned to each data set. Data

sets are displayed as groups of corresponding bars, stacked

bars, or individual bars in separate rows.

base currency The currency in which daily business

transactions are performed.

base dimension A standard dimension that is associated

with one or more attribute dimensions. For example,

assuming products have flavors, the Product dimension is

the base dimension for the Flavors attribute dimension.

base entity An entity at the bottom of the organization

structure that does not own other entities.

batch calculation Any calculation on a database that is

done in batch; for example, a calculation script or a full

database calculation. Dynamic calculations are not

considered to be batch calculations.

batch file An operating system file that can call multiple

ESSCMD scripts and run multiple sessions of ESSCMD. On

Windows-based systems, batch files have BAT file

extensions. On UNIX, batch files are written as a shell script.

batch POV A collection of all dimensions on the user POV

of every report and book in the batch. While scheduling the

batch, you can set the members selected on the batch POV.

batch processing mode A method of using ESSCMD to

write a batch or script file that can be used to automate

routine server maintenance and diagnostic tasks. ESSCMD

script files can execute multiple commands and can be run

from the operating system command line or from within

operating system batch files. Batch files can be used to call

multiple ESSCMD scripts or run multiple instances of

ESSCMD.

block The primary storage unit which is a

multidimensional array representing the cells of all dense

dimensions.

block storage database The Essbase database storage model

categorizing and storing data based on the sparsity of data

values defined in sparse dimensions. Data values are stored

in blocks, which exist only for sparse dimension members

for which there are values.

Blocked Account An account that you do not want

calculated in the consolidated file because you want to enter

it manually.

book A container that holds a group of similar Financial

Reporting documents. Books may specify dimension

sections or dimension changes.

book POV The dimension members for which a book is

run.
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bookmark A link to a reporting document or a Web site,

displayed on a personal page of a user. The two types of

bookmarks are My Bookmarks and image bookmarks.

bounding rectangle The required perimeter that

encapsulates the Interactive Reportingdocument file

content when embedding Interactive Reportingdocument

file sections in a personal page, specified in pixels for height

and width or row per page.

broadcast message A simple text message sent by an

administrator to a user who is logged on to a Planning

application. The message displays information to the user

such as system availability, notification of application

refresh, or application backups.

budget administrator A person responsible for setting up,

configuring, maintaining, and controlling an application.

Has all application privileges and data access permissions.

build method A method used to modify database outlines.

Choice of a build method is based on the format of data in

data source files.

business process A set of activities that collectively

accomplish a business objective.

business rules Logical expressions or formulas that are

created within an application to produce a desired set of

resulting values.

cache A buffer in memory that holds data temporarily.

calc script A set of commands that define how a database

is consolidated or aggregated. A calculation script may also

contain commands that specify allocation and other

calculation rules separate from the consolidation process.

Calculated Accounts You cannot alter the formulas in

Calculated Accounts. These formulas are fixed in order to

maintain the accounting integrity of the model you are

building. For example, the formula for Net Income, a

Calculated Account, is modeled into Strategic Finance and

can not be changed in either historical or forecast periods.

calculated member in MaxL DML A member designed for

analytical purposes and defined in the optional WITH

section of a MaxL DML query.

calculation The process of aggregating data, or of running

a calculation script on a database.

calculation status A consolidation status that indicates that

some values or formula calculations have changed. You

must reconsolidate to get the correct values for the affected

entity.

calendar User-defined time periods and their relationship

to each other. Q1, Q2, Q3, and Q4 comprise a calendar or

fiscal year.

cascade The process of creating multiple reports for a

subset of member values.

Catalog pane Displays a list of elements available to the

active section. If Query is the active section, a list of database

tables is displayed. If Pivot is the active section, a list of

results columns is displayed. If Dashboard is the active

section, a list of embeddable sections, graphic tools, and

control tools are displayed.

categories Groupings by which data is organized. For

example, Month

cause and effect map Depicts how the elements that form

your corporate strategy relate and how they work together

to meet your organization's strategic goals. A Cause and

Effect map tab is automatically created for each Strategy

map.

CDF See custom-defined function (CDF).

CDM See custom-defined macro (CDM).

cell (1) The data value at the intersection of dimensions in

a multidimensional database; the intersection of a row and

a column in a worksheet. (2) A logical group of nodes

belonging to one administrative domain.

cell note A text annotation for a cell in an Essbase database.

Cell notes are a type of LRO.

CHANGED status Consolidation status that indicates data

for an entity has changed.

chart A graphical representation of spreadsheet data. The

visual nature expedites analysis, color-coding, and visual

cues that aid comparisons.

chart template A template that defines the metrics to

display in Workspace charts.

child A member with a parent above it in the database

outline.
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choice list A list of members that a report designer can

specify for each dimension when defining the report's point

of view. A user who wants to change the point of view for a

dimension that uses a choice list can select only the members

specified in that defined member list or those members that

meet the criteria defined in the function for the dynamic list.

clean block A data block that where the database is fully

calculated, if a calculation script calculates all dimensions at

once, or if the SET CLEARUPDATESTATUS command is

used in a calculation script.

cluster An array of servers or databases that behave as a

single resource which share task loads and provide failover

support; eliminates one server or database as a single point

of failure in a system.

clustered bar charts Charts in which categories are viewed

side-by-side; useful for side-by-side category analysis; used

only with vertical bar charts.

code page A mapping of bit combinations to a set of text

characters. Different code pages support different sets of

characters. Each computer contains a code page setting for

the character set requirements of the language of the

computer user. In the context of this document, code pages

map characters to bit combinations for non-Unicode

encodings. See also encoding.

column A vertical display of information in a grid or table.

A column can contain data from one field, derived data from

a calculation, or textual information.

committed access An Essbase Kernel Isolation Level setting

that affects how Essbase handles transactions. Under

committed access, concurrent transactions hold long-term

write locks and yield predictable results.

computed item A virtual column (as opposed to a column

that is physically stored in the database or cube) that can be

calculated by the database during a query, or by Oracle's

Hyperion® Interactive Reporting Studio in the Results

section. Computed items are calculations of data based on

functions, data items, and operators provided in the dialog

box and can be included in reports or reused to calculate

other data.

configuration file The security platform relies on XML

documents to be configured by the product administrator

or software installer. The XML document must be modified

to indicate meaningful values for properties, specifying

locations and attributes pertaining to the corporate

authentication scenario.

connection file See Interactive Reporting database

connection file (OCE).

consolidated file (Parent) A file into which all of the

business unit files are consolidated; contains the definition

of the consolidation.

consolidation The process of aggregating data from

dependent entities to parent entities. For example, if the

dimension Year consists of the members Qtr1, Qtr2, Qtr3,

and Qtr4, its consolidation is Year.

consolidation file (*.cns) The consolidation file is a

graphical interface that enables you to add, delete or move

Strategic Finance files in the consolidation process using

either a Chart or Tree view. It also enables you to define and

modify the consolidation.

consolidation rule Identifies the rule that is executed

during the consolidation of the node of the hierarchy. This

rule can contain customer specific formulas appropriate for

the correct consolidation of parent balances. Elimination

processing can be controlled within these rules.

content Information stored in the repository for any type

of file.

context variable A variable that is defined for a particular

task flow to identify the context of the taskflow instance.

contribution The value added to a parent from a child

entity. Each child has a contribution to its parent.

conversion rate See exchange rate.

cookie A segment of data placed on your computer by a

Web site.

correlated subqueries Subqueries that are evaluated once

for every row in the parent query; created by joining a topic

item in the subquery with a topic in the parent query.
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Cost of Debt Value determined by using a weighted average

Yield to Maturity (YTM) of a company's entire debt

portfolio. Use is the current YTM rate rather than the

nominal cost of debt. The coupon rate determines the

interest payment, but it does not always reflect the actual

cost of the company's debt today. As required returns

change, the price of a debt issue also changes so that the

actual interest payments and anticipated proceeds, at

maturity, yield the investors their revised required return.

Therefore, the YTM fully reflects the current return

demanded by debt holders and the rate at which existing

debt would have to be replaced.

Cost of Equity The return an investor expects to earn on

an individual stock. Using the CAPM method, the Cost of

Equity is equal to:

Cost of Preferred Represents the expected return to

preferred stockholders. Like debt, you need to enter the yield

to maturity on preferred stock, but without the tax

shielding.

critical business area (CBA) An individual or a group

organized into a division, region, plant, cost center, profit

center, project team, or process; also called accountability

team or business area.

critical success factor (CSF) A capability that must be

established and sustained to achieve a strategic objective;

owned by a strategic objective or a critical process and is a

parent to one or more actions.

crosstab reporting Categorizes and summarizes data in

table format. The table cells contain summaries of the data

that fit within the intersecting categories. For example, a

crosstab report of product sales information could show size

attributes, such as Small and Large, as column headings and

color attributes, such as Blue and Yellow, as row headings.

The cell in the table where Large and Blue intersect could

contain the total sales of all Blue products that are sized

Large.

cube A block of data that contains three or more

dimensions. An Essbase database is a cube.

currency conversion A process that converts currency

values in a database from one currency into another. For

example, to convert one U. S. dollar into the European euro,

the exchange rate (for example, 0.923702) is multiplied with

the dollar (1* 0.923702). After conversion, the European

euro amount is .92.

Currency Overrides In any input period, the selected input

method can be overridden to enable input of that period's

value as Default Currency/Items. To override the input

method, enter a pound sign (#) either before or after the

number.

currency partition A dimension type that separates local

currency members from a base currency, as defined in an

application. Identifies currency types, such as Actual,

Budget, and Forecast.

custom calendar Any calendar created by an administrator.

custom dimension A dimension created and defined by

users. Channel, product, department, project, or region

could be custom dimensions.

custom property A property of a dimension or dimension

member that is created by a user.

custom report A complex report from the Design Report

module, composed of any combination of components.

custom-defined function (CDF) Essbase calculation

functions developed in Java and added to the standard

Essbase calculation scripting language using MaxL. See also

custom-defined macro (CDM).

custom-defined macro (CDM) Essbase macros written

with Essbase calculator functions and special macro

functions. Custom-defined macros use an internal Essbase

macro language that enables the combination of calculation

functions and they operate on multiple input parameters.

See also custom-defined function (CDF).

cycle through To perform multiple passes through a

database while calculating it.

dashboard A collection of metrics and indicators that

provide an interactive summary of your business.

Dashboards enable you to build and deploy analytic

applications.

data cache A buffer in memory that holds uncompressed

data blocks.

data cell See cell.

data file cache A buffer in memory that holds compressed

data (PAG) files.
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data form A grid display that enables users to enter data

into the database from an interface such as a Web browser,

and to view and analyze data or related text. Certain

dimension member values are fixed, giving users a specific

view into the data.

data function That computes aggregate values, including

averages, maximums, counts, and other statistics, that

summarize groupings of data.

data load rules A set of criteria that determines how to load

data from a text-based file, a spreadsheet, or a relational data

set into a database.

data lock Prevents changes to data according to specified

criteria, such as period or scenario.

data mining The process of searching through an Essbase

database for hidden relationships and patterns in a large

amount of data.

data model A representation of a subset of database tables.

data value See cell.

database connection File that stores definitions and

properties used to connect to data sources and enables

database references to be portable and widely used.

Default Currency Units Define the unit scale of data. For

example, If you select to define your analysis in Thousands,

and enter “10”, this is interpreted as “10,000”.

dense dimension In block storage databases, a dimension

likely to contain data for every combination of dimension

members. For example, time dimensions are often dense

because they can contain all combinations of all members.

Contrast with sparse dimension.

dependent entity An entity that is owned by another entity

in the organization.

descendant Any member below a parent in the database

outline. In a dimension that includes years, quarters, and

months, the members Qtr2 and April are descendants of the

member Year.

Design Report An interface in Web Analysis Studio for

designing custom reports, from a library of components.

destination currency The currency to which balances are

converted. You enter exchange rates and convert from the

source currency to the destination currency. For example,

when you convert from EUR to USD, the destination

currency is USD.

detail chart A chart that provides the detailed information

that you see in a Summary chart. Detail charts appear in the

Investigate Section in columns below the Summary charts.

If the Summary chart shows a Pie chart, then the Detail

charts below represent each piece of the pie.

dimension A data category used to organize business data

for retrieval and preservation of values. Dimensions usually

contain hierarchies of related members grouped within

them. For example, a Year dimension often includes

members for each time period, such as quarters and months.

dimension build The process of adding dimensions and

members to an Essbase outline.

dimension build rules Specifications, similar to data load

rules, that Essbase uses to modify an outline. The

modification is based on data in an external data source file.

dimension tab In the Pivot section, the tab that enables you

to pivot data between rows and columns.

dimension table (1) A table that includes numerous

attributes about a specific business process. (2) In Essbase

Integration Services, a container in the OLAP model for one

or more relational tables that define a potential dimension

in Essbase.

dimension type A dimension property that enables the use

of predefined functionality. Dimensions tagged as time have

a predefined calendar functionality.

dimensionality In MaxL DML, the represented

dimensions (and the order in which they are represented)

in a set. For example, the following set consists of two tuples

of the same dimensionality because they both reflect the

dimensions (Region, Year): { (West, Feb), (East, Mar) }

direct rate A currency rate that you enter in the exchange

rate table. The direct rate is used for currency conversion.

For example, to convert balances from JPY to USD, In the

exchange rate table, enter a rate for the period/scenario

where the source currency is JPY and the destination

currency is USD.
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dirty block A data block containing cells that have been

changed since the last calculation. Upper level blocks are

marked as dirty if their child blocks are dirty (that is, they

have been updated).

display type One of three Web Analysis formats saved to

the repository: spreadsheet, chart, and pinboard.

dog-ear The flipped page corner in the upper right corner

of the chart header area.

domain In data mining, a variable representing a range of

navigation within data.

drill-down Navigation through the query result set using

the dimensional hierarchy. Drilling down moves the user

perspective from aggregated data to detail. For example,

drilling down can reveal hierarchical relationships between

years and quarters or quarters and months.

drill-through The navigation from a value in one data

source to corresponding data in another source.

duplicate alias name A name that occurs more than once

in an alias table and that can be associated with more than

one member in a database outline. Duplicate alias names

can be used with duplicate member outlines only.

duplicate member name The multiple occurrence of a

member name in a database, with each occurrence

representing a different member. For example, a database

has two members named “New York.” One member

represents New York state and the other member represents

New York city.

duplicate member outline A database outline containing

duplicate member names.

Dynamic Calc and Store members A member in a block

storage outline that Essbase calculates only upon the first

retrieval of the value. Essbase then stores the calculated value

in the database. Subsequent retrievals do not require

calculating.

Dynamic Calc members A member in a block storage

outline that Essbase calculates only at retrieval time. Essbase

discards calculated values after completing the retrieval

request.

dynamic calculation In Essbase, a calculation that occurs

only when you retrieve data on a member that is tagged as

Dynamic Calc or Dynamic Calc and Store. The member's

values are calculated at retrieval time instead of being

precalculated during batch calculation.

dynamic hierarchy In aggregate storage database outlines

only, a hierarchy in which members are calculated at

retrieval time.

dynamic member list A system-created named member set

that is based on user-defined criteria. The list is refreshed

automatically whenever it is referenced in the application.

As dimension members are added and deleted, the list

automatically reapplies the criteria to reflect the changes.

dynamic reference A pointer in the rules file to header

records in a data source.

dynamic report A report containing data that is updated

when you run the report.

Dynamic Time Series A process that performs period-to-

date reporting in block storage databases.

dynamic view account An account type indicating that

account values are calculated dynamically from the data that

is displayed.

Eliminated Account An account that does not appear in

the consolidated file.

elimination The process of zeroing out (eliminating)

transactions between entities within an organization.

employee A user responsible for, or associated with,

specific business objects. Employees need not work for an

organization; for example, they can be consultants.

Employees must be associated with user accounts for

authorization purposes.

encoding A method for mapping bit combinations to

characters for creating, storing, and displaying text. Each

encoding has a name; for example, UTF-8. Within an

encoding, each character maps to a specific bit combination;

for example, in UTF-8, uppercase A maps to HEX41. See

also code page and locale.

ending period A period enabling you to adjust the date

range in a chart. For example, an ending period of “month”,

produces a chart showing information through the end of

the current month.
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Enterprise View An Administration Services feature that

enables management of the Essbase environment from a

graphical tree view. From Enterprise View, you can operate

directly on Essbase artifacts.

entity A dimension representing organizational units.

Examples: divisions, subsidiaries, plants, regions, products,

or other financial reporting units.

Equity Beta The riskiness of a stock, measured by the

variance between its return and the market return, indicated

by an index called “beta”. For example, if a stock's return

normally moves up or down 1.2% when the market moves

up or down 1%, the stock has a beta of 1.2.

essbase.cfg An optional configuration file for Essbase.

Administrators may edit this file to customize Essbase

Server functionality. Some configuration settings may also

be used with Essbase clients to override Essbase Server

settings.

EssCell A function entered into an Essbase Spreadsheet

Add-in to retrieve a value representing an intersection of

specific Essbase database members.

ESSCMD A command-line interface for performing

Essbase operations interactively or through batch script

files.

ESSLANG The Essbase environment variable that defines

the encoding used to interpret text characters. See also

encoding.

ESSMSH See MaxL Shell.

exceptions Values that satisfy predefined conditions. You

can define formatting indicators or notify subscribing users

when exceptions are generated.

exchange rate A numeric value for converting one currency

to another. For example, to convert 1 USD into EUR, the

exchange rate of 0.8936 is multiplied with the U.S. dollar.

The European euro equivalent of $1 is 0.8936.

exchange rate type An identifier for an exchange rate.

Different rate types are used because there may be multiple

rates for a period and year. Users traditionally define rates

at period end for the average rate of the period and for the

end of the period. Additional rate types are historical rates,

budget rates, forecast rates, and so on. A rate type applies to

one point in time.

expense account An account that stores periodic and year-

to-date values that decrease net worth if they are positive.

Extensible Markup Language (XML) A language

comprising a set of tags used to assign attributes to data that

can be interpreted between applications according to a

schema.

external authentication Logging on to Oracle's Hyperion

applications with user information stored outside the

applications, typically in a corporate directory such as

MSAD or NTLM.

externally triggered events Non-time-based events for

scheduling job runs.

Extract, Transform, and Load (ETL) Data source-specific

programs for extracting data and migrating it to

applications.

extraction command An Essbase reporting command that

handles the selection, orientation, grouping, and ordering

of raw data extracted from a database; begins with the less

than (<) character.

fact table The central table in a star join schema,

characterized by a foreign key and elements drawn from a

dimension table. This table typically contains numeric data

that can be related to all other tables in the schema.

field An item in a data source file to be loaded into an

Essbase database.

file delimiter Characters, such as commas or tabs, that

separate fields in a data source.

filter A constraint on data sets that restricts values to

specific criteria; for example, to exclude certain tables,

metadata, or values, or to control access.

flow account An unsigned account that stores periodic and

year-to-date values.

folder A file containing other files for the purpose of

structuring a hierarchy.

footer Text or images at the bottom of report pages,

containing dynamic functions or static text such as page

numbers, dates, logos, titles or file names, and author

names.

format Visual characteristics of documents or report

objects.
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formula A combination of operators, functions,

dimension and member names, and numeric constants

calculating database members.

frame An area on the desktop. There are two main areas:

the navigation and workspace frames.

free-form grid An object for presenting, entering, and

integrating data from different sources for dynamic

calculations.

free-form reporting Creating reports by entering

dimension members or report script commands in

worksheets.

function A routine that returns values or database

members.

generation A layer in a hierarchical tree structure that

defines member relationships in a database. Generations are

ordered incrementally from the top member of the

dimension (generation 1) down to the child members.

generation name A unique name that describes a

generation.

generic jobs Non-SQR Production Reporting or non-

Interactive Reporting jobs.

global report command A command in a running report

script that is effective until replaced by another global

command or the file ends.

grid POV A means for specifying dimension members on

a grid without placing dimensions in rows, columns, or page

intersections. A report designer can set POV values at the

grid level, preventing user POVs from affecting the grid. If

a dimension has one grid value, you put the dimension into

the grid POV instead of the row, column, or page.

group A container for assigning similar access permissions

to multiple users.

GUI Graphical user interface

highlighting Depending on your configuration, chart cells

or ZoomChart details may be highlighted, indicating value

status: red (bad), yellow (warning), or green (good).

Historical Average An average for an account over a

number of historical periods.

holding company An entity that is part of a legal entity

group, with direct or indirect investments in all entities in

the group.

host A server on which applications and services are

installed.

host properties Properties pertaining to a host, or if the

host has multiple Install_Homes, to an Install_Home. The

host properties are configured from the LSC.

Hybrid Analysis An analysis mapping low-level data stored

in a relational database to summary-level data stored in

Essbase, combining the mass scalability of relational systems

with multidimensional data.

hyperlink A link to a file, Web page, or an intranet HTML

page.

Hypertext Markup Language (HTML) A programming

language specifying how Web browsers display data.

identity A unique identification for a user or group in

external authentication.

image bookmarks Graphic links to Web pages or

repository items.

IMPACTED status Indicates changes in child entities

consolidating into parent entities.

implied share A member with one or more children, but

only one is consolidated, so the parent and child share a

value.

inactive group A group for which an administrator has

deactivated system access.

inactive service A service suspended from operating.

INACTIVE status Indicates entities deactivated from

consolidation for the current period.

inactive user A user whose account has been deactivated by

an administrator.

income account An account storing periodic and year-to-

date values that, if positive, increase net worth.

index (1) A method where Essbase uses sparse-data

combinations to retrieve data in block storage databases. (2)

The index file.

index cache A buffer containing index pages.
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index entry A pointer to an intersection of sparse

dimensions. Index entries point to data blocks on disk and

use offsets to locate cells.

index file An Essbase file storing block storage data retrieval

information, residing on disk, and containing index pages.

index page A subdivision in an index file. Contains pointers

to data blocks.

input data Data loaded from a source rather than

calculated.

Install_Home A variable for the directory where Oracle's

Hyperion applications are installed. Refers to one instance

of Oracle's Hyperion application when multiple

applications are installed on the same computer.

integration Process that is run to move data between

Oracle's Hyperion applications using Shared Services. Data

integration definitions specify the data moving between a

source application and a destination application, and enable

the data movements to be grouped, ordered, and scheduled.

intelligent calculation A calculation method tracking

updated data blocks since the last calculation.

intercompany elimination See elimination.

intercompany matching The process of comparing

balances for pairs of intercompany accounts within an

application. Intercompany receivables are compared to

intercompany payables for matches. Matching accounts are

used to eliminate intercompany transactions from an

organization's consolidated totals.

intercompany matching report A report that compares

intercompany account balances and indicates if the

accounts are in, or out, of balance.

interdimensional irrelevance A situation in which a

dimension does not intersect with other dimensions.

Because the data in the dimension cannot be accessed from

the non-intersecting dimensions, the non-intersecting

dimensions are not relevant to that dimension.

intersection A unit of data representing the intersection of

dimensions in a multidimensional database; also, a

worksheet cell.

Investigation See drill-through.

isolation level An Essbase Kernel setting that determines

the lock and commit behavior of database operations.

Choices are: committed access and uncommitted access.

iteration A “pass” of the budget or planning cycle in which

the same version of data is revised and promoted.

Java Database Connectivity (JDBC) A client-server

communication protocol used by Java based clients and

relational databases. The JDBC interface provides a call-

level API for SQL-based database access.

job output Files or reports produced from running a job.

job parameters Reusable, named job parameters that are

accessible only to the user who created them.

jobs Documents with special properties that can be

launched to generate output. A job can contain Interactive

Reporting, Oracle's Hyperion® SQR® Production

Reporting – System 9, or generic documents.

join A link between two relational database tables or topics

based on common content in a column or row. A join

typically occurs between identical or similar items within

different tables or topics. For example, a record in the

Customer table is joined to a record in the Orders table

because the Customer ID value is the same in each table.

journal entry (JE) A set of debit/credit adjustments to

account balances for a scenario and period.

JSP Java Server Pages.

latest A Spreadsheet key word used to extract data values

from the member defined as the latest time period.

layer (1) The horizontal location of members in a

hierarchical structure, specified by generation (top down)

or level (bottom up). (2) Position of objects relative to other

objects. For example, in the Sample Basic database, Qtr1 and

Qtr4 are in the same layer, so they are also in the same

generation, but in a database with a ragged hierarchy, Qtr1

and Qtr4 might not be in same layer, though they are in the

same generation.

legend box A box containing labels that identify the data

categories of a dimension.

level A layer in a hierarchical tree structure that defines

database member relationships. Levels are ordered from the

bottom dimension member (level 0) up to the parent

members.
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level 0 block A data block for combinations of sparse, level

0 members.

level 0 member A member that has no children.

liability account An account type that stores “point in

time” balances of a company's liabilities. Examples of

liability accounts include accrued expenses, accounts

payable, and long term debt.

life cycle management The process of managing

application information from inception to retirement.

line chart A chart that displays one to 50 data sets, each

represented by a line. A line chart can display each line

stacked on the preceding ones, as represented by an absolute

value or a percent.

line item detail The lowest level of detail in an account.

link (1) A reference to a repository object. Links can

reference folders, files, shortcuts, and other links. (2) In a

task flow, the point where the activity in one stage ends and

another begins.

link condition A logical expression evaluated by the

taskflow engine to determine the sequence of launching

taskflow stages.

linked data model Documents that are linked to a master

copy in a repository

linked partition A shared partition that enables you to use

a data cell to link two databases. When a user clicks a linked

cell in a worksheet, Essbase opens a new sheet displaying the

dimensions in the linked database. The user can then drill

down those dimensions.

linked reporting object (LRO) A cell-based link to an

external file such as cell notes, URLs, or files with text, audio,

video, or pictures. (Only cell notes are supported for Essbase

LROs in Financial Reporting.)

local currency An input currency type. When an input

currency type is not specified, the local currency matches

the entity's base currency.

local report object A report object that is not linked to a

Financial Reporting report object in Explorer. Contrast with

linked reporting object (LRO).

local results A data model's query results. Results can be

used in local joins by dragging them into the data model.

Local results are displayed in the catalog when requested.

locale A computer setting that specifies a location's

language, currency and date formatting, data sort order, and

the character set encoding used on the computer. Essbase

uses only the encoding portion. See also encoding and

ESSLANG.

locale header record A text record at the beginning of some

non-Unicode-encoded text files, such as scripts, that

identifies the encoding locale.

location alias A descriptor that identifies a data source. The

location alias specifies a server, application, database, user

name, and password. Location aliases are set by DBAs at the

database level using Administration Services Console,

ESSCMD, or the API.

locked A user-invoked process that prevents users and

processes from modifying data

locked data model Data models that cannot be modified by

a user.

LOCKED status A consolidation status indicating that an

entity contains data that cannot be modified.

Log Analyzer An Administration Services feature that

enables filtering, searching, and analysis of Essbase logs.

LRO See linked reporting object (LRO).

LSC services Services configured with the Local Service

Configurator. They include Global Services Manager

(GSM), Local Services Manager (LSM), Session Manager,

Authentication Service, Authorization Service, Publisher

Service, and sometimes, Data Access Service (DAS) and

Interactive Reporting Service.

managed server An application server process running in

its own Java Virtual Machine (JVM).

manual stage A stage that requires human intervention to

complete.

Map File Used to store the definition for sending data to or

retrieving data from an external database. Map files have

different extensions (.mps to send data; .mpr to retrieve

data).
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Map Navigator A feature that displays your current

position on a Strategy, Accountability, or Cause and Effect

map, indicated by a red outline.

Marginal Tax Rate Used to calculate the after-tax cost of

debt. Represents the tax rate applied to the last earned

income dollar (the rate from the highest tax bracket into

which income falls) and includes federal, state and local

taxes. Based on current level of taxable income and tax

bracket, you can predict marginal tax rate.

Market Risk Premium The additional rate of return paid

over the risk-free rate to persuade investors to hold “riskier”

investments than government securities. Calculated by

subtracting the risk-free rate from the expected market

return. These figures should closely model future market

conditions.

master data model An independent data model that is

referenced as a source by multiple queries. When used,

“Locked Data Model” is displayed in the Query section's

Content pane; the data model is linked to the master data

model displayed in the Data Model section, which an

administrator may hide.

mathematical operator A symbol that defines how data is

calculated in formulas and outlines. Can be any of the

standard mathematical or Boolean operators; for example,

+, -, *, /, and %.

MaxL The multidimensional database access language for

Essbase, consisting of a data definition language (MaxL

DDL) and a data manipulation language (MaxL DML). See

also MaxL DDL, MaxL DML, and MaxL Shell.

MaxL DDL Data definition language used by Essbase for

batch or interactive system-administration tasks.

MaxL DML Data manipulation language used in Essbase

for data query and extraction.

MaxL Perl Module A Perl module (essbase.pm) that is part

of Essbase MaxL DDL. This module can be added to the Perl

package to provide access to Essbase databases from Perl

programs.

MaxL Script Editor A script-development environment in

Administration Services Console. MaxL Script Editor is an

alternative to using a text editor and the MaxL Shell for

administering Essbase with MaxL scripts.

MaxL Shell An interface for passing MaxL statements to

Essbase Server. The MaxL Shell executable file is located in

the Essbase bin directory (UNIX: essmsh, Windows:

essmsh.exe).

MDX (multidimensional expression) The language that

give instructions to OLE DB for OLAP- compliant

databases, as SQL is used for relational databases. When you

build the OLAPQuery section's Outliner, Interactive

Reporting Clients translate requests into MDX instructions.

When you process the query, MDX is sent to the database

server, which returns records that answer your query. See

also SQL spreadsheet.

measures Numeric values in an OLAP database cube that

are available for analysis. Measures are margin, cost of goods

sold, unit sales, budget amount, and so on. See also fact

table.

member A discrete component within a dimension. A

member identifies and differentiates the organization of

similar units. For example, a time dimension might include

such members as Jan, Feb, and Qtr1.

member list A named group, system- or user-defined, that

references members, functions, or member lists within a

dimension.

member load In Essbase Integration Services, the process

of adding dimensions and members (without data) to

Essbase outlines.

member selection report command A type of Report

Writer command that selects member ranges based on

outline relationships, such as sibling, generation, and level.

member-specific report command A type of Report Writer

formatting command that is executed as it is encountered

in a report script. The command affects only its associated

member and executes the format command before

processing the member.

merge A data load option that clears values only from the

accounts specified in the data load file and replaces them

with values in the data load file.

metadata A set of data that defines and describes the

properties and attributes of the data stored in a database or

used by an application. Examples of metadata are

dimension names, member names, properties, time

periods, and security.

Glossary 135



metadata sampling The process of retrieving a sample of

members in a dimension in a drill-down operation.

metadata security Security set at the member level to

restrict users from accessing certain outline members.

metaoutline In Essbase Integration Services, a template

containing the structure and rules for creating an Essbase

outline from an OLAP model.

metric A numeric measurement computed from business

data to help assess business performance and analyze

company trends.

migration audit report A report generated from the

migration log that provides tracking information for an

application migration.

migration definition file (.mdf) A file that contains

migration parameters for an application migration,

enabling batch script processing.

migration log A log file that captures all application

migration actions and messages.

migration snapshot A snapshot of an application

migration that is captured in the migration log.

MIME Type (Multipurpose Internet Mail Extension) An

attribute that describes the data format of an item, so that

the system knows which application should open the object.

A file's mime type is determined by the file extension or

HTTP header. Plug-ins tell browsers what mime types they

support and what file extensions correspond to each mime

type.

mining attribute In data mining, a class of values used as a

factor in analysis of a set of data.

minireport A report component that includes layout,

content, hyperlinks, and the query or queries to load the

report. Each report can include one or more minireports.

missing data (#MISSING) A marker indicating that data in

the labeled location does not exist, contains no value, or was

never entered or loaded. For example, missing data exists

when an account contains data for a previous or future

period but not for the current period.

model (1) In data mining, a collection of an algorithm's

findings about examined data. A model can be applied

against a wider data set to generate useful information about

that data. (2) A file or content string containing an

application-specific representation of data. Models are the

basic data managed by Shared Services, of two major types:

dimensional and non-dimensional application objects. (3)

In Business Modeling, a network of boxes connected to

represent and calculate the operational and financial flow

through the area being examined.

monetary A money-related value.

multidimensional database A method of organizing,

storing, and referencing data through three or more

dimensions. An individual value is the intersection point for

a set of dimensions.

named set In MaxL DML, a set with its logic defined in the

optional WITH section of a MaxL DML query. The named

set can be referenced multiple times in the query.

native authentication The process of authenticating a user

name and password from within the server or application.

nested column headings A report column heading format

that displays data from multiple dimensions. For example,

a column heading that contains Year and Scenario members

is a nested column. The nested column heading shows Q1

(from the Year dimension) in the top line of the heading,

qualified by Actual and Budget (from the Scenario

dimension) in the bottom line of the heading.

NO DATA status A consolidation status indicating that

this entity contains no data for the specified period and

account.

non-dimensional model A Shared Services model type that

includes application objects such as security files, member

lists, calculation scripts, and Web forms.

non-unique member name See duplicate member name.

note Additional information associated with a box,

measure, scorecard or map element.

null value A value that is absent of data. Null values are not

equal to zero.
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numeric attribute range A feature used to associate a base

dimension member that has a discrete numeric value with

an attribute that represents a value range. For example, to

classify customers by age, an Age Group attribute dimension

can contain members for the following age ranges: 0-20,

21-40, 41-60, and 61-80. Each Customer dimension

member can be associated with an Age Group range. Data

can be retrieved based on the age ranges rather than on

individual age values.

ODBC Open Database Connectivity. A database access

method used from any application regardless of how the

database management system (DBMS) processes the

information.

OK status A consolidation status indicating that an entity

has already been consolidated, and that data has not

changed below it in the organization structure.

OLAP Metadata Catalog In Essbase Integration Services, a

relational database containing metadata describing the

nature, source, location, and type of data that is pulled from

the relational data source.

OLAP model In Essbase Integration Services, a logical

model (star schema) that is created from tables and columns

in a relational database. The OLAP model is then used to

generate the structure of a multidimensional database.

online analytical processing (OLAP) A multidimensional,

multiuser, client-server computing environment for users

who analyze consolidated enterprise data in real time. OLAP

systems feature drill-down, data pivoting, complex

calculations, trend analysis, and modeling.

Open Database Connectivity (ODBC) Standardized

application programming interface (API) technology that

allows applications to access multiple third-party databases.

organization An entity hierarchy that defines each entity

and their relationship to others in the hierarchy.

origin The intersection of two axes.

outline The database structure of a multidimensional

database, including all dimensions, members, tags, types,

consolidations, and mathematical relationships. Data is

stored in the database according to the structure defined in

the outline.

outline synchronization For partitioned databases, the

process of propagating outline changes from one database

to another database.

P&L accounts (P&L) Profit and loss accounts. Refers to a

typical grouping of expense and income accounts that

comprise a company's income statement.

page A display of information in a grid or table often

represented by the Z-axis. A page can contain data from one

field, derived data from a calculation, or text.

page file Essbase data file.

page heading A report heading type that lists members

represented on the current page of the report. All data values

on the page have the members in the page heading as a

common attribute.

page member A member that determines the page axis.

palette A JASC compliant file with a .PAL extension. Each

palette contains 16 colors that complement each other and

can be used to set the dashboard color elements.

parallel calculation A calculation option. Essbase divides a

calculation into tasks and calculates some tasks

simultaneously.

parallel data load In Essbase, the concurrent execution of

data load stages by multiple process threads.

parallel export The ability to export Essbase data to

multiple files. This may be faster than exporting to a single

file, and it may resolve problems caused by a single data file

becoming too large for the operating system to handle.

parent adjustments The journal entries that are posted to

a child in relation to its parent.

parents The entities that contain one or more dependent

entities that report directly to them. Because parents are

both entities and associated with at least one node, they have

entity, node, and parent information associated with them.

partition area A subcube within a database. A partition is

composed of one or more areas of cells from a portion of

the database. For replicated and transparent partitions, the

number of cells within an area must be the same for the data

source and target to ensure that the two partitions have the

same shape. If the data source area contains 18 cells, the data

target area must also contain 18 cells to accommodate the

number of values.
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partitioning The process of defining areas of data that are

shared or linked between data models. Partitioning can

affect the performance and scalability of Essbase

applications.

pattern matching The ability to match a value with any or

all characters of an item entered as a criterion. Missing

characters may be represented by wild card values such as a

question mark (?) or an asterisk (*). For example, “Find all

instances of apple” returns apple, but “Find all instances of

apple*” returns apple, applesauce, applecranberry, and so

on.

percent consolidation The portion of a child's values that

is consolidated to its parent.

percent control Identifies the extent to which an entity is

controlled within the context of its group.

percent ownership Identifies the extent to which an entity

is owned by its parent.

performance indicator An image file used to represent

measure and scorecard performance based on a range you

specify; also called a status symbol. You can use the default

performance indicators or create an unlimited number of

your own.

periodic value method (PVA) A process of currency

conversion that applies the periodic exchange rate values

over time to derive converted results.

permission A level of access granted to users and groups

for managing data or other users and groups.

persistence The continuance or longevity of effect for any

Essbase operation or setting. For example, an Essbase

administrator may limit the persistence of user name and

password validity.

personal pages A personal window to repository

information. You select what information to display and its

layout and colors.

personal recurring time events Reusable time events that

are accessible only to the user who created them.

personal variable A named selection statement of complex

member selections.

perspective A category used to group measures on a

scorecard or strategic objectives within an application. A

perspective can represent a key stakeholder (such as a

customer, employee, or shareholder/financial) or a key

competency area (such as time, cost, or quality).

pie chart A chart that shows one data set segmented in a pie

formation.

pinboard One of the three data object display types.

Pinboards are graphics, composed of backgrounds and

interactive icons called pins. Pinboards require traffic

lighting definitions.

pins Interactive icons placed on graphic reports called

pinboards. Pins are dynamic. They can change images and

traffic lighting color based on the underlying data values and

analysis tools criteria.

pivot The ability to alter the perspective of retrieved data.

When Essbase first retrieves a dimension, it expands data

into rows. You can then pivot or rearrange the data to obtain

a different viewpoint.

planner Planners, who comprise the majority of users, can

input and submit data, use reports that others create,

execute business rules, use task lists, enable e-mail

notification for themselves, and use Smart View.

planning unit A data slice at the intersection of a scenario,

version, and entity; the basic unit for preparing, reviewing,

annotating, and approving plan data.

plot area The area bounded by X, Y, and Z axes; for pie

charts, the rectangular area surrounding the pie.

plug account An account in which the system stores any

out of balance differences between intercompany account

pairs during the elimination process.

POV (point of view) A feature for working with dimension

members not assigned to row, column, or page axes. For

example, you could assign the Currency dimension to the

POV and select the Euro member. Selecting this POV in data

forms displays data in Euro values.

precalculation Calculating the database prior to user

retrieval.

precision Number of decimal places displayed in numbers.

predefined drill paths Paths used to drill to the next level

of detail, as defined in the data model.
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presentation A playlist of Web Analysis documents,

enabling reports to be grouped, organized, ordered,

distributed, and reviewed. Includes pointers referencing

reports in the repository.

preserve formulas User-created formulas kept within a

worksheet while retrieving data.

primary measure A high-priority measure important to

your company and business needs. Displayed in the

Contents frame.

product In Shared Services, an application type, such as

Planning or Performance Scorecard.

Production Reporting See SQR Production Reporting.

project An instance of Oracle's Hyperion products

grouped together in an implementation. For example, a

Planning project may consist of a Planning application, an

Essbase cube, and a Financial Reporting Server instance.

promote The action to move a data unit to the next review

level, allowing a user having the appropriate access to review

the data. For example, an analyst may promote the data unit

to the next level for his supervisor's review.

promotion The process of transferring artifacts from one

environment or machine to another; for example, from a

testing environment to a production environment.

property A characteristic of an artifact, such as size, type,

or processing instructions.

provisioning The process of granting users and groups

specific access permissions to resources.

proxy server A server acting as an intermediary between

workstation users and the Internet to ensure security.

public job parameters Reusable, named job parameters

created by administrators and accessible to users with

requisite access privileges.

public recurring time events Reusable time events created

by administrators and accessible through the access control

system.

PVA See periodic value method (PVA).

qualified name A member name in a qualified format that

differentiates duplicate member names in a duplicate

member outline. For example,     [Market].[East].[State].

[New York] or [Market].[East].[City].[New York]

query Information requests from data providers. For

example, used to access relational data sources.

query governor An Essbase Integration Server parameter

or Essbase Server configuration setting that controls the

duration and size of queries made to data sources.

range A set of values including upper and lower limits, and

values falling between limits. Can contain numbers,

amounts, or dates.

reconfigure URL URL used to reload servlet configuration

settings dynamically when users are already logged on to the

Workspace.

record In a database, a group of fields making up one

complete entry. For example, a customer record may

contain fields for name, address, telephone number, and

sales data.

recurring template A journal template for making identical

adjustments in every period.

recurring time event An event specifying a starting point

and the frequency for running a job.

redundant data Duplicate data blocks that Essbase retains

during transactions until Essbase commits updated blocks.

regular journal A feature for entering one-time

adjustments for a period. Can be balanced, balanced by

entity, or unbalanced.

Related Accounts The account structure groups all main

and related accounts under the same main account number.

The main account is distinguished from related accounts by

the first suffix of the account number.

relational database A type of database that stores data in

related two-dimensional tables. Contrast with

multidimensional database.

replace A data load option that clears existing values from

all accounts for periods specified in the data load file, and

loads values from the data load file. If an account is not

specified in the load file, its values for the specified periods

are cleared.

replicated partition A portion of a database, defined

through Partition Manager, used to propagate an update to

data mastered at one site to a copy of data stored at another

site. Users can access the data as though it were part of their

local database.
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Report Extractor An Essbase component that retrieves

report data from the Essbase database when report scripts

are run.

report object In report designs, a basic element with

properties defining behavior or appearance, such as text

boxes, grids, images, and charts.

report script A text file containing Essbase Report Writer

commands that generate one or more production reports.

Report Viewer An Essbase component that displays

complete reports after report scripts are run.

reporting currency The currency used to prepare financial

statements, and converted from local currencies to

reporting currencies.

repository Stores metadata, formatting, and annotation

information for views and queries.

resources Objects or services managed by the system, such

as roles, users, groups, files, and jobs.

restore An operation to reload data and structural

information after a database has been damaged or

destroyed, typically performed after shutting down and

restarting the database.

restructure An operation to regenerate or rebuild the

database index and, in some cases, data files.

result frequency The algorithm used to create a set of dates

to collect and display results.

review level A Process Management review status indicator

representing the process unit level, such as Not Started, First

Pass, Submitted, Approved, and Published.

Risk Free Rate The rate of return expected from “safer”

investments such as long-term U.S. government securities.

role The means by which access permissions are granted to

users and groups for resources.

roll-up See consolidation.

root member The highest member in a dimension branch.

row heading A report heading that lists members down a

report page. The members are listed under their respective

row names.

RSC services Services that are configured with Remote

Service Configurator, including Repository Service, Service

Broker, Name Service, Event Service, and Job Service.

rules User-defined formulas.

runtime prompt A variable that users enter or select before

a business rule is run.

sampling The process of selecting a representative portion

of an entity to determine the entity's characteristics. See also

metadata sampling.

saved assumptions User-defined Planning assumptions

that drive key business calculations (for example, the cost

per square foot of office floor space).

scale The range of values on the Y axis of a chart.

scaling Scaling determines the display of values in whole

numbers, tens, hundreds, thousands, millions, and so on.

scenario A dimension for classifying data (for example,

Actuals, Budget, Forecast1, and Forecast2).

schedule Specify the job that you want to run and the time

and job parameter list for running the job.

scope The area of data encompassed by any Essbase

operation or setting; for example, the area of data affected

by a security setting. Most commonly, scope refers to three

levels of granularity, where higher levels encompass lower

levels. From highest to lowest, these levels are as follows: the

entire system (Essbase Server), applications on Essbase

Server, or databases within Essbase Server applications. See

also persistence.

score The level at which targets are achieved, usually

expressed as a percentage of the target.

scorecard Business Object that represents the progress of

an employee, strategy element, or accountability element

toward goals. Scorecards ascertain this progress based on

data collected for each measure and child scorecard added

to the scorecard.

scorecard report A report that presents the results and

detailed information about scorecards attached to

employees, strategy elements, and accountability elements.
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secondary measure A low-priority measure, less important

than primary measures. Secondary measures do not have

Performance reports but can be used on scorecards and to

create dimension measure templates.

Section pane Lists all sections that are available in the

current Interactive Reporting document file.

security agent A Web access management provider (for

example, Netegrity SiteMinder) that protects corporate

Web resources.

security platform A framework enabling Oracle's

Hyperion applications to use external authentication and

single sign-on.

serial calculation The default calculation setting Essbase

divides a calculation pass into tasks and calculates one task

at a time.

services Resources that enable business items to be

retrieved, changed, added, or deleted. Examples:

Authorization and Authentication.

servlet A piece of compiled code executable by a Web

server.

Servlet Configurator A utility for configuring all locally

installed servlets.

session The time between login and logout for a user

connected to Essbase Server.

set In MaxL DML, a required syntax convention for

referring to a collection of one or more tuples. For example,

in the following MaxL DML query, SELECT { [100-10] }

ON COLUMNS FROM Sample.Basic { [100-10] } is a set.

shared member A member that shares storage space with

another member of the same name, preventing duplicate

calculation of members that occur multiple times in an

Essbase outline.

Shared Services Application enabling users to share data

between supported Oracle's Hyperion products by

publishing data to Shared Services and running data

integrations.

sibling A child member at the same generation as another

child member and having the same immediate parent. For

example, the members Florida and New York are children

of East and each other's siblings.

single sign-on Ability to access multiple Oracle's Hyperion

products after a single login using external credentials.

slicer In MaxL DML, the section at the end of a query that

begins with and includes the keyword WHERE.

smart tags Keywords in Microsoft Office applications that

are associated with predefined actions available from the

Smart Tag menu. In Oracle's Hyperion applications, smart

tags can also be used to import Reporting and Analysis

content, and access Financial Management and Essbase

functions.

SmartCut A link to a repository item, in URL form.

snapshot Read-only data from a specific time.

source currency The currency from which values originate

and are converted through exchange rates to the destination

currency.

sparse dimension In block storage databases, a dimension

unlikely to contain data for all member combinations when

compared to other dimensions. For example, not all

customers have data for all products.

SPF files Printer-independent files created by a SQR

Production Reporting server, containing a representation

of the actual formatted report output, including fonts,

spacing, headers, footers, and so on.

Spotlighter A tool that enables color coding based on

selected conditions.

SQL spreadsheet A data object that displays the result set

of a SQL query.

SQR Production Reporting A specialized programming

language for data access, data manipulation, and creating

SQR Production Reporting documents.

stacked charts A chart where the categories are viewed on

top of one another for visual comparison. This type of chart

is useful for subcategorizing within the current category.

Stacking can be used from the Y and Z axis in all chart types

except pie and line. When stacking charts the Z axis is used

as the Fact/Values axis.

stage A task description that forms one logical step within

a taskflow, usually performed by an individual. A stage can

be manual or automated.
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stage action For automated stages, the invoked action that

executes the stage.

standard dimension A dimension that is not an attribute

dimension.

standard journal template A journal function used to post

adjustments that have common adjustment information for

each period. For example, you can create a standard

template that contains the common account IDs, entity IDs,

or amounts, then use the template as the basis for many

regular journals.

Standard Template The Standard template is the basis for

the basic Strategic Finance file. The Standard template

contains all default settings. All new files are created from

the Standard template unless another template is selected.

Start in Play The quickest method for creating a Web

Analysis document. The Start in Play process requires you

to specify an Oracle's Hyperion® Interactive Reporting –

System 9 database connection file, then assumes the use of

a spreadsheet data object. Start in Play uses the highest

aggregate members of the time and measures dimensions to

automatically populate the rows and columns axes of the

spreadsheet.

Status bar The status bar at the bottom of the screen

displays helpful information about commands, accounts,

and the current status of your data file.

stored hierarchy In aggregate storage databases outlines

only. A hierarchy in which the members are aggregated

according to the outline structure. Stored hierarchy

members have certain restrictions, for example, they cannot

contain formulas.

strategic objective (SO) A long-term goal defined by

measurable results. Each strategic objective is associated

with one perspective in the application, has one parent, the

entity, and is a parent to critical success factors or other

strategic objectives.

Strategy map Represents how the organization

implements high-level mission and vision statements into

lower-level, constituent strategic goals and objectives.

structure view Displays a topic as a simple list of

component data items.

Structured Query Language A language used to process

instructions to relational databases.

Subaccount Numbering A system for numbering

subaccounts using non-sequential, whole numbers.

subscribe Flags an item or folder to receive automatic

notification whenever the item or folder is updated.

Summary chart In the Investigates Section, rolls up detail

charts shown below in the same column, plotting metrics at

the summary level at the top of each chart column.

super service A special service used by the

startCommonServices script to start the RSC services.

supervisor A user with full access to all applications,

databases, related files, and security mechanisms for a

server.

supporting detail Calculations and assumptions from

which the values of cells are derived.

suppress rows Excludes rows containing missing values,

and underscores characters from spreadsheet reports.

symmetric multiprocessing (SMP) A server architecture

that enables multiprocessing and multithreading.

Performance is not significantly degraded when a large

number of users connect to an single instance

simultaneously.

sync Synchronizes Shared Services and application models.

synchronized The condition that exists when the latest

version of a model resides in both the application and in

Shared Services. See also model.

system extract Transfers data from an application's

metadata into an ASCII file.

tabs Navigable views of accounts and reports in Strategic

Finance.

target Expected results of a measure for a specified period

of time (day, quarter, etc.,)

task list A detailed status list of tasks for a particular user.

taskflow The automation of a business process in which

tasks are passed from one taskflow participant to another

according to procedural rules.
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taskflow definition Represents business processes in the

taskflow management system. Consists of a network of

stages and their relationships; criteria indicating the start

and end of the taskflow; and information about individual

stages, such as participants, associated applications,

associated activities, and so on.

taskflow instance Represents a single instance of a taskflow

including its state and associated data.

taskflow management system Defines, creates, and

manages the execution of a taskflow including: definitions,

user or application interactions, and application

executables.

taskflow participant The resource who performs the task

associated with the taskflow stage instance for both manual

and automated stages.

Taxes - Initial Balances Strategic Finance assumes that the

Initial Loss Balance, Initial Gain Balance and the Initial

Balance of Taxes Paid entries have taken place in the period

before the first Strategic Finance time period.

TCP/IP See Transmission Control Protocol/Internet Protocol

(TCP/IP).

template A predefined format designed to retrieve

particular data consistently.

time dimension Defines the time period that the data

represents, such as fiscal or calendar periods.

time events Triggers for execution of jobs.

time scale Displays metrics by a specific period in time,

such as monthly or quarterly.

time series reporting A process for reporting data based on

a calendar date (for example, year, quarter, month, or

week).

Title bar Displays the Strategic Finance name, the file

name, and the scenario name Version box.

token An encrypted identification of one valid user or

group on an external authentication system.

top and side labels Column and row headings on the top

and sides of a Pivot report.

top-level member A dimension member at the top of the

tree in a dimension outline hierarchy, or the first member

of the dimension in sort order if there is no hierarchical

relationship among dimension members. The top-level

member name is generally the same as the dimension name

if a hierarchical relationship exists.

trace level Defines the level of detail captured in the log file.

traffic lighting Color-coding of report cells, or pins based

on a comparison of two dimension members, or on fixed

limits.

transformation (1) Transforms artifacts so that they

function properly in the destination environment after

application migration. (2) In data mining, modifies data

(bidirectionally) flowing between the cells in the cube and

the algorithm.

translation See currency conversion.

Transmission Control Protocol/Internet Protocol (TCP/

IP) A standard set of communication protocols linking

computers with different operating systems and internal

architectures. TCP/IP utilities are used to exchange files,

send mail, and store data to various computers that are

connected to local and wide area networks.

transparent login Logs in authenticated users without

launching the login screen.

transparent partition A shared partition that enables users

to access and change data in a remote database as though it

is part of a local database

triangulation A means of converting balances from one

currency to another via a third common currency. In

Europe, this is the euro for member countries. For example,

to convert from French franc to Italian lira, the common

currency is defined as European euro. Therefore, in order

to convert balances from French franc to Italian lira,

balances are converted from French franc to European euro

and from European euro to Italian lira.

triggers An Essbase feature whereby data is monitored

according to user-specified criteria which when met cause

Essbase to alert the user or system administrator.

trusted password A password that enables users

authenticated for one product to access other products

without reentering their passwords.
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trusted user Authenticated user

tuple MDX syntax element that references a cell as an

intersection of a member from each dimension. If a

dimension is omitted, its top member is implied. Examples:

(Jan); (Jan, Sales); ( [Jan], [Sales], [Cola], [Texas], [Actual] )

two-pass An Essbase property that is used to recalculate

members that are dependent on the calculated values of

other members. Two-pass members are calculated during a

second pass through the outline.

unary operator A mathematical indicator (+, -, *, /, %)

associated with an outline member. The unary operator

defines how the member is calculated during a database roll-

up.

Unicode-mode application An Essbase application

wherein character text is encoded in UTF-8, enabling users

with computers set up for different languages to share

application data.

unique member name A non-shared member name that

exists only once in a database outline.

unique member outline A database outline that is not

enabled for duplicate member names.

upper-level block A type of data block wherein at least one

of the sparse members is a parent-level member.

user directory A centralized location for user and group

information. Also known as a repository or provider.

user variable Dynamically renders data forms based on a

user's member selection, displaying only the specified

entity. For example, user variable named Department

displays specific departments and employees.

user-defined attribute (UDA) User-defined attribute,

associated with members of an outline to describe a

characteristic of the members. Users can use UDAs to return

lists of members that have the specified UDA associated with

them.

user-defined member list A named, static set of members

within a dimension defined by the user.

validation A process of checking a business rule, report

script, or partition definition against the outline to make

sure that the object being checked is valid.

value dimension Used to define input value, translated

value, and consolidation detail.

variance Difference between two values (for example,

planned and actual value).

version Possible outcome used within the context of a

scenario of data. For example, Budget - Best Case and

Budget - Worst Case where Budget is scenario and Best Case

and Worst Case are versions.

view Representation of either a year-to-date or periodic

display of data.

visual cue A formatted style, such as a font or a color, that

highlights specific types of data values. Data values may be

dimension members; parent, child, or shared members;

dynamic calculations; members containing a formula; read

only data cells; read and write data cells; or linked objects.

Web server Software or hardware hosting intranet or

Internet Web pages or Web applications.

weight Value assigned to an item on a scorecard that

indicates the relative importance of that item in the

calculation of the overall scorecard score. The weighting of

all items on a scorecard accumulates to 100%. For example,

to recognize the importance of developing new features for

a product, the measure for New Features Coded on a

developer's scorecard would be assigned a higher weighting

than a measure for Number of Minor Defect Fixes.

wild card Character that represents any single character (?)

or group of characters (*) in a search string.

WITH section In MaxL DML, an optional section of the

query used for creating re-usable logic to define sets or

members. Sets or custom members can be defined once in

the WITH section, and then referenced multiple times

during a query.

workbook An entire spreadsheet file with many

worksheets.

write-back The ability for a retrieval client, such as a

spreadsheet, to update a database value.

ws.conf A configuration file for Windows platforms.

wsconf_platform A configuration file for UNIX platforms.

XML See Extensible Markup Language (XML).
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Y axis scale Range of values on Y axis of charts displayed in

Investigate Section. For example, use a unique Y axis scale

for each chart, the same Y axis scale for all Detail charts, or

the same Y axis scale for all charts in the column. Often,

using a common Y axis improves your ability to compare

charts at a glance.

Zero Administration Software tool that identifies version

number of the most up-to-date plug-in on the server.

zoom Sets the magnification of a report. For example,

magnify a report to fit whole page, page width, or percentage

of magnification based on 100%.

ZoomChart Used to view detailed information by

enlarging a chart. Enables you to see detailed numeric

information on the metric that is displayed in the chart.
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Symbols
-jscriptcmd, 43

A
accessibility, 106
ActiveDocument level, 61
adding

computed columns to query request lines, 78
items to the request line, 78
joins, 78
topics to a data model section, 77

alert dialog box, 102
anti-aliasing

charts, 114
Application level, 60
architecture of Workspace, 89
assignment operators

versus comparison operators, 82
assistance

with problem scripts, 87
automation controller, OLE, 56

B
backgrounds, borders, fonts, 99
borders, backgrounds, fonts, 99
BQY-XML formatting, 112
break statements, 54
brioquery 5.5 limit dialog box

store values
in text boxes, 79

browser, object, 35
browsing repository, 17
buttons

command, 13
option, 13
radio, 13

bypassing errors, 86

C
c++

OLE automation calls, 56
caching

disk, 90
calling functions, 44
case-sensitive code, 82
catalog pane

in design mode, 12
in run mode, 12

change modes
design mode, 12
run mode, 12

changing function parameters and object properties,
44

charts
anti-aliasing, 114
section hierarchy level, 64
sizing, 97

check boxes, definition, 13
check syntax, 36
client status, 100
client-side events, 101
client-side JavaScript, 100

client status, 100
client-side events, 101

client-side javascript
text box events and properties, 102

code entry, 86
code, case-sensitive, 82
collection, definition, 32
command buttons, definition, 13
comparison operators

versus assignment operators, 82
components of Workspace, 90
conditional statements, 48
conditional tests, 83
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Interactive Reportingconnection files (OCEs),
scripting, 76

connection login
display, 77

console window
locating errors, 97
reviewing error messages, 37

constant, definition, 32
continue statements, 53
control events, 101
control objects

events associated with, 101
list of, 13

controller, OLE automation, 56
controls, 98

controlling visibility of, 76
enabling and disabling, 76
objects properties, 98

copy script, 36
createshape, 72
creating

dashboard sections, 12
Interactive ReportingDatabase Connection Files

(OCES)), 76
predefined drill-down path, 96
shapes, 72
variable filters (limits), 79

cut script, 36
cut, copy, and paste dashboard objects, 36

D
dashboard home

embedded browser, preload, 21
preload, 21
setting, 21

dashboard objects, 13
delete, 14
embed objects, 14
insert, 14
working with, 13

dashboard scripting, 43
dashboard sections, 11

change modes, 12
control objects, 13
controlling visibility of controls, 76
creating, 12
default mode, 13

deleting, 12
enabling and disabling controls, 76
hierarchy level, 63
inserting, 12
layout tools in, 27
naming, 12
properties, 26
renaming, 12
switch modes, 12
toolbar, 28
working with, 11

dashboard sections toolbar
using, 28

dashboards, 11
external content, 14

data models
add topics, 77
download, 77

default
run mode, 13

defining functions, 44
examples, 46
in different scopes, 45

deleting
dashboard objects, 14
dashboard sections, 12
embedded sections, 14
shapes, 72

description pane, 37
syntax reference, 84

design considerations
embedded objects, 26

design guides, 27
using, 27

design mode, 12
design tools, 27
designing for Workspace, 89
designing scripts, 85
disabling controls, 76
disk caching in Workspace, 90
displaying

connection login boxes, 77
table catalogs, 77

distributed components in Workspace, 90
do...while statements, 52
document options

properties, 18
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document options dialog box, 18
document types, 18
document variables

using, 47
document-level events, 34

associate, 34
downloading data models, 77
drill-down path

create, 96
drop-down list boxes, definition, 13

E
embed objects, 14
embedded browser controls

dashboards, 15
working with, 15

embedded objects, 24
design considerations, 26
paging, 25
view-only

behaviors, 25
properties, 24

embedded pivot section
dashboards, 26
interactivity, 26

embedded sections
delete, 14

enabling controls, 76
entering code, 86
errors

bypassing, 86
identifying, 81
locating, 97

console window, 97
logs, 98
try-catch block, 98

review in console window, 37
scripted credentials

fixing, 112
event controls

for toolbar display, 104
events, 32, 100

document-level, 34
document-level, associate, 34
object-level, 33
section-level, 34

events menu, 36

example
controlling graphics and controls visibility, 76
defining functions, 46
javascript, 69
scripts, 76

excel, 56
OLE automation calls, 56

execution window, using to test scripts, 37
export

scripts, 58
to pdf, 104
to xls, 104

external content
dashboards, 14

F
files

export scripts to text, 58
find and replace within scripts, 38
find scripts, 36
fixing

scripted credentials errors, 112
fonts, backgrounds, borders, 99
for statements, 51
for...in statements, 55
formatting

BQY-XML, 112
functions, 43

calling, 44
change parameters and object properties, 44
define, 44
define in different scopes, 45

examples, 46
document variables, 47
global variables, 47
scope, 45
section variables, 47
variables, 47

G
global variables, 47
graphic objects

associated events, 33
list of, 13

graphics, 99
controlling visibility of, 76
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graphics objects, 99
grids, 28
guided analysis, 106
guided analysis and reporting, 106
guides, design, 27

H
headers

page, turning off, 79
help

online, 37
with problem scripts, 87

hierarchy level
ActiveDocument, 61
Application, 60
chart section, 64
dashboard section, 63
query section, 63
results, reports, pivots sections, 65
sections, 62

chart, 64
dashboard, 63
query, 63
results, reports, pivots, 65
table and OLAPQuery, 66

table and OLAPQuery sections, 66
hierarchy, object model, 59
HTML

user embedded, 111
Hyperion support for problem scripts, 87
hyperlink controls

dashboards, 22
working with, 22

I
identifying errors, 81
if...else statements, 48

stop script, 49
inline if statements, 49
insert

dashboard objects, 14
dashboard sections, 12

Interactive Reporting
charts

Workspace limitations, 94
dashboard scripting, 43

dashboard sections
Workspace limitations, 95

document sections
Workspace limitations, 92

features
supported in Workspace, 91

general functions
Workspace limitations, 92

object model. See object model
OLAPQueries

Workspace limitations, 93
pivots

Workspace limitations, 94
queries and data models

Workspace limitations, 93
reports

Workspace limitations, 95
results and tables

Workspace limitations, 94

J
JavaScript

client-side, 100
client status, 100

manipulating objects, 55
OLE automation controller within, 56

javascript
case-sensitivity, 82
client-side

events, 101
text box events and properties, 102

entering syntax, 86
examples, 69
improving performance, 85
sample, 37

JavScript
statements, 48

joins
add, 78

JOOLE, 56

L
label statements, 53
launch scripts

command line, 43
layout tools, 27
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limit values in urls submitted to ODS, 79
limitations

Workspace
Interactive Reporting charts, 94
Interactive Reporting dashboard sections, 95
Interactive Reporting documents, 92
Interactive Reporting general functions, 92
Interactive Reporting OLAPQueries, 93
Interactive Reporting pivots, 94
Interactive Reporting queries and data models,

93
Interactive Reporting reports, 95
Interactive Reporting results and tables, 94

line number, go to, 36
list boxes, definition, 13
locating errors, 97

console window, 97
logs, 98
try-catch block, 98

log into repository, 17
logs

locating errors, 98
loop statements, 51

M
manipulating objects with JavaScript, 55
map, object model, 59
methods, definition, 31
Microsoft automation interfaces, 56
multithreading in Workspace, 90

N
naming

dashboard sections, 12
navigation toolbar, 29
navigation, object model, 59

O
object browser, 35
object level events, 101
object model

description pane, 37
hierarchy, 59, 60

ActiveDocument level, 61
Application level, 60
chart section, 64

dashboard section, 63
query section, 63
results, reports, pivots sections, 65
sections, 62
table and OLAPQuery sections, 66

irrelevant to Workspace but must be retained, 109
items excluded from Workspace, 108
map, 59
Microsoft automation interfaces, 56
navigating, 59
online help, 37
processing povs, 107
terminology, 31
tree

traversing, 107
object properties

retrieving, 70
setting, 70
setting with javascript, 70

object-level events, 33
objects

controls, 13
embedded, 24
embedded sections, controls, graphics

delete, 14
graphics, 13
in catalog pane, 12
insert, embed, 14
manipulating with javascript, 55
placement and sizing, 71
resources, 14
sections, 13

objects, definition, 31
objects, embedded

design considerations, 26
paging, 25
view-only behaviors, 25
view-only properties, 24

OCEs
create, 76
script, 76

OLE automation calls
c++, excel, visual basic, 56

OLE automation controller, 56
OnCellDoubleClick, 33
OnChange, 33
OnClick, 33
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OnClientClick, 33
OnClientDoubleClick, 33
OnClientEnter, 33
OnClientExit, 34
OnDoubleClick, 33
OnEnter, 33
OnExit, 33
online help, 37
OnRowDoubleClick, 33
OnSelection, 33
option buttons, definition, 13
outlook, 56

P
page headers

turning off for first page in reports, 79
paging

embedded objects, 25
pane

description, 37
scripting, 36

parsing smartcuts and storing data in global variables
povs, processing, 107

partial document loading in Workspace, 90
paste script, 36
pdf, export to, 104
performance-enhancing features of Workspace, 90

disk caching, 90
distributed components, 90
multithreading, 90
partial document loading, 90

personal pages, 105
pivots

results and reports sections hierarchy level, 65
placement and sizing

objects, 71
placement node, 71

method, 71
method, using, 72
placing objects, 73
properties, 71
properties, using, 72

placing objects, 73
povs processing, 107

parsing smartcuts and storing data in global
variables, 107

traversing the object model tree, 107

predefined drill-down path
creating, 96

printout() method
support in Workspace, 113

processing povs, 107
parsing smartcuts and storing data in global

variables, 107
traversing the object model tree, 107

processing queries
using prompt for database logon, 79

prompt to save dialog box, turning off, 79
properties

control objects, 98
definition, 32
setting for dashboards, 26

Q
query request line

add computed columns, 78
query section hierarchy level, 63

R
radio buttons, definition, 13
recalculating results, 85
reference

syntax, 84
removeshape, 72
removing shapes, 72
rename dashboard sections, 12
replace scripts, 36
reporting, 106
reporting and guided analysis, 106
reports

results and pivots sections hierarchy level, 65
turning off page headers for first page, 79

repository
browsing, 17
embed an object, 17
log in, 17

request line, add items, 78
resources objects

images, 14
results

recalculating, 85
reports and pivots sections hierarchy level, 65

retrieve
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object properties, 70
reviewing error messages in console window, 37
rulers, 28

using, 28
run mode, switching to, 12

S
sample Javascript, 37
sample scripts

add
computed column to a query request line, 78
items to the request line, 78
joins, 78
topics to data model sections, 77

create an OCE, 76
display table catalog, 77
setup topic objects variables, 78
turn off page headers for the first page in reports,

79
using a brioquery 5.5 limit dialog box to store

values in text boxes, 79
scope, function, 45
script commands, launching, 43
script editor

description pane, 84
using, 35

scripted credentials errors
fixing, 112

scripting
user credentials, 112

scripting pane, 36
scripts, 43

designing, 85
export to text files, 58
find and replace, 38
launch from command line, 43
testing using execution window, 37
troubleshooting, 81

section objects, 13
section variables, 47
section-level events, 34

active, 34
sections hierarchy level, 62
set

object properties, 70
setting

dashboard properties, 26

topic object variables, 78
variable filters (limits), 79

shapes
create, 72
remove, 72

shapes collection
createshape method, 72
removeshape method, 72

sizing
charts, 97

space-saving variables, 81
standard Interactive Reporting toolbar, 103
statements

break, 54
conditional, 48
continue, 53
do...while, 52
for, 51
for...in, 55
if...else, 48
inline if, 49
JavaScript, 48
label, 53
loop, 51
switch, 50
while, 52
with, 55

stop a script
if...else statements, 49

storing data in global variables and parsing smartcuts
povs, processing, 107

switch modes
design mode, 12
run mode, 12

switch statements, 50
syntax reference, 84

T
table and OLAPQuery sections hierarchy level, 66
table catalogs

display, 77
testing scripts using the execution window, 37
tests, conditional, 83
text boxes, 14

displaying values, 69
entering values, 69
events and properties, 102
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text files, export scripts, 58
toggle modes

design mode, 12
run mode, 12

toolbars, 102
dashboard sections, 28
event controls for display, 104
navigation, 29
not required in Workspace, 103
rules in Workspace, 105
standard Interactive Reporting, 103
Workspace personal pages, 105

tools, layout, 27
topic object variables

setting, 78
topics, add to data models, 77
traversing the object model tree

povs, processing, 107
troubleshooting scripts, 81
try-catch block, locating errors, 98
turning off

page headers, 79
prompt to save dialog box, 79

U
understanding

functions, 43
Interactive Reporting events, 32
Interactive Reporting object model, 31

user credentials in scripting, 112
user embedded HTML, 111
using

brioquery 5.5 limit dialog box, 79
console window, to review error messages, 37
execution window to test scripts, 37
javascript statements, 48
ODS user name as limit, 79
script editor, 35

V
variable filters (limits)

create, 79
set, 79

variables
creating function components, 47
document, 47

global, 47
section, 47
space-saving, 81

view-only behaviors
embedded objects, 25

view-only properties
embedded objects, 24

visual basic
OLE automation calls, 56

W
while statements, 52
window

console, 37
execution, 37

with statements, 55
Workspace

architecture, 89
components, 90
designing, 89
disk caching, 90
distributed components, 90
excluded object model items, 108
irrelevant object model properties, 109
multithreading, 90
partial document loading, 90
performance-enhancing features, 90

disk caching, 90
distributed components, 90
multithreading, 90
partial document loading, 90

personal pages, toolbars, 105
printout() method support, 113
supported Interactive Reporting features, 91
toolbar rules, 105

Workspace limitations
Interactive Reporting charts, 94
Interactive Reporting dashboard sections, 95
Interactive Reporting documents, 92
Interactive Reporting general functions, 92
Interactive Reporting OLAPQueries, 93
Interactive Reporting pivots, 94
Interactive Reporting queries and data models, 93
Interactive Reporting reports, 95
Interactive Reporting results and tables, 94
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X
xls, export to, 104
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